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1 Quick Overview 
 

HiCAD Basics 
This part of the training book deals with the basics of the CAD program HiCAD, such as creat-
ing, saving and loading of drawings, point options, part structure etc., including related 
exercises.  

Text Section + 3-D Training Section 
From “Chapter 30: “Beginning of 3-D Training: Solid Primitives“ onwards, this training book pro-
vides various exercises for the 3-D module. Each exercise is preceded by one or several 
chapters explaining all functions needed do be able to do the exercise. If you are already famil-
iar with the basics of HiCAD, you can immediately start with this chapter.  

Glossary and Index 
The Glossary provides explanations of the essential CAD-specific terms. In the Index you will 
find an alphabetical list of the training book topics and the corresponding pages.  

Notes 

This section of the training book contains empty pages for your personal notes.      

 
 

     

                                              

   

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

This training book and the software described herein are provided in conjunction with a licence and may only be used or 
copied in accordance with the licence terms. The contents of this training book serve solely the purpose of information, 
may be changed by the ISD Software und Systeme GmbH without prior notice and shall not be regarded as binding. The 
ISD Software und Systeme GmbH does not guarantee the correctness or exactness of the information provided in this 
documentation. No part of this documentation may be reproduced, saved to databases or transferred in any form without 
prior written permission by the ISD Software und Systeme GmbH, unless expressly permitted by virtue of the licence 
agreement.   

Issued and edited by: © 2010 ISD ® Software und Systeme GmbH  
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2 FAQ 
Experience has shown that some questions arise particularly frequently. To spare you unnec-
essary browsing through the pages we will begin with 12 FAQs:  

Question 1: What are the functions of the mouse buttons? 

a) Left mouse button (LMB): Select function / confirm entry (e.g. a radius) 

b) Middle mouse button (MMB): Exit function / cancel 

c) Right mouse button (RMB): Context menu (you can right-click on an icon, a part, the 
drawing area, a dimensioning, a text and numerous other objects). 

 

Question 2: How do I select a point option? 

a) All point options represented by one letter (R, A, D, W, P, N) can be selected via the 
corresponding keyboard button. 

b) RETURN key of the keyboard 

c) Right-click just when HiCAD suggests a point option 

d) (quick) double left-click  
 

Question 3: How do I draw an uninterrupted polyline even if different point options are 
required? 

a)   left-click on the drawing area and select new point option 

b)   RMB > Polyline > Continue, and select new point option 

c)  overwrite previous point option with new point option (only possible for point options rep-
resented by one or two letters) 

 

Question 4: Which point options do I select if a reference point is required? 

Select „Relative-Return“ (REL RET). Just press the “R“ key for point option „Relative“, then con-
firm by pressing the RETURN key.   
 

Question 5: Which types of re-use are available? 

a) HiCAD Clipboard 

b) Insert Part > Others > From drawing, Via document master  

c) Insert Part  > Insert part, via DB document master  

d) Insert Part > Insert main part, via Standard Part catalogue 

e) Insert Part > User Library > New part library 

In this context please also note how you save parts to a catalogue, resp. to the database. 
The procedure is described in detail in Chapter 51: “Re-Use”. 

 

Question 6: How do I close a polyline in a 3-D Sketch? 

a) Sketch > Others > Sort GE in active sketch 

b) Information > 3-D, Further… > Information – 3-D Sketch 

c) Information > 3-D, Further… > Information – 3-D Sketch 1 

After further changes select „Sort GE in active sketch“ again.  
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Question 7: I want to convert a 2-D part to a 3-D part. A closed contour is required for 
this.  How do I make sure that the contour of the 2-D part is closed?  

a) 2-D-Geometry > Tools > Sort GE… (Drawing or Active part)  

b) 2-D-Geometry > Change > Delete overlaps 

c) Information > 2-D, Further… > Polyline 

After further changes select the “Sort GE…“ function again.  
 

Question 8: How do I perform a translation by a particular value with a translation vec-
tor?  

Start point: Select an arbitrary point in the drawing area. End point: Relative. 
 

Question 9: How do I change the grid in Sketch functions? 

“–“ key: refine the grid; “+” key: coarsen the grid; space key: for direct value input  
 

Question 10: How do I convert a HiCAD drawing to a graphic? 

a) CTRL + C > Select format and size > Select detail / Select background colour 

b) CTRL + W 

c) PRINT key 

d) Activate the “Drawing” tab and select Others > Extras > Tools > Create Enhanced 
Metafile (EMF). You can also select a superordinate part with a right-click.  

 

Question 11: How do I load the automatic “10 minute save” option? 

Open / Explorer / Local Disk / hicad / temp / switch to „SZN“ extension in the textbox „Files of 
type“/ select hicad_N1. During this process, N is the number of the drawing which with you 
have worked. If you want to load the drawing in the third compartment of the tab „Construction“, 
load hicad_31; if you have worked in the first compartment, select the drawing hicad_11. 
 

Question 12: How do I exchange the ISD logo in the drawing frame with my own com-
pany logo? 

Perform the following steps in an empty drawing:  

a) Drawing > Insert drawing frame > Do not complete title block > select a frame, e.g. DIN 
A0 > insert this frame in your drawing. 

b) In the “2-D Part structure” tab of the ICN, right-click on the name of the drawing. Select 
the “Auxiliary parts On/Off” function, then select “Auxiliary parts On”.   

c) Delete the sub-part with the old logo and create a new sub-part (e.g. with the name 
“Logo”) below the “SCHRIFE” entry. Draw the new logo there, e.g. with lines, texts etc. 
You can also create a new sub-part to the part “Logo”, draw a company logo as a 
closed contour there and hatch it with very narrow hatching line spacing (e.g. 0.05 – an 
example for this would be the “HiCAD eye” symbol). Save the part “Logo“ as Part. 

d) Activate the entire drawing frame and save it as 2-D part without database 

i) with the name ”DINA0“ suggested by the computer, if you are creating a 
frame for your own company, 

ii) with a different name, if you are creating a frame for a customer, for whom 
you regularly create drawings. 

e) Now load, one after another, frames DIN-A1 to DIN-A4. For each of them you can de-
lete the sub-part with the old logo and load your own company logo saved in step c), as 
a sub-part to the part „SCHRIFE“. Then continue with step d). 
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3 Abbreviations 
In this training book the following abbreviations are used:  

 ICN     Information and Communication Navigator (Browser) 
 LMB    left mouse button 
 MMB   middle mouse button 
 RMB    right mouse button 
 HCM   HiCAD Constraint Manager (Parametrics) 

    

4 Learning Targets 
This training book provides a tutorial enabling you to operate the HiCAD 3-D module. The topics 
covered in this training book correspond to the contents of a 3-D basic training course at the 
ISD. Target groups of this training are, for example, design engineers, design draughtsmen or 
product managers. The tutorial has been structured in such a way that you can work through 
the chapters successively. You can however also start with a chapter of your choice.  

All participants in the training should have sufficient skill in the operation of the HiCAD 2-D mod-
ule. As a good knowledge of 2-D design (especially the HiCAD part structure and the point 
options) is essential to working in 3-D, the first exercises in this training book will deal with the 
HiCAD 2-D module.   
 
In this training manual you will learn how to  

 convert the product structure to the HiCAD part structure, 
 create, process and correct 3-D parts,  
 change 3-D parts in entire drawings, 
 use standard parts, 
 dimension parts, 
 insert texts, 
 create detail drawings and assembly drawings,  
 print and plot drawings and output data via interfaces. 

 

The target of the training consists in enabling you to create engineering documents of your pro-
duct that are suitable for production.  
 

Each of the following sections is explained in the following way:  
 Icons and descriptions of the essential functions, 
 References to the appropriate chapters in the Online Help, if required,  
 Answering of questions and clarification of issues that may arise, 
 Explanation of the processing steps, 
 One exercise on the topics dealt with in the chapter.  

 

5 How Can I Get Further Information? 
5.1 Online Help 
In addition to this training book, you can get more information on the 2-D and 3-D modules from 
the following sources of information:   
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 The Online Help for the 2-D and 3-D module. You can call the Online Help with the F1 key 
or by clicking the “?” symbol (at the top right of the HiCAD GUI) and selecting Help Topics.  

 The above-mentioned Online Help also contains the “Basics” section that provides a gen-
eral overview of the working techniques and technologies used in HiCAD. It explains the 
concept of the system, the Graphical User Interface (GUI) and various design methods, and 
provides definitions of HiCAD-specific terms. General functions such as the working with 
drawing details or the printing and plotting of drawings are described in this Online Help 
section.  

 The “What’s New in HiCAD?” section of the Online Help provides an overview of new func-
tions and enhancements in HiCAD.  

   

Furthermore, the Online Help provides information on the Industry Solutions (Steel Engineering, 
Metal Engineering, Plant Engineering etc.), or on special modules such as Parametrics,  2-D-
>3-D Conversion, Macro Technology, Freeform Surface Technology, or HELiOS Product Data 
Management. 

 

 
Fig. 1  The HiCAD Online Help 

 

6 Why 3-D? 
Today an increasing number of companies rely on 3-D models to reduce their development 
times and remain internationally competitive.   

The advantages of 3-D models are however still widely underestimated although they signifi-
cantly contribute to an increased competitiveness and can be used by many departments of a 
company in a productive and efficient manner.   

 

6.1 Clear and Descriptive Visualisation 
If you want to represent several views of a real part in a 2-D CAD system, you need to create 
for each view an appropriate 2-D model. There are however no dependencies between the indi-
vidual 2-D views. This means that changes applied to one of the views do not automatically 
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affect the other views. Therefore a pure 2-D CAD system does not enable you to check the 
consistency of the individual views to ensure a realistic, “true-to-life” representation of the part.  

In a 3-D model, by contrast, each point is described exactly, thus preventing geometrically in-
consistent models and allowing a realistic modelling of parts. Thanks to optimum illumination 
and assignment of material properties, a 3-D model can be rendered in a photo-realistic manner 
and presented in a far more descriptive and promotionally effective way than a 2-D drawing. 
The representation options run the gamut from simple ray-tracing to tracking shots and simu-
lated motion sequences, which comes in handy for presentations on trade fairs or at a 
customer’s company.  

 

6.2 Reduce Errors 
3-D models can be used to evaluate prototypes during the construction process and check their 
functional capabilities in early stages: The earlier errors are detected, the earlier they can be 
eliminated or even avoided right from the start, thus significantly improving product quality while 
reducing production costs.   

Exploded views can be derived directly from the 3-D model. Transport, motion and assembling 
simulations can be performed and checked during the design process, enabling you to detect 
and prevent collisions during assembling and transport processes or motion sequences at early 
stages of a project.  

In the field of conveying technique, for example, you can perform collision checks via simula-
tion, which enables you to reliably assess the operability of a product. In the field of mould 
making, you can use motion or assembling simulation to analyse moulding processes.     

 

6.3 Work Flexibly 
3-D bodies can be processed and modelled much easier:  For example, if you add a bore 
somewhere in a 2-D drawing, you are forced to adjust the different views of the model individu-
ally. But if you add the bore in 3-D, the production drawings will be adjusted automatically.  

Furthermore, designing in 3-D allows a significant reduction of routine and/or repetitive tasks 
due to many automation technologies, e.g. Feature Technology or Referencing.   
 

6.4 Accelerated Product Development 
Another advantage of 3-D models over 2-D drawings consists in the fact that they contain much 
more data. This enables the user to process 3-D models including their data with subsequent 
applications. Analyses and simulations on a virtual model are just as possible as Rapid Proto-
typing, FEM calculations or the automatic generation of tool paths.  

Altogether, the superior geometry data of the 3-D model allows a broad range of applications 
and processings throughout the entire production process.  The tighter integration of all depart-
ments involved in the process enables a significant reduction of product development times, 
which constitutes an important factor for global competitiveness.  
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7 About the ISD and HiCAD 
7.1 About the ISD 
The ISD Software und Systeme GmbH is one of the worldwide leading providers of highly 
integrated CAD/CAM/PDM solutions for innovative product development processes.  

Our software solutions for Engineering and the manufacturing industry are developed at our 
headquarters in the Technology Park Dortmund. These are:  

 HiCAD, the CAD system for development and design engineering,  

 HELiOS, the PDM solution for the organisation of product development processes, 

 HiCAM, the CAM product group for a passing of construction data to NC-controls in produc-
tion departments.  

In addition, you can also use our wide range of services, including Consulting, Product Devel-
opment, Installation, Training, Maintenance and Hotline, which enable short lines of 
communication, high flexibility and an optimum adaptation to customer requirements.  

More information about the ISD and its product can be found on the Internet at:  
http://www.isdgroup.com 

 

7.2 About HiCAD  
HiCAD is a CAD solution for the entire product development and design engineering process. 
Due to its modular structure, the program is just as suitable for beginners as for complex, highly 
automated construction processes.  

2-D/3-D functionality, object-oriented working and an associative data structure allow a very 
convenient operation. The hybrid data model with surface/solid modeller, Feature Technology 
and Freeform Surface modeller enables an extremely high performance, which can even be 
increased further by the following Industry Modules:  

 Steel Engineering / Metal Engineering, 
 Stairs construction, 
 Sheet Metal, 
 Plant Engineering, 
 P+ID (Piping & Instrumentation Diagrams),  
 Freeform Surfaces,  
 Macro Programming,  
 2-D and 3-D Variants, 
 Assembling/Transport/Motion simulations, 
 Integrated Product Data Management, 
 BOM creation, ERP interface, data transfer to NC programs 
 … and many other programs. For further information, please contact your sales agent.  

 

HiCAD’s intuitive user interface enables a quick familiarisation with the product and easy ac-
cess to 2-D/3-D data structures as well as to the integrated Industry Solutions.  The 
extraordinary versatility of HiCAD enables a combined, simultaneous working in 2-D and 3-D – 
in one file!  

You can save your existing 2-D data and use the 2-D->3-D Conversion module to automatically 
convert your 2-D drawings to 3-D model drawings at any time!  
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An integral part of HiCAD is the Information + Communication Navigator (ICN), which clearly 
outperforms common structure browsers. The ICN provides direct access to all opened models, 
drawings and views, part and assembly structures, attributes and the PDM properties of individ-
ual parts. You can create and process your drawing while the ICN is open. During the process, 
the representation in the ICN is constantly adjusted to the actual construction in the drawing 
area. All structures and properties can be modified or processed via mouse-clicks in the ICN. In 
this way, you can also activate a wide range of part processing functions. Multiple selection 
options (as known from Windows applications) enable a modification of several parts in one 
single processing step.   

HiCAD’s Performance Characteristics: 

 Microsoft Windows Standard 
 Combined working in 2-D and 3-D 
 Part-oriented designing 
 Information + Communication Navigator (ICN) 
 Automatic object snap and context menus 
 Extensive Symbol and Standard Parts Libraries 
 Macro Technology and Macro Recorder 
 HiCAD Constraint Manager (HCM) 
 2-D->3-D Conversion Technology 
 Assembling/Transport/Motion Simulation 
 Freeform Surface Technology  
 Part Referencing  
 Part-oriented Feature Technology 
 Material Editor and lighting models  
 Integrated Product Data Management 
 Data transfer from other systems (CATIA, ME10, STEP, DXF, DWG etc.) 
 BOM creation, ERP interface, data transfer to NC programs 
 Powerful Industry Solutions 
 Modular, extendable structure 

 

7.2.1 HiCAD’s Concept at a Glance 
 The Information + Communication Navigator (ICN) provides a permanent overview of com-

plex structures and data. It enables you to control and process your drawing and provides 
quick access to individual drawing components.  

 The unique 2-D<->3-D associativity within one file is enabled through a combination of 3-D 
design and 2-D legacy data maintenance.  

 Comprehensive Industry Solutions for Steel Engineering, Plant Engineering, Sheet Metal 
and many other fields of industry provide optimum functionality for all use cases.  

 The combination of parametric and non-parametric modelling enabled through our self-
developed ESM kernel guarantees a maximum of flexibility.  

 Significant time savings can be achieved through the automation of standard component 
creation via Macro and Variant Technology.   

 Function simulations and analyses help you avoid errors in the 3-D model at an early stage.   
 Top-performance even for large assemblies consisting of tens of thousands of parts.  
 The integrated PDM functionality ensures a safe referencing, thus creating the basis for 

Concurrent Engineering. 
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 The system is operated in a similar way as Windows applications, which enables a quick 
familiarisation and keeps training costs low.  

 

7.2.2 2-D<->3-D Associativity 
The so-called “2-D<->3-D associativity” enables a combined, simultaneous designing in 2-D 
and 3-D at any time.   

As HiCAD provides such associativity, a HiCAD drawing can contain 2-D and 3-D objects from 
various industries in one file.   

“2-D<->3-D associativity” means in particular:   
 For example, views created with HiCAD 3-D can be turned into production drawings with 

the help of 2-D functions. As dimensionings and texts have already been entered in the 3-D 
model, they will already exist in the derived views.  

 2-D drawings – even from foreign systems – can be used as a basis for the creation of 3-D 
model drawings. The 2-D->3-D Conversion module, which has been especially developed 
for this purpose, enables an automatic conversion of 2-D detail drawings to 3-D models.  
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8 The Screen Configuration 
HiCAD’s user interface is based on graphical symbols. All functions can be selected via self-
explanatory symbols.   

 
Fig. 2  The HiCAD User Interface (Default configuration) 

 

The HiCAD user interface mainly consists of the following areas:  
 the drawing area,  
 the transparent toolbar, 
 the multifunctional toolbar (“Ribbon”),  
 the tabs of the Ribbon,  
 the QuickAccess toolbar, 
 the Information + Communication Navigator (ICN), 
 the info bar with user guidance texts, 
 the “Surface/Line/Edge Parameters” bar,  
 the status bar. 

 

With the exception of the drawing area and the Ribbon, the above elements of the user inter-
face can be freely positioned, hidden and re-displayed again.  
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8.1 The Drawing Area 
In this area you create and process your drawing. The drawing detail displayed in this area is 
the current (active) detail. Use the Zoom functions to enlarge or downsize the detail.  
 

8.2 How Do I Select a Function? 
You use the functions of the Ribbon, the context menus, the transparent toolbar, and the Quick-
Access toolbar to tell HiCAD what tasks you want to perform.  
 

8.2.1 Multifunctional Toolbar (“Ribbon”) 
The Ribbon is composed of different tabs, which in turn consist of several function groups. Most 
of the functions are illustrated with small images (symbols). To select a function on the Ribbon, 
just left-click the desired function. If you activate a different tab, you will obtain different func-
tions.  
 

8.2.2 Context Menus 
If you right-click a part, a 3-D view (pink dotted rectangle), the drawing area or a dimensioning, 
a context menu for the selected object will be displayed. Examples: If you right-click a 2-D or 3-
D part in the drawing area or in the ICN, you will get various part-specific functions such as 
“Translate part”, “Subtract part” etc. If you right-click the drawing area, you are offered drawing-
specific functions, such as “Change scale” or similar. If you right-click a dimensioning of a draw-
ing object, you are offered various dimensioning functions. The selecting of functions via 
context menus is often the quickest way to call a function: If you select an object by right-
clicking it, you automatically indicate to HiCAD which of the parts or dimensionings you want to 
modify or process.  

 

                   
Fig. 3  Context menu of a 3-D part (left) and of a view (right) 
 

see 
Online 
Help 
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8.2.3 Pull-Down Menus 
Pull-down menus are called via the function groups of the Ribbon. You open them by clicking 
the arrow symbol in a function group. To select a function in the pull-down menu, left-click it.  
 

 
Fig. 4  Example of a pull-down menu  

A pull-down menu can contain sub-menus. Functions containing sub-menus are identified by an 
arrowhead pointing to the right. The sub-menu is displayed if you move the mouse pointer on 
an appropriately identified menu item:  

 
Fig. 5  Sub-menu of pull-down menu  

Please note: 
 If a pull-down menu is already displayed for a function group of the Ribbon, just move the 

mouse pointer over the other menu items. If there is a sub-menu to the menu item, it will be 
displayed without a further mouse click.  

 To close a pull-down menu, simply left-click outside the pull-down menu.  
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8.2.4 Pop-Up Menus 
In contrast to a pull-down menu, a pop-up menu can appear in any visible position of the screen 
area. You activate a pop-up menu by a right-click. 

In HiCAD one distinguishes between two types of pop-up menus:  
 Pop-up menus providing functions for quick access and designing alternatives  
 Context-sensitive pop-up menus, also called context menus.  

QuickAccess Functions and Designing Alternatives 
If the cursor points on any function, right-click to open the below menu containing several 
QuickAccess functions. You can use this menu, for example, to take over frequently used func-
tions into the QuickAccess toolbar.  
 

 
Fig. 6  Right-click on any function 

 
Now let us assume that we have already activated a function, e.g. “Rectangle, 2 points, 
Sketch”. Now you can right-click to open a pop-up menu with designing alternatives (sub-menu) 
for this menu item or function:    

 
Fig. 7  Sub-functions of the 2-D function Rectangle, 2 points, Sketch 
 

Context Menu 
If the cursor points on an object in your drawing, e.g. on a part, a view or a dimensioning, right-
click to activate a context menu with appropriate functions for the selected object. Please also 
see chapter “8.2.2 Context Menus“. 
 
A pop-up menu appears directly under the current cursor position. Left-click outside the menu to 
close the pop-up menu again.  
 

8.3 The Info Bar with User Guidance Texts 
In this field, which can normally be found at the bottom of the HiCAD screen, the user guidance 
texts are displayed. These texts show you what further steps need to be taken to execute a 
function.  Especially in case of functions requiring reactions to several prompts it is very impor-
tant that you take a look at the Info bar to see the next step that HiCAD prompts you to take. 
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Fig. 8   The Info bar with user guidance texts 

Furthermore, the user guidance text tells you whether you can activate a context menu with a 
right-click or whether any special functions are available.   

Please note that you can display a further bar with user guidance texts via Settings > Docking 
windows > Info Bar, as shown in the figure below:  

 
Fig. 9  Additional Info Bar with user guidance texts 
  

8.4 The Status Bar 
The fields in the Status Bar solely serve the purpose of information. They contain  

 the name of the active part, 
 the active view,  
 the scale of the current drawing,  
 the type of the selected coordinate system, and 
 the current cursor coordinates 

are displayed.  

 
Fig. 10   The Status Bar (detail) 

9 The HiCAD Drawing  
Construction files in HiCAD are referred to as Drawings. They have the file extension .SZA.  

A drawing consists of 2-D and/or 3-D parts. These can, for example, be individual parts, as-
semblies or bores.   

For the sake of structuring, one distinguishes between  
 Main parts and  
 Sub-parts.  

This structure is referred to as Part structure and constitutes the basic concept of all HiCAD 
applications. 

see 
Online 
Help 



                                                        The HiCAD Drawing 

HiCAD  Basics  23 

 

Fig. 11  Part structure in 3-D 

In the 2-D module, too, there are main parts and sub-parts. As in the 3-D module, main parts 
are independent parts, i.e. such parts which do not belong to any other part. Sub-parts are parts 
which belong to another part (or assembly), to which they have been welded, bolted, glued etc.   
 
Generally, a HiCAD drawing contains information on:  

 the coordinate system and the unit of measurement, 
 the 2-D and 3-D parts,  
 the hatchings, 
 the 2-D and 3-D texts, 
 the 2-D and 3-D dimensionings,  
 the non-graphical elements (object data). 

 

9.1 What is the Purpose of Part Structures? 
Especially when dealing with very complex drawings, a logical structuring of data is absolutely 
essential. In HiCAD such structuring is enabled by a subdivision of drawings into main parts and 
sub-parts. This part-oriented structure allows constructions whose logical composition corre-
sponds to that of real products, consisting of a main assembly, (sub-)assemblies, and individual 
parts.  

The HiCAD part structure is displayed in the form of a “tree structure” – similar to the directory 
structure of your hard disk on your computer.  

The benefits: 
 The drawing has a clear, descriptive structure. 
 You can link production data and BOM information to the constructed part.  
 The part structure enables the creation of structure lists and quantity lists.  
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 The parts where-used list promotes a re-use of parts.  
 Company-specific series can be represented via part parameterisation.  
 Parts can be transferred from a draft to a detail drawing for production. 
 Re-used parts can be changed in one step in all drawings.   
 Designing in 2-D requires overlap calculations in the assembly drawing, which are realised 

via the overlap levels of the parts.  
 The associativity of hatchings is realised via the part.  
 Scaling for individual parts, independent of the drawing scale, enables better representa-

tions. 
 Processing functions usually refer to parts.  

 
 
The observance of a logical and clear part structure automatically leads to a professional, me-
ticulous and clean construction of the parts. In this way, error sources are reduced significantly. 

 

An overview of the part structure of you current drawing is displayed in the middle window of the 
Information + Communication Navigator (ICN). 

 
Fig. 12  Part structure in the Information + Communication Navigator  

9.1.1 Main Parts and Sub-Parts 
A main part is the highest organisational unit in a HiCAD and can in turn consist of several sub-
ordinated parts, which are called sub-parts. These sub-parts, too, can consist of further sub- 
parts.  The subdivision of part into main parts and sub-parts serves the purpose of a logical 
structuring.    
Just like a drawing, each main or sub-part has its own name enabling its retrieval or activation.   
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10  Basics of the 2-D Module 
The operation of the 3-D module requires basic knowledge of the 2-D module. The following 
chapters will therefore deal with various 2-D functions and exercises, and mainly concentrate on 
the topics which will later also be relevant for the operation of the 3-D module (e.g. point op-
tions, part structure etc.).  If you have already attended the HiCAD 2-D Training, you can skip 
the next chapters and begin with Chapter 30. 

  

10.1 Drawing Creation: The First Steps 
To create a new, initially empty drawing file, select the New drawing function.   

You have the following options to activate this function:  
 Activate the Drawing tab on the Ribbon, and then select the New drawing function in the 

New/Open function group. 
 Select the keyboard combination CTRL+N. 
 Select the New drawing function on the QuickAccess toolbar (at the top of the screen).  

 

The further procedure depends on whether you want to create a drawing with or without data-
base:  

Procedure WITH database (additional module)  

If you want to create a drawing with database (additional module), activate in the HiCAD Start 
Centre the checkboxes Create new drawing and Enter drawing into database and select a 
scale. After clicking OK, select New drawing, without part master. If you also want to use the 
Part and BOM Management of the database, select New drawing, with part master. This pro-
cedure is explained in detail in a separate database training.  

If you select the New drawing, without part master option, the following input mask for docu-
ments appears:  

 
Fig. 13  New drawing, with database (additional module). Input mask for documents 
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The scale of the current settings in the HiCAD Start Centre is applied. If you right-click the draw-
ing area you can change the scale with the Main scale function.  
 

Procedure WITHOUT database 

If you want to create a drawing without database, activate in the HiCAD Start Centre the Create 
new drawing checkbox, but do not activate the Enter drawing into database checkbox. After 
clicking OK, the new drawing automatically obtains the name “DRAWING”, followed by a con-
secutive number. Use the Save as function in the QuickAccess toolbar to replace this name by 
a more descriptive name.  

 
Fig. 14  New drawing, without database. Automatically created drawing name “DRAWING1”  

 

10.2 Creating a 2-D Part 
As described above, a HiCAD drawing can contain 2-D and 3-D parts which in turn consist of 2-
D graphical elements and 3-D geometry elements. Each of these parts can be a main part or 
sub-part, or - when working with the 3-D module - an assembly or main assembly.  

A Main assembly (e.g. a Main assembly ‘Motor’) is the highest organisational unit in the draw-
ing and can in turn consist of several Assemblies, e.g. Assembly ‘Drive’ and Assembly ‘Sheet 
covering’. The Assemblies are made up of individual parts, such as base sheet, lateral sheet LH 
or lateral sheet RH. For the sake of a clear structuring, one distinguishes between Main parts 
and Sub-parts.   

This part-oriented data structure enables the creation of constructions whose logical structure 
corresponds to that of real products. It is therefore recommended that you plan your product 
structure before you begin with your actual drawing and arrange the part structure of your prod-
uct appropriately.  

As for the drawing, each part, whether main part or sub-part, is assigned a name via which it 
can be retrieved or activated.  

Please note: In contrast to the 3-D module, there are no explicit assemblies or assembly main 
parts in the 2-D module.  Here we use only main parts and sub-parts. If desired, we can how-
ever call a 2-D main part, e.g. Main assembly ‘Motor’ and a sub-part, e.g. Assembly ‘Sheet 
covering’.   

 

10.2.1 2-D Main Part  
To create a new 2-D main part, use the New main part function.  You can access this function  

 in the New function group of the 2-D Part tab of the Ribbon, or 
 by right-clicking on a free space in the drawing area. 

Select the New main part function and enter the part name. Then switch to the construction 
functions in the 2-D Geometry tab.  
 

10.2.2 Main Assembly (2-D) 
In the New function group of the 2-D Part tab you will also find the Main assembly (2-D) func-
tion. As with the “New main part” function, you create a 2-D main part – with the difference that 
all existing 2-D parts are automatically moved below the newly created 2-D main assembly. 

 

 

See 
Online 
Help 
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Fig. 15  Functions for the creation of a 2-D part          

 
Fig. 16  Functions for the loading of parts 
 

Select the required function (e.g. New main part) and enter the part name. Depending on the 
selected function, choose the required construction function from the Ribbon or the pop-up 
menus.  

A detailed description of the individual design functions can be found in the Online Help.  
 

You can also access the different functions by right-clicking an existing part. The context menu 
will only offer appropriate functions for selection, i.e. if you select a 2-D part, the context menu 
will only contain functions for creation and processing of 2-D parts. If you right-click a 3-D part, 
the context menu will only contain 3-D functions etc.  
 

10.2.3 New 2-D Sub-Part 
To assign a new sub-part to a part, right-click the part to which you want to assign a new sub-
part. Select 2-D Part, New, then select New sub-part. 

Please note: You can right-click the part either in the drawing area or in the ICN (struc-
ture browser).  
 

10.2.4 The Active Part 
The currently selected part in the drawing is called “active part”. The HiCAD processing func-
tions normally refer to this part. For example, when inserting dimensionings or texts in a 
drawing, they are always assigned to the currently active part. Active parts are marked red in 
the ICN (Information + Communication Navigator). 

You have the following options to activate a part in a drawing:  
 Move the mouse pointer on the part and click the part. The following part-relevant functions 

will then be applied to this part.  
 Activate the part in the ICN. 
 Move the mouse pointer on the part and right-click the part. A context menu appears, dis-

playing the possible processing functions for this part. A right-clicked part is automatically 
activated.  

see 
Online 
Help 
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11 Point Options 
11.1 General 
In this chapter we will learn how to use so-called point options and several ways to select them.  

Point options are used for line functions, transformation functions or similar, e.g. to specify the 
position of a line, rectangle or translation vector. Almost all point options in 2-D can also be 
used for 3-D parts.   

First, let us take a look at the rectangle function to which we will apply various point options at a 
later point:  

Rectangle, 2 points 
The Ribbon is made up of numerous tabs, which in turn consist of several function groups (see 
Chapter 18 “The Screen Configuration“). The Polygon function group of the 2-D Geometry tab 
contains functions enabling you to  

 sketch rectangles or define them via specification of 2 points,   
 draw or translate rectangles in a particular angle 
 draw hexagons, octagons and n-gons  

Line colour and line type can be set at the bottom of the screen.  
 

11.2 How to Select Point Options 
11.2.1 Selection of Point Options 
Point options are used to create, identify or position parts. They can be considered subordinate 
functions to the other functions. To activate a point option, you first need to call another function 
(e.g. “Rectangle, 2 points“, “Polyline“, or “Translate part“), which requires an object identification 
or a point specification first.   

 

There are 5 different ways to select a point option: 

The HiCAD Autopilot:  
If you want HiCAD to suggest a snappable point to you, place the cursor in the vicinity of this 
point. If the Autopilot has found the point, an appropriate symbol is displayed next to the cursor:  
 

 
End point 

 
Mid-point of line 

 
Genuine intersection 
point  

Circle/Arc centre 

 
Perpendicular base 
point  

Osculation point 

 
Isolated point 

 
 

Theoretical intersection 
point 

Fig. 17    Snap point symbols (Examples) 

 

You apply a snap point by a simple left-click.  
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Selection via RETURN Key: 
If HiCAD requires the specification of a point, you can open the point options dialogue by press-
ing the RETURN key. The following point options menu is displayed:  

 
Fig. 18  Point options menu; activated, after suggestion of a point option by HiCAD, via RETURN key, quick double-click 
or RMB 

 

Selection via Quick Double-Click: 
If HiCAD requires the specification of a point, you can open the point options menu with a quick 
double-click (LMB). Please make sure that when you double-click, HiCAD does not suggest any 
snap points. As with the pressing of the RETURN key, the point options menu shown above is 
displayed.  

Selection via Keyboard: 
Numerical point options, i.e. point options for arbitrary coordinate entries and point numbers, as 
well as some angle functions can also be selected via the keyboard.  These are all point options 
with one letter, i.e. R, A, D, P, W und N: 

 Activation by simple entry of the point option letter with the keyboard (e.g. A for Absolute or 
R for Relative). The point option Relative (R) can also be activated with the space bar.  

Please note: All point options with one or two letters, i.e. AX, AY, AR, D2, D, A, P, PX, PY, R, 
W, WX, WY and N, can be directly changed in the HiCAD pocket calculator, by simply overwrit-
ing the point option specification at the start of the input field (followed by a space).   

Selection via RMB: 
Move the cursor close to a graphical element, a dimensioning, or similar. As soon as the HiCAD 
Autopilot suggests a point option, press the right mouse button. The point options menu is dis-
played.  
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Complete list of point options in HiCAD: 

 

(E) Online to nearest line/edge, 
through point   

 
(I)  Snap point  

 
(AX)  Absolute X-Position 

  

(S)  Genuine intersection point 

 

 
(AY)  Absolute Y-Position 

  

(S2)  Theoretical intersection point

 

 
(AR) Point from X- and Y-Position 

  

(LU)  Zoom 

 
(VI) From point I 

 

(FF)  Perpendicular to surface 
(only 3-D) 

 

 
(V) From point 

 
(SP)  Surface centroid 

 
(M2)  Mid-point between 2 points 

  

(SK)  Body centroid (only 3-D) 

 

 
(ZP)  Centre of polyhedral circle 

 

(R)  Relative coordinates 

 
(O)  Online to edge through point 

 

(W)  Relative angle and distance 

 

 
(J)  Isolated point 

  

(WX) Relative angle and X-
distance 

 
(SD)  Intersection point 2-D/3-D 
lines 

 

(WY) Relative angle and Y- dis-
tance 

 
 (M)  Midpoint of line/edge 

  

(FL)  Perpendicular base point on  
line/edge 

 

(ZD)  3-D point from 2-D drawing 
 (only 3-D) 

 

(F)  Perpendicular base point on 
nearest line/edge 

 
(D)  Distance from line/edge start

 

(G)  Mirrored point 

 
(A)  Absolute Position 

  

Enter via keyboard 

 
(P)  Absolute angle and distance 

 
(Z) Centre 

 
(PX)  Absolute angle and X-
distance 

 
(L) Last point 

 
(PY)  Absolute angle and Y-
distance 

 
(OF) Online to surface through 
point (only 3-D) 

 
(SZ) Sketch 

 
Switch snap radius on/off 

 
(T)  Tangent  

 
(KF) Intersection point 
Edge/Surface (only 3-D) 

 
 (RET)  Apply current cursor 
position 

 
(N) Named point 

 
(QP)  Quad point  

 
(B)  Dimensioning point 

Fig. 19  Overview of 2-D and 3-D point options  
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11.2.2 Some Exemplary Point Options 
The following paragraphs illustrate the exemplary point options “Relative coordinates”, “Online 
to nearest line and Distance from line start. All other point options are described in detail in the 
Online Help. You access the Online Help by pressing the F1 key or clicking the question mark 
symbol at the top right of the HiCAD user interface.  

 

Relative Coordinates 
Select these point options to set a point with X- or Y-coordinate values relative to an existing 
point (reference point). The reference point is the last entered point in the active function.  

 Activate the 2-D point options. 
 Choose point option R. 
 Enter the values X and Y (e.g. 50 40). 

R 50 40
point found

last point
50

 

Fig. 20  Relative coordinates 

You can now enter further X/Y coordinates to create the next relative point.  

Values from the drawing can be taken over by using auxiliary codes: 

Z Taking over of a value from the drawing, 

L Taking over of the last distance 

FA Specification of a scaling factor 

 

Snap point 
Use this point option to identify the point at the end of a line or the contact point of two lines 
(corner).  

 Place the cursor in the vicinity of the line the end of which you want to identify.  
 Activate the 2-D point options. 
 Select point option I. 

HiCAD identifies the line end or the line corner which is nearest to the cursor position.  

 

Online to Nearest Line 
Use point option O to set a point onto a line.  

 Activate the 2-D point options.  
 Select point option O. 

 
R 

 
I 

 
O 



Point Options 

32                                                                                                                                            HiCAD  Basics 

last point

Online from
current cursor
position

point found

 
Fig. 21  Online to nearest line (shortest way from cursor position to nearest line) 

 

With this option you can place the end point of a polyline exactly on a line. HiCAD takes the 
shortest way from the cursor position to the nearest line. This point option is frequently used for 
placing processing symbols on lines. 

 

Distance from Line Start  
Use this point option to set a point on a line element via the distance to the reference point. The 
reference point is the start point of a selected line.  

 Activate the 2-D point options. 
 Select point option D. 
 Enter the distance. If you do not enter a distance, HiCAD offers the distance from the start 

point to the end point of the line.  
 Identify the reference line in the vicinity of the start point on that side of the line from which 

you want to define the distance for the new point on the line.  

The side of the start point determines the direction of the distance from the start point to the 
new point on the line. If you enter a distance of 40 mm, and select the reference line in the vicin-
ity of the left start point of the line, HiCAD moves 40 mm from the left start point along the line 
(from left to right) and places the new point there. If you enter a negative value, HiCAD moves 
away from the line.   

The value is saved internally and remains available for a possible re-use as “Last distance”, 
auxiliary code L. 

element
identification element

identification

option D 20 option D 40

point found point
found

 
Fig. 22  Distance from line start 

 

Instead of entering a value for the distance, you can also take the distance over from the draw-
ing, by using, as for point option R, the auxiliary codes L, Z or FA. 

 
D 
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12 How to Use the Mouse Buttons 
HiCAD is operated via the mouse. You use the mouse buttons as follows:  

 

Mouse But-
ton 

Function  

Left  
(LMB, RET) 

 

 Activation of part, elements, beam/profile 
groups or other objects (depending on the cur-
rent identification mode) 

 Marking/Selection of objects  
 Calling of functions 
 Confirmation of entries (e.g. radii etc.) 

 Drag&Drop of views, dimensions, texts etc. 
(press and hold down mouse button) 

 Zooming of drawings (press and hold down 
mouse button) 

Right  
(RMB, END) 

 

 Activation of context-sensitive menus:  
 If a function containing sub-functions is ac-
tive, a pop-up menu with appropriate 
functions is displayed.   

 If an object has been selected, a context 
menu with appropriate processing functions 
for this object is displayed. For example, if 
you right-click a dimensioning, a context 
menu with dimensioning function appears, if 
you right-click a view, a context menu with 
view functions is displayed etc. A right-
clicked object is automatically activated. 

 Special functions (see info bar) 
Middle  
(MMB, ESC) 

 

 Cancelling of functions 
 Scrolling of drawings (mouse wheel) 
 Dynamic rotation of views  

(If you have only a mouse with 2 buttons, you can, in-
stead of pressing the MMB, press the LMB and RMB 
simultaneously. If you have a wheel mouse, you use the 
wheel as MMB.) 
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13 Select Functions via the Keyboard 
You can use the keyboard of your computer, or various keyboard shortcuts to call functions: 

Key allocations for the processing of drawings   
 
↑, ↓, →, ← Move (translate) drawing detail 
Page 
up, Page 
down   

Zoom in, Zoom out 

Home View all 
ESC Cancel 
End Define detail 
Del Redraw 
Ins Rotate view 
F1 Activate Online Help 
F2 Dynamic zoom 
F3 Hide/show 3-D coordinate system 
Ctrl+C Create graphic detail from drawing and copy to 

clipboard (EMF or Bitmap) 
Ctrl+K Move 3-D CS representation (see F3) 
Ctrl+N Create new drawing 
Ctrl+O Open drawing 
Ctrl+P Print 
Ctrl+S Save drawing 
Ctrl+Z UNDO 
Ctrl+ +Z REDO 
Ctrl+6  Variables memory 
Ctrl+7 Create macro 
Ctrl+8 Call macro 
Ctrl+W Create graphic detail from drawing and save/copy to 

clipboard 
Ctrl+Alt+W Identical with Ctrl+W 
0 3-D Processing plane 
1 Only show active 3-D part 
2 Show all parts 
3 Standard axonometry 
7 Glass model 
8 Shaded without edges 

 
 
Key allocations for the display of parts in the ICN 
 
↑, ↓ Switch active part, 1 row up / down 
Page up, 
Page down  

Move to top/to bottom  

Pos1 Jump to first item 
End Jump to last item 
Del Delete item in part structure 
Ctrl+A Select all parts 
Ctrl+C Copy part / part list to clipboard 
Ctrl+F Find 
Ctrl+V  Paste part / part list from clipboard 
Ctrl+X Cut part / part list 
Ctrl+Z UNDO 
Ctrl+ +Z REDO 
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14 More Functions and First Excercise 
14.1 Change Point Options without Ending the Line Function 
 

Many point options are “infinite” functions. An example: You have selected the Polyline (2-D) 
(without sketch!) function and use the Relative coordinates (R) point option. As long as your 
polyline does not leave the currently selected detail of the drawing area, you can, after confirm-
ing the X- and Y-coordinates, use the Relative coordinates point option again. If you want to 
continue the polyline with a different point option, e.g. Absolutes angle + distance (P), left-
click on the drawing area, then press the RETURN key to access the point options. You can 
then continue with a point option of your choice, e.g. with Absolute angle + distance (P). 
 
 

Tip 1: Point options can be directly overwritten. You can, for instance, overwrite the letter “R” 
and the space with the letter “P”. (do not forget to re-enter the space!).  
 

Tip 2: Let us assume that you have left-clicked on the drawing area and pressed the RETURN 
key to access the point options. You could also have right-clicked and selected the Polyline >  
Continue function in the context menu. After this, you could also have pressed the RETURN 
key to get to the point options.  
 

Tip 3: After pressing the middle mouse button (MMB) you could have selected point option (P) 
by pressing the P key on your keyboard.  
 

14.2 Insert Drawing Frames and Title Blocks 
Use the Insert drawing frame to insert a drawing frame with title block as main part into the 
active drawing.  You access this function either by selecting Insert Part > Insert drawing fra-
me on the Drawing tab, or via the context menu of the drawing. 

 Activate a view of the Sheet area. 
 After selecting the Insert drawing frame function, the selection menu for DIN frames ap-

pears. Select an appropriate frame in DIN format and specify how you want to complete the 
title block.  

 Specify the fitting points for the position of the frame. The title block is completed automati-
cally (if the corresponding option was activated in the previous step).  

The DIN frame is always inserted as a main part into the drawing. The part becomes not visible 
until you right-click on the name of the drawing in the middle window of the ICN (2-D Part struc-
ture) and select Auxiliary parts On/Off > Auxiliary part On.  

If you have changed part master data and want to update the title block accordingly, use the 
Update title block function in the HELiOS PDM functions for active drawing function group 
of the Helios PDM  tab. If you work without database, you also can complete the title block sub-
sequently. On the Drawing tab, select Extras > Tools > Complete title block. 
 

14.3 Save Drawing 
To save the current drawing, select the Save drawing function.  

You have the following options to activate this function:  
 On the QuickAccess toolbar, click the Save drawing symbol.  
 Select the same-named function in the Save/Print function group of the Drawing tab. 
 Select the keyboard shortcut CTRL+S. 

If you want to save the drawing with a different name or via an Interface, select the Save as … 
function on the QuickAccess toolbar. 
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14.4 Exercise 1 (2D-GL-01.0) Plate 
 Learning target: Creating a drawing, creation of main parts; purpose of the three mouse 

buttons; point options; different methods to select the point options (via the HiCAD Autopilot, 
Return key, keyboard etc.); functions (like View all, Rectangular zoom window etc.), which 
can be selected via the keyboard; drawing frame; save drawing. 

 Create a new drawing with the database (additional module!). If you do not have a database 
in your company, you are enabled to switch the database function off on your training com-
puter. 

 Create the main part “Plate”. 
 Create the graphic elements of the “Plate” exercise in the given order! 
 Save the drawing. 
 Space for notes: 
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15 Point Option R (RET) 
If you do not want to refer to the last used point when using a relative point determination (i.e., 
for example: R, P, PX or PY), but select a different reference point, close the corresponding 
mask without any value entries (i.e. without making any entries, left-click on the drawing area or 
press the RETURN key). HiCAD first prompts you to specify the new reference point, and then 
to enter the coordinates.    

This applies, for example, to the functions:  
 R – Relative, 
 P – Polar coordinates, 
 PX – Polar coordinates with X-distance 
 PY – Polar coordinates with Y-distance 

 
Point Option R (RET) is by far the most versatile point option. It enables you, for instance, to 
replace almost all auxiliary lines.  
In the following example, you want the corner B of the second rectangle to be positioned at a 
distance of 100 to the right and 25 to the bottom relative to the corner A of the first rectangle.  
 

100

-2
5

A

B

 
Fig. 23  Point option R(RET) 

 
 Select point option R, e.g. by pressing the R key on the keyboard (do not enter any num-

bers). 
 Press the RETURN key or left-click on the drawing area.  
 Specify reference point: Corner A (see image above) with point option I 
 Enter 100 for the X value, and -25 for the Y value. 
 End point of rectangle with point option R (e.g. 120 60). 

 
Instead of R(RET) you can also select point option V. If you select V, you specify a reference 
point with an arbitrary point option. An input field appears enabling you to enter an X- and an Y-
coordinate to specify the movements from the reference point to the right, resp. to the top (for 
negative coordinates: to the left, resp. to the bottom). 

Instead of R(RET) you can also select point option VIS. If you select VIS, HiCAD automatically 
uses the intersection point or the line end with is closest to the cursor, as reference point. An 
input field appears enabling you to enter an X- and an Y-coordinate to specify the movements 
from the reference point to the right, resp. to the top (for negative coordinates: to the left, resp. 
to the bottom). 

 
R     

(RET) 
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16 Notes on the Information and Communication Navigator 
(ICN)  
An integral part of HiCAD is the so-called Information + Communication Navigator (short: ICN), 
which, in terms of versatility, surpasses common structure browsers by far.   

The ICN enables permanent, direct access to all opened models, drawings and views, to as-
sembly structures, attributes and PDM properties of the individual parts. The ICN identifies 
referenced parts appropriately and supplies information about parts which have changed or are 
currently processed.   

View structures are also visualised, including all dependencies between views and 2-D/3-D part 
structures, as well as between 3-D models and list views. You can switch between views in the 
ICN, without having to activate any view function.  

The design process can take place while the ICN is open; the navigator display is constantly 
synchronised with and adjusted to the construction object in the drawing area. All structures and 
most of the properties can be directly processed in the ICN via mouse click. In addition, many 
part processing functions can be activated by right-clicking a part in the ICN. Multiple selection 
options (as known from Windows) enable you to change several parts at once, with one single 
processing step.  

 
Fig. 24  The Information + Communication Navigator (Example)  

Upper ICN window 

Tabs: Views, Switch drawing 

Middle ICN window 

Tabs: 2-D Part structure, 3D-part structure 

Lower ICN window 

Tabs: Feature, HCM, Graphic, Properties 
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HiCAD can also manage objects without part character, e.g. auxiliary lines, DIN frames, etc. In 
the middle window of the ICN, right-click on the name of the drawing and select the Auxiliary 
parts On/Off function in the context menu of the drawing.  

For more detailed information on the ICN please read the “The Information + Communication 
Navigator” chapter of this training book. 

  

17 Main Parts and Sub-Parts 
The structure of main parts and sub-parts (part structure) is a basic idea of all HiCAD modules. 
Therefore, it is mandatory that you carefully read and understand the contents of the following 
two pages.   

 

 
Fig. 25 Example of a 3-D part structure 

 
Please note:  
Pin and Wheel are mounted to each other, i.e. they belong to one assembly (in our above ex-
ample, this is the Assembly “Swivel”). Via this Assembly “Swivel”, they can be moved, copied, 
deleted etc. together.   
In the same way, Fork, L-Bracket and Threaded rod form a structural unit. Therefore, they both 
belong to the Assembly “Tensioning elements”.  
Both assemblies together constitute the product “Turnbuckle”, which is represented in the part 
structure as the Main assembly “Turnbuckle”. All parts of the drawing belong to this main as-
sembly. This means that if you move the main assembly, all subordinated assemblies and their 
parts are automatically moved (copied, deleted, etc.). 
If, for example, you decide that the Thread rod is not mounted to Fork and L-Profile, but belongs 
to the Swivel, you can move it below the Assembly “Swivel”.  
In the same way, you may want to assign further (subordinate) assemblies to the Assembly 
“Swivel”. Please note however that in the 3-D module you can create only one main assembly 
per drawing.  
 
Please also note:  
In the 2-D module there are no assembly / main assembly parts with an explicit assembly ID. 
The parts are however structured in the same way into main assemblies, (sub-)assemblies etc. 
You can, for example, create a normal 2-D main part and call it Main assembly “Turnbuckle”, or 
a sub-part and call it Assembly “Swivels”.  
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17.1 Interactions and Automatisms within Part Structures 
 Transformations: If, for example, a part is translated or rotated, its sub-parts are automati-

cally moved as well.   
 Overlaps: You can determine for entire 2-D parts whether they should be placed in front of 

or behind another part. You do not need to do this for each single line of the part (in 3-D, 
HiCAD automatically knows the depth of the parts). 

 Hatching: Part hatchings do in no case require any rework. Sub-parts (e.g. bores, cut-outs, 
bolts etc.) are automatically excluded from hatching. When creating assembly drawings, 
contours often change due to part overlaps. Even in this case, rework is not required, as the 
part hatching depends on the part structure, and not on the line contours.  

 Re-use: If you re-use a part in another drawing, all information inherent in this part (hatch-
ing, overlap level, master data for bills of materials, part attributes etc.) are taken along with 
it.  The automatic transfer of master data, for instance, guarantees that in the new drawing, 
too, no part is missing in the bill of materials.    

 Bill of Materials: Can be created “at the push of a button”, as names of the parts as well as 
corresponding master data are already defined in the drawing.  

 

17.2 When Do You Use Main Parts, When Sub-Parts? 
How do you structure a drawing into main parts and sub-parts? 

Part rule: All parts which are, physically, one part (i.e. parts you can pick up with your hands, 
e.g. a flange or a bolt), are regarded as individual parts. Reason: If you want to move or re-
use this part, you can do so in one step and do not need to move each line individually. The 
next two rules decide whether you turn this part into a main part or sub-part: 

Main part rule: If a part is independent and does not belong to any other part in the drawing, it is 
a main part. Please note that in the 3-D module you can create only one main assembly per 
drawing. 

Sub-part rule: All parts that belong together are assigned to a so-called assembly. They are 
sub-parts to this assembly or main assembly. Bores and bolts always belong to a work-
piece, which means that they are always sub-parts (these are automatically created for 
standard parts and construction aids). 
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17.3 Exercise 2 (2D-GL-02.0) Input of Point Options with R(RET)   
 Learning target: Create a drawing; point option R(RET); purpose of the three mouse but-

tons; different methods to select the point options (via the HiCAD autopilot, Return key, 
keyboard etc.); functions (like View all, Rectangular zoom window etc.), which can be se-
lected via the keyboard; activate sheet view; insert drawing frame and save. 

 Create a new drawing with the database (additional module!). If you do not have a database 
in your company, you are enabled to switch the database function off on your training com-
puter. 

 Create a main part “Assembly Wire Bending Cantilever”. 
 Create a sub part “Base plate 150x100” and draw it. 
 Create a sub part “6 Stay Bolts”. 
 The point option R(RET) is the most extensive point option, e.g. you can replace nearly 

every auxiliary line with it. Therefore, use exclusively the R(RET) option to position all 6 stay 
bolts!  

 Save the drawing. 

Hint: Please pay particular attention to the main and sub-part structure. This is the basic idea of 
all HiCAD modules. Main parts are parts which are “independent”, i.e. which do not belong to 
any other part in the drawing. In this exercise the main part is the Assembly “wire bending canti-
lever”. Sub parts are all parts which belong to the respective superior part of the drawing. In this 
exercise the sub parts are the base plate and the stay bolts.   
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18 Point Options P(RET), PX(RET), PY(RET) 
The training book chapter “Point Option R (RET)“ provided an introduction to the same-named 
point option:  First you needed to select the point option “Relative coordinates (R)”, and close 
the mask without entering a value, by pressing the RETURN key. You could then specify a ref-
erence point. From this reference point, you moved to the right, resp. to the top using X- and Y-
coordinates.  

Analogously, you can use the P(RET) function for the “Absolute angle + distance (P)“ point op-
tion. As for R(RET), you close the corresponding mask without entering any values, by pressing 
the RETURN key or left-clicking on the drawing area. HiCAD then prompts you to specify the 
new reference point. After that, HiCAD will not ask for an X- or Y-coordinate, but for an angle 
and an absolute length.   
 

If you select PX(RET) instead of PX, (or PY(RET) instead of PY), the same prompts as for point 
option P(RET) will appear. Only the entered length will not be interpreted as absolute length, 
but as X- (or Y-)length.  

 

19 2-D Construction Aids and Standard Processings 
Various construction aids are available for your drawing. These can be found in the Construc-
tion Aids function group of the 2-D Part tab.  These construction aids are fitted as independent 
parts (i.e. as sub-parts to the active part), they are however usually not shown in the part struc-
ture, as they are no “parts” in the proper meaning of the word, but rather processings of parts. 
The ICN displays only those parts which would also turn up in a bill of materials.  

Use the functions of the Construction Aids function group to draw, besides creating shorten-
ings and details,  

 Bores, countersinks, threads and shaft processings 
 Hole patterns, slots and punchings, 
 Shortenings and details. 

HiCAD will automatically create a sub-part. If it is a “genuine” part (nut, washer etc.), this sub-
part is shown in the ICN. If it is not a “genuine” part, but a processing (bore, countersink, feather 
key etc.) this sub-part is not shown in the ICN, although it exists as a sub-part. It would, for ex-
ample, be transformed (translated, rotated etc.) together with the superordinate part. 

You can however visualise automatically created main parts and sub-parts:  In the middle win-
dow of the ICN, right-click the name of the drawing and select the “Auxiliary parts On/Off” 
function.  

 
Abb. 26  Right-click name of drawing and select “Auxiliary parts On/Off” 

 
P 

(RET) 

 
PX 

(RET) 

 
PY 

(RET) 
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The selected parts can be inserted into the active drawing repeatedly if required. Right-click to 
end the insertion and select a different construction aids.  

 

Bore, Top View and Bore, Side View 
Use these functions to create an individual bore for a through hole with a crosshairs. The bore 
can be inserted repeatedly, if required.  

 Enter the diameter of the bore. 
 If you select Bore side view HiCAD prompts you to specify the length.  
 Select the insertion direction.  
 Specify the fitting point in the drawing. 

 
Fig. 27  Through hole 

Right-click to get back to the function selection, a click on the middle mouse button ends the 
insertion.  

 

Circle 

The functions Polyline, Rectangle and Circle can be found in the Others sub-menu of the 
Construction Aids function group. These functions are used in the same way as described for 
the bores. Please note that here as well, it is assumed that the construction aids are used for 
the creation of processings. The sub-part created by HiCAD will therefore remain invisible in the 
part list of the ICN. It can however be used like a part in the drawing (e.g. by right-clicking it and 
selecting one of the processing functions from the context menu, such as Translate part, Rotate 
part etc.). 

 

When inserting a Construction Aids or Standard Processing (e.g. Bore, Hole pattern, Circle etc.) 
HiCAD automatically creates a sub-part. By this means it is ensured that if, e.g., you translate a 
sheet, all bores within the sheet are automatically translated as well. Besides, you can translate, 
rotate, and mirror the bore in the drawing as an individual part without having to move each 
single line. To do this, right-click the bore and select one of the processing functions from the 
context menu. Construction Aids and Standard processings are not regarded as “genuine” 
parts, but as processings. Therefore the sub-part created by HiCAD remains invisible in the 
ICN, where only “genuine” parts are displayed.   

Before inserting the processing (bore etc.), the user needs to activate the part to which the 
processing should be applied (e.g. a sheet). Although HiCAD creates the sub-part automati-
cally,  HiCAD needs to know to which part the sub-part is applied. If you right-click the sheet, it 
is activated automatically. Irrespective of whether a sub-part is created by yourself or automati-
cally by HiCAD when inserting processings: Sub-parts are always created for the currently 
active part.    
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19.1 Exercise 3 Input of Point Options with R(RET), P(RET), PX(RET), 
PY(RET) 

 Tip: If there is not much time, you trainer should only show you this exercise.  
 Learning target: Point options R(RET), P(RET), PX(RET), PY(RET); Construction Aids, 

create a drawing; add title block and save; purpose of the three mouse buttons; different 
methods to select the point options (e.g. by pressing the RETURN key on the keyboard or 
by using the right mouse button in the moment when HiCAD suggests a point option etc.); 
functions (like View all, Rectangular zoom window etc.), which can be selected via the key-
board, various methods to select functions (e.g. select the Construction Aids via the 
corresponding icon in the user interface or via the right mouse button at the part in the draw-
ing or via the right mouse button at the sheet in the ICN). 

 Draw the sheet. 
 Use the “Rectangle“ and “Circle“ functions in the Construction Aids. Use the point options 

R(RET), P(RET), PX(RET) and PY(RET) to move them to the right position.  
 Please remember that the Construction Aids are not only available as an icon on the user 

interface, but also via the context menu of the part in the drawing (right mouse button) re-
spectively via the context menu of the part in the ICN.   

 Display the auxiliary parts in the ICN (right-click on name of drawing in the middle ICN win-
dow). 

 Save the drawing. 
 Space for notes:   
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20 Dimensioning and Information 
20.1 Dimensioning 
The 2-D Dimensioning functions can be found on the 2-D Dimensioning tab. If you right-click a 
dimensioning in the active drawing, a context menu containing further dimensioning functions is 
displayed.  

A dimensioning is composed of the following elements: 

 

 
Fig. 28  Dimensioning 

 

Each newly created dimensioning is assigned to the active part. This also applies if the dimen-
sioned line does belong to a different (inactive) part.  
 

Please always activate the part you want to dimension. This is the only way to guarantee the 
associativity of the dimensioning. “Associativity” means that dimensions are automatically up-
dated if form or position of the dimensioned part are changed.  
 

The following paragraphs will deal with some exemplary dimensioning functions. For a more 
detailed description of the dimensioning functions, please read the relevant chapter of the 
Online Help.  

                                                                                              

20.1.1 Linear Dimension, Axially Parallel (2-D) 
Use the Linear dimension, axially parallel function, as well as the other functions from the 
Parallel function group to create linear dimensions which are parallel to the X- or Y-axis. Axially 
parallel dimensionings will retain their axially parallel position even if the part is rotated. Select 
the distance you want to dimension by identifying two points. Some dimensioning functions also 
allow the selection of a line. 

For identification, all point options are available. You can identify any point in the drawing. They 
do not necessarily need to be end points of a distance or line, but can also belong to different 
parts.  

 

20.1.1.1 Linear Dimension, Parallel Dimensioning Points 
Use this function, or the other functions of the Direct function group to create a linear dimension 
which is parallel to the dimensioned points (i.e. normally not parallel to the X- or Y-axis). 
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 Identify the two points.  
 Enter the third point for the position of the dimensioning.  

 

Axially parallel dimensions retain their position even after rotation of the corresponding part. 
Linear dimensions which have been created parallel to the dimensioning points, are rotated with 
the part.  
 

 

If you want to dimension a line, you do not need to select point option I for the start and end 
point. It will suffice if you left-click, without any point option, in the vicinity of a line end.  If a di-
mensioning function is active, HiCAD will automatically select the nearest line end.  Please 
note: This is only applies to dimensioning functions! If you draw a line and then click in the vicin-
ity of an already existing line, the end of the old line will not be selected as the beginning of the 
new line; HiCAD would start the line at the position of the cursor. For all non-dimensioning func-
tions, the end of a line can only be selected via  point option I !  
 

20.2 Information Tab 
If you do not dimension a part, but only a length, a radius or similar, you can also use the func-
tions provided by the Information tab.  

All information stored in the system can be called via the functions of the Information tab. They 
enable you to detect point coordinates, distances, angles text attributes, dimensioning attrib-
utes, the contents of the variables memory, and much more.  

The values calculated with these functions are passed to system variables in the variables 
memory. For example, if you measure a length or a radius with the functions of the 2-D Dis-
tances function group, the result will be saved to the system variable  %Z3. This may be of 
interest if you use the Information menu in a macro and require the measured length for another 
function (e.g. for a part, in order to translate a length measured with the help of the Information 
menu).     

The following paragraphs deal with some exemplary functions of the Information menu. All other 
functions for measuring of distances are similar and are described in detail in the Online Help.  
 

20.2.1 2-D Distances 
Use the functions of the 2-D Distances function group to detect distances between: 

 Points, 
 Line elements, 
 Radii,  
 Points and line elements. 

The calculated distance is assigned to system variable Z3.  
 

20.2.1.1 Information, Distance 2 Points 
Use this function to measure the distance between arbitrary points.  

 Use the point options to identify the two points. 

The distance between the points is shown in the text window. As with all numerical values, you 
can copy the value with a right-click to paste it to another input field or to a text file, if required.   

 

As a preparation for the next exercise, please read the answer to the question “How do I draw a 
continuous polyline if I require different point options?” in the “FAQ” section at the beginning of 
this training book. Further information on this topic can also be found in chapter 14.1  “Change 
Point Options without Ending the Line Function“. 
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20.3 Exercise 4 (2D-GL-04.0) Sheet Metal, Punched   
 Learning target: Creating a new drawing; add drawing frame and save; various point op-

tions, different methods to select the point options (e.g. by pressing the RETURN key on the 
keyboard or by using the right mouse button in the moment when HiCAD suggests a point 
option etc.); purpose of the three mouse buttons; Construction Aids, functions (like View all, 
Rectangular zoom window etc.) which can be selected via the keyboard, various methods to 
select functions (e.g. select the Construction Aids via the context menu (right mouse button) 
at the punching in the drawing area, via the context menu of the punching in the ICN or via 
the corresponding icon in the user interface). 

 Create a main part for the punched sheet metal. Use the point options you learned.   
 Try to close the polyline without interruption.  
 Use the Construction Aids to add the punchings to the sheet metal part. 
 Dimension the punched sheet metal. Always activate the main or sub-part you are dimen-

sioning at the moment. 
 Save the drawing. 
 Space for notes: 
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21 Load Drawing, With or Without Database 
21.1 Load Drawing 
In chapters 10.1 and 14.3 you have learned how to create and save drawings. Now we want to 
load a drawing from the database.  

To load an already existing HiCAD file from the database (additional module), select the Load 
drawing, with DB function. If you work without database, select Load drawing.  

The Load drawing function can be accessed:  
 via the QuickAccess toolbar, 
 via the New/Open function group of the Drawing tab,  
 via the keyboard shortcut CTRL+O. 

After that, select the required file.  
 

If you have already loaded and processed a file, but have not saved it yet, HiCAD asks you 
whether you want to save this drawing.  
If you want an already loaded file to remain open, select an empty field in the Switch drawing 
tab of the ICN by a double-click. You can open up to 18 drawings in HiCAD.   
You can also load HiCAD drawings via the Windows Explorer.  
 

 

21.2 Filters in the Database Mask 
If you want to display all drawings which have been saved to the server, these might well be 
tens of thousands of drawings. Therefore it makes sense to narrow the search by setting ap-
propriate filters.   

Procedure WITH Database (additional module): 

Deactivate the two filters suggested by HiCAD for Links. As we have not linked our drawing to 
anything, this filter would not make any sense for us. Instead, define your own filter in one of the 
input fields of the database mask. This can be, e.g. 2* in the “Document number” field, or B* in 
the “Designation” field. You will then only be shown drawings whose document number begin 
with a 2, or whose designation begins with a B.  

 

 
Fig. 29  Loading of a drawing via database (additional module) with filter “2*” 
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However, even a list of all drawings whose document number begins with a 2 can still be quite 
long. You can however sort this list according to all attributes, such as document number, des-
ignation, revision date etc.: Click the header of the column according to which you want to sort 
(i.e. Document Number, Designation etc.). If you click twice you obtain a reverse sorting of the 
list.  

 
Fig. 30  Result list after loading of drawing with filter 2* and sorting according to Designation 

 

Procedure WITHOUT Database:  
If you work at your company without database, you probably will have switched off the database 
on your training computer. After selecting the Load drawing function, the Windows mask with 
the file names of all drawings is displayed. Further selection criteria are not available when 
working without database. You can however select the View menu icon. In the following menu, 
select Details.  

 
Fig. 31  Working without database: Further search criteria  
 

Click Name or Created in the header of the result list to sort the list according to name or date 
of creation. If you click Created twice, not the oldest, but most recent drawing will appear at the 
top of the list.  

 

If you possess the additional database module, you can learn about all further functions of the 
document/part/BOM database in a separate database training.   

 

 

 

 

 

 

 

21.3 Continuation Exercise 4, Sheet Metal, Punched 
 Load Exercise “Sheet Metal, Punched” from the database (if the database is switched off, 

please load without database). Use one (or several) search criteria and sort the result list as 
described in Chapter 21. 
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21.4 Exercise 5 (2D-GL-05.0) Handle 
 Please note: In order to save as much time as possible for the 3-D training, you should only 

do this exercise if there is a lot of time left. Usually, your trainer will only show you this exer-
cise or skip it completely.   

 Learning target: Various point options, especially R(RET); mirror lines; circles at boundary 
lines and points; centre line. 

 All exercises so far could be dealt with by using the function R (RET). For the construction 
of the handle, the use of auxiliary lines is permitted. 

 Familiarise yourself with the subsequent changing of the drawing scale. 
 Dimension the part. Please remember that the 2-D circular dimensioning can only be used 

for circles. If you intend to use a diameter dimension for a rectangle, you will find an appro-
priate function in the pull-down menu of the Dimensioning Tools function (in the “Tools” 
function group of the “2-D Dimensioning+Text” tab). Do not only use the point option I (re-
spectively a click close to the line without point option) for dimensioning, but also the point 
options Z (Centre) and QP (Quad Point).  

 Space for notes: 
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21.5 Exercise 6 (2D-GL-06.0) Sheet 
 Please note: In order to save as much time as possible for the 3-D training, you should only 

do this exercise if there is a lot of time left. Usually, your trainer will only show you this exer-
cise or skip it completely.    

 Learning target: Different types of tangents. Point options, in particular R(RET); dimension-
ing of the appropriate part; select various kinds of functions (e.g. Construction Aids).  

 In order to design this sheet, use the following functions one after the other circle, tangent 
and trimming graphic elements.  

 Use Construction Aids for the bores. Please remember that the Construction Aids cannot 
only be called via the icon in the user interface, but also via the context menu of the part in 
the drawing area (right mouse button) respectively via the context menu of the part in the 
ICN. 

 Create a part for the recess too, in order to make it invisible in the ICN by default. The re-
cess is not a part, but a processing. Please use the Construction Aids only once. Draw all 
further lines of the recess using the standard 2-D line menus to prevent the emergence of 
several sub parts for the recess. During this process, the design part needs to be active.   

 Activate the appropriate main part or sub-part when you dimension it. Display the Construc-
tion Aids in the ICN if necessary.  

 Space for notes:   
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21.6 Exercise 7 (2D-GL-07.0) Lever 
 Please note: In order to save as much time as possible for the 3-D training, you should only 

do this exercise if there is a lot of time left. Usually, your trainer will only show you this exer-
cise or skip it completely. 

 Learning target: Circles, circular arcs; various methods to trim 2-D lines; centre cross; di-
mensioning. 

 Create a new drawing and a main part “lever”. 
 Use the different options to design circles and tangents. 
 Correct these afterwards to create the lever. 
 Dimension the part. 
 Space for notes: 
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22 Automatic Part Dimensioning 
In the Tools function group (between Process and Text) of the 2-D Dimensioning tab, you will 
find the Dimensioning Tools > Part function.   

This function generates dimensioning suggestions for the active part.  

This function is explained in detail in the Online Help. Owing to the multitude of possible combi-
nations, we will concentrate on three particularly important entries that will be required for the 
next exercise: 

 

 
Fig. 32  Automatic part dimensioning 
 

In the menu shown above, select Geometry type, then select Closed contour. 

Now select Modify parameters. For Linear dimensions: Type select Parallel dimensions 
twice. (for X- and Y-direction). 

Right-click to return to the first dialogue again. Select Dimension part.   

 

 



                                                        Detail 

HiCAD  Basics  61 

23 Detail 
Activate the 2-D Part tab. In the Others pull-down menu of the Construction Aids function 
group you will find the Detail function. Use this function to define a detail as a part and insert it 
into the drawing with a scale of your choice.  

 Specify the scale, then select the area for the detail. The detail is displayed enlarged.    
 Select one fitting point on the detail and one on the drawing area. The selected detail is 

identified by a dashed circle.  
 Specify the reference line start point and end point for the designation of the detail.  
 Specify a name for the detail.  
 Specify the position for the designation of the detail in the drawing 

Detail Drawing M
Scale 5:1

Reference line  
Fig. 33  Detail 
 

24 Use Symmetries 
Many parts in Mechanical Engineering are rotation-symmetrical or mirror-symmetrical. In such 
cases, it will suffice to draw only one half of the part. The other half is obtained by cloning 
(translating, rotating, mirroring) of the part. Some parts even have double symmetries. In the 
exercise “Sheet with hole pattern” you only need to draw one quarter, the rest of the part is ob-
tained by mirroring it twice.    

 
Fig. 34 Sheet with hole pattern before mirroring the part twice 
 

Tip: Before drawing a part, you should check if the part contains any rotation or mirror symme-
tries. If so, it will suffice to draw only one half or even one quarter of the part. The rest can be 
created with the Clone part… (2-D) function.  
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24.1 Exercise 8 (2D-GL-8.0) Sheet with Bore Pattern 
 Please note: In order to save as much time as possible for the 3-D training, you should only 

do this exercise if there is a lot of time left. Usually, your trainer will only show you this exer-
cise or skip it completely. 

 Learning target: Recognise symmetries. Watch out for one or more mirror or rotation sym-
metries in the workpiece before drawing it. In that case you only need to draw half, or – as 
in this exercise – only a quarter.  

 Draw a quarter of the sheet metal only.  
 Use the Construction Aids for the appropriate bores. 
 Create the complete sheet metal by mirroring the part “Sheet Metal” twice.  
 If required, change the part structure of the bores with the “Break up” functions or by copy-

ing of lines. The required functions are described in detail in “Chapter 29: Break Up Parts“ 
and “Chapter 28: Move Lines and Dimensions to Another Part“ of this training book.  

 Dimension the part with the automatic part dimensioning function. 
 Create a detail of the part (not shown in the drawing).  
 Alternative solution: If you had drawn the complete sheet metal instead of a quarter, you 

had been able to draw a bore with a diameter of 30 and a quad bore diagram with a diame-
ter of 8. In that case you would have had to mirror the bore pattern and the individual bore 
separately twice. 

 Space for notes:   
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25 Hatching 
25.1 General 
HiCAD offers two options for the hatching of closed contours:  

 Part-based hatching (lines in one part)   
 Contour-based hatchings (lines in several parts). 

When using part-based hatching, a surface bounded by a closed polyline is hatched. The line 
elements of the closed polyline must be contained in one part.  

The polyline can have any shape and complexity and consist of up to 2500 line elements. If a 
polyline consists of more than 2500 line elements, it needs to be decomposed into several 
parts, and each closed surface needs to be hatched separately.   

Line elements which are distributed among several parts, do not form a proper closed polyline, 
even if they are optically continuous. Part-based hatchings can therefore not be applied to 
them.   

Standard parts, in contrast, are particularly well-suited for part-based hatchings.  

When using contour-based hatching, the inside of closed contours is hatched; the line elements 
can however belong to different parts. For this type of hatching, you need to specify a hatching 
reference point. On the one hand, the contour-based hatching is more flexible than the part-
based hatching, but on the other hand the detection of the corresponding contour is mandatory. 
And in contrast to part-based hatching, sub-parts and texts are not automatically excluded here.   

When using part-based hatching, all parts located below the hatched part as sub-parts, are 
automatically excluded from hatching (provided that they form closed polylines). The same ap-
plies to texts and dimensioning within the hatched part.   

The contour-based hatching considers only those exclusions whose hatching reference point 
lies in the same part as the exclusion element.  

You can link texts and dimensionings to hatching exclusions – they will be changed together 
with the exclusions.   

If the part-based hatching is selected, the corresponding hatching code is entered into the ac-
tive part. The line elements all belong to the same part.  

If the contour-based hatching is selected, the hatching code is entered into the active part; the  
position of the corresponding contour elements is, however, arbitrary.  

You can define arbitrary exclusions in hatchings.   

The hatched contour can also be filled with an arbitrary symbol. This is not possible for part-
based hatchings.  

To speed up the drawing process you can also hide hatchings.  

In the following example the parts have been filled with different hatching codes:  
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Fig. 35  Hatched part 
 

 

25.2 Part Hatching 
If you select Part hatching, a surface bounded by a closed polyline is hatched. The line ele-
ments of the closed polyline must be contained in one part. A polyline can consist of up to 2500 
line elements.  

You cannot apply part hatching to surfaces which do not form a closed polyline.  
 Activate the part you want to hatch.  

You can also activate a part that has already been hatched. The existing hatching will be re-
placed.   

 Select the Change/Define part hatching function.  

The input mask for hatching attributes is displayed.   

 
Fig. 36  Input mask for hatching attributes 
 

Select the hatching type (see above image), the hatching line spacing, the hatching line angle 
and hatching colour and confirm with Hatch.  

If the part has no own line elements, but serves only the purpose to structurally combine the 
sub-parts, the hatching code is automatically entered into all sub-parts which are on the same 
level as the part to be hatched.   

Part and contour hatchings can be deleted not only via the Delete hatching function in the 
Hatching function group on the 2-D Part tab, but also via the pop-up menu of the Delete ob-
ject function on the Drawing tab. For both options please note that there are different functions 
for the deletion of part hatching and contour hatching. 
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25.3 What if Part Hatching Does Not Work? 
25.3.1 Sort GE (2D)  
The Sort GE (2D) function can be found in the function group Tools on the 2-D Geometry tab. 
You can use this function to connect polylines which form optically a closed contour, but not 
according to the internal data structure. The restructuring of line elements takes place only 
within one part. No line element is assigned to another part.  

For example, if you draw a rectangle, but select the Polyline function after two lines again, you 
will start a new polyline. This means that the contour appears optically closed, but according to 
the internal data structure it is not.  

By applying the Sort GE (2D) function, the polylines will be connected, thus forming a “genuine” 
closed contour (i.e. they will also be closed according to the data structure). 

 

25.3.2 Double Lines Within a Part 
If there are points of contact between two parts, the contact line need to be a double line, as 
each of the parts has to form a closed contour if you hatch them, if they overlap or if you want to 
calculate their areas.  However, if there are double lines within one part, they are superfluous. 
Sometimes they can even be the reason why hatching does not work.  

Activate the 2-D Geometry tab. In the Others  pull-down menu of the Change function group, 
select the Delete overlaps function. Double lines within one part are deleted.  Double lines at 
points of contact between two parts are however (for logical reasons) retained. It may happen 
that a hatching does not appear until after a repeated selection of the Sort GE (2-D) function 
(see training book chapter 25.3.1). 

Please note: If you select the Double lines function in the Delete function group of the 2-D Ge-
ometry tab, only double lines of equal length are deleted.  

 

25.3.3 Check for Closed Contours 
In the 2-D Others function group of the Information tab you will find the Polyline function, ena-
bling to check whether a contour is actually closed. A closed contour is, for example, a 
prerequisite for the creation of hatchings and overlaps. 

If there are gaps in a contour, you can close them with the following functions:  

25.3.3.1 Close corner, internal corner 
The Change function group of the 2-D Geometry tab provides numerous functions for the proc-
essing of line elements. Many of these functions are contained in the Others pull-down menu 
(small blue arrow), which looks as follows:  
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Fig. 37  Close corner, internal corner function 

 

The Others sub-menu contains, among many other functions, the Close corner, internal cor-
ner function. If you click a corner from its internal side, both lines are lengthened in such a way 
that they form a “genuine” closed corner. If this was the only non-closed place in your contour, it 
is closed now and can be hatched. Besides, you can also use functions such as 
Lengthen/Shorten GE, to line (2-D) to close contours.  
 

 

If you needed to delete another double line or close another corner, it is recommended to sort 
the contour once again with the Sort GE (2-D) function!  

 



Hatching 

68                                                                                                                                            HiCAD  Basics 

25.4 Exercise 9 (2D-GL-9.0) Spacer Sleeve 
 Please note: In order to save as much time as possible for the 3-D training, you should only 

do this exercise if there is a lot of time left. Usually, your trainer will only show you this exer-
cise or skip it completely. 

 Learning target: Part hatching; chamfer dimensioning; dimensioning of diameters, updating 
of the fits table by saving the drawing.  

 Create the spacer sleeve. Please remember that you need to be closer to the line where the 
length of the chamfer is supposed to be with the identification point when using the “Cham-
fer with Length + Angle” function. If the length is to be marked off of the upper line, you need 
to select the upper line from the inner side. If the length is to be marked off of the left line, 
you need to select the left line from the inner side. 

 Use the Part hatching function to hatch the part. 
 Use the Construction Aids or Standard Processings functions for the creation of the bores.  
 Dimension the workpiece. Activate the part that you are dimensioning at the moment. The 

pull-down menu of the Dimensioning Tools function (in the “Tools” function group of the “2-D 
Dimensioning+Text” tab) provides an appropriate function for diameter dimensioning of non-
circular parts (e.g. revolved parts in a side view).   

 Add tolerances and fits as well as the corresponding tables. 
 Change one of the fits. 
 Update the fits table by saving the drawing. 
 Space for notes: 
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26 Overlaps and Exclusions 
26.1 Overlap Parts  
The Overlap function group of the 2-D Part tab contains various functions for the assignment 
and processing of overlaps. If you click the Others icon of the function group (small blue arrow), 
a pull-down menu with further functions is displayed.  

Use the Overlap part to define parts as overlap contours.  
 Identify the part that you want to be overlapped (i.e. the part you want to send to the back).  
 Select the overlapping part (i.e. the part you want to bring to the front) and end the identifi-

cation with the middle mouse button (or with the right mouse button if you want to stay in the 
context menu).   

Now specify how you want to arrange the hidden edges. For this you use the functions Hidden 
edges dashed, Hide hidden edges or All edges visible. These functions are described in 
detail in Chapter  26.3. 

 
Fig. 38  Overlapped parts; Setting: “Hide hidden edges” 
 

26.2 Define Exclusion Contour 
Use the Define exclusion contour function in the Overlap function group of the 2-D- Part tab 
to find define the contour of an exclusion, i.e. a bore in a sheet or similar.   

Requirements for this are an overlap contour in the active part and a contour which can be de-
fined as exclusion.  

 Identify the contour start for the exclusion.  
 Press the middle mouse button to end identification.  
 Select the Redraw function to display the exclusion.  

 
Fig. 39  Exclusion 
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26.3 Type of Representation for Hidden Edges 
 

26.3.1 All edges visible 
Use this function in the Visualisation menu to display all edges, including the hidden ones.  

 
Fig. 40  All edges visible 

This function applies to all overlaps of the currently processes drawing. 
 

26.3.2 Hide hidden edges 
Use this function to hide all “hidden” edges, for all overlaps.  

 
Fig. 41  Hide hidden edges 
 

26.3.3 Hidden edges dashed 
Use this function to display all hidden edges by an arbitrary line type. The line type can be cho-
sen after selection of the function.  

 
Fig. 42  Hidden edges dashed 

This function applies to all overlaps in the currently processed drawing. 
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26.4 Exercise 10 (2D-GL-10.0) Sheet with 2 Holes at Specified Positions 
 Please note: In order to save as much time as possible for the 3-D training, you should 

only do this exercise if there is a lot of time left. Usually, your trainer will only show you this 
exercise or skip it completely.  

 Learning target: Overlap 2-D parts. 
 Create the three parts in front of one another.  
 Define the overlaps and exclusion contours. 
 Dash, respectively hide the overlapping lines. 
 Space for notes: 
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27 Part Structure when Designing in Several Views 
The basic idea of HiCAD is to create drawings with entire parts (main parts and sub-parts) in-
stead of individual lines. This allows a fast and well-structured working, with many automatisms 
which would otherwise not be possible. This also has also proven helpful when designing in 
several views. Views are created as main parts, to which all corresponding parts are assigned 
as sub-part.  Of course, these workpieces can in turn contain sub-parts.  

Such a 2-D part structure can be seen below:  

 
Fig. 43  Part structure when designing in several views 
 

Please note that the views need to be main parts, and the workpieces sub-parts. Otherwise it 
would be very laborious to move a view: You would have to move, for each part, the sub-part 
VA (or STA and DS, respectively). In the part structure as shown above, one movement would 
suffice.  
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Fig. 44  Rendered HiCAD drawing 

 

 

Fig. 45  Rendered HiCAD drawing 
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27.1 Exercise 11 (2D-GL-11.0) Pulley 
 Please note: In order to save time, it is sufficient if the trainer shows you this exer-

cise (in particular the part structure). 
 Learning target: Part structure of 2-D drawings with several views. 
 Create one main part “Front view” and one main part “Sectional view”. Create for 

each of the main parts one sub-part “Pulley”. To avoid confusions of the sub-parts 
“Pulley”, you should give them different names, such as “Pulley-FV” and “Pulley-
SV”. 

 Use Part hatching to hatch the part. 
 Dimension the part. 
 Space for notes:  
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28 Move Lines and Dimensions to Another Part 
28.1 Take Over Elements to Active Part 
In the Others pull-down menu of the Tools function group on the 2-D-Geometry tab, you will 
find the Elements > Take over to active part function. This function retains the geometric posi-
tion of the line elements, and changes only their belonging to a part, by inserting the line into the 
active part and deleting it from the previous part.  

 In the selection menu, choose the type of identification (Individually, In rectangle, Polyline) 
 Identify the line elements you want to assign to the active part. 

In the image below, the line taken from part 1 is an element of part 2. You can check with the 
cursor if the upper line of part 1 now actually belongs to part 2:  

 
Fig. 46  Line element taken over to active part  
 

 If you use the identification type In rectangle, dimensionings, texts, etc. will be taken over 
all well.  

 You can use the Copy to active part function to copy the lines into the active part, i.e. the 
selected lines will also remain in the active part. This means that the lines exist twice (in the 
active part and in the previous part).  

 

28.2 Dimensions to New Part  
In the Process function group (between Tolerances and Tools) of the 2-D Dimensioning tab 
you will find the Dimensions to new part function. Use this function to assign the selected di-
mensioning to the active part. The dimension is deleted from the previous part.  

 First select a type of identification for the dimensioning (e.g. Individually).  
 Select the part to which you want to move the dimensioning. 
 Identify the dimension figure of the dimension.  

You can now identify further dimensions, or end the function with the middle mouse button, or 
right-click to go to the dimensioning context menu.   
 

28.3 To Which Part Do Lines or Dimensionings Belong? 
If you place the cursor in the vicinity of a part in the drawing, this part is highlighted pink, includ-
ing its dimensionings, processing symbols etc. Sub-parts of this part appear in orange colour. 
This enables you to see which lines, dimensionings, texts etc. are assigned to which part.  

If you use the Show only active part function, you see only the active part, but including all 
corresponding sub-parts.  

When using the Only active part function on the Information tab, HiCAD asks you: Highlight 
sub-parts as well? If you answer with “No”, you will only see the active part, without sub-
parts.  
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28.4 Exercise “Take Over to Active Part” (without graphics)  
 Please note: In order to save as much time as possible for the 3-D training, you should only 

do this exercise if there is a lot of time left. Usually, your trainer will only show you this exer-
cise or skip it completely. 

 Learning target: Move lines and dimensions subsequently into the appropriate part.  
 Create the main part “Shaft”. Draw into this part (with few lines) a shaft, a corresponding 

flange, a lid and a base plate. “Forget” the creation of further main parts, respectively sub 
parts for the flange, the lid and the base plate. After this work step all lines will belong to one 
main part only.  

       
Fig. 47  Main part “Shaft”  

 Add some few dimensions.   
 Every workpiece should be represented by one individual part, i.e. its own main or sub-part. 

Reason: You are then enabled to translate, rotate, delete the part, add master data etc. This 
way it is easier and you do not need to translate, rotate or delete every single line. Part 
hatching and overlaps are based on the part structure as well. Create the parts for the 
flange, the lid and the base plate subsequently. Start from the assumption that the shaft and 
the flange belong to a (subordinate) assembly “Revolved parts”, the lid and the base plate to 
a (subordinate) assembly “housing”. These two assemblies belong to a superior main as-
sembly “Drive”. Move the lines and dimensions into these parts.   

 

       
Fig. 48  One part for each workpiece 

 
 The middle window of the ICN contains one part for each workpiece now. These are in turn 

arranged according to main and sub-assemblies. Check if lines and dimensions are in the 
right parts.  
 

In HiCAD each workpiece is a part of its own. As soon as we have several parts it makes sense 
to structure them into assemblies. Each part is located as a sub-part below its superordinate 
assembly. This assembly can in turn be a sub-part to a superordinate main assembly. Very 
large drawings can have a part structure consisting of very many levels.    
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29 Break Up Parts 
In the Others pull-down menu of the New function group of the 2-D Part tab, you will find the 
functions: Break up > 1st sub-part level, Break up > All sub-part levels and Break up > Part. 
All three functions delete parts within the part structure of the drawing. Prior to that, the corre-
sponding lines, dimensionings, texts etc. are moved to a superordinate part. This means that no 
lines, dimensionings etc. will be lost – the change takes only place in the part structure.  If you 
select Break up > 1st sub-part level, one less level will exist in the part structure (namely the 
one below the active part). The lines are previously automatically copied to the active part.   

If you select Break up > All sub-part levels, no part will exist below the active part any more. 
Prior to that, the lines are automatically copied to the active part.   

If you select Break up > Part , the active part will no longer exist. Prior to that, the lines are 
copied to the superordinate part. If  there were any sub-parts to the deleted part, they are 
moved level higher.   

Now let us take a closer look at the Break up > Part function:   

Use this function to break-up only the active part, and integrate its elements into the superordi-
nate part (if there were any sub-parts to the deleted part, they will be moved one level higher). 

 First activate the part, then select the Break up > Part function. 

All lines, dimensionings, texts, etc. will be moved into the superordinate part. The (now empty) 
active part is deleted. You would use this function, e.g. for relief grooves: These are elements of 
the outer contour, which means that you initially cannot use part hatching to hatch a flange, as 
the lines of its outer contour are distributed among the main part “flange” and its sub-part “relief 
groove”.  If you use the Break up > Part function (please note that the relief groove needs to be 
active), the lines of the relief groove would be moved into the main part.  Now the main part has 
a closed contour and can obtain a part hatching.   

 

 

29.1 Exercise 12 (2D-GL-12.0) Flange 
 Please note: In order to save as much time as possible for the 3-D training, you should only 

do this exercise if there is a lot of time left. Usually, your trainer will only show you this exer-
cise or skip it completely. 

 Learning target: Some standard parts need to be broken up (in this exercise a relief groove 
and in the next exercise a groove) as they are part of the outer contour. 

 Draw one half of the flange. Create the other half by mirroring the part.  
 Add the bore with the help of the Standard processings and Construction Aids. 
 Add the two relief grooves.  
 HiCAD created a sub-part for each relief groove. This cannot be seen in the ICN, as relief 

grooves, recesses, bores etc. do not have part character and therefore are not included in 
BOM. The lines of the relief grooves, however, are not included in the main part “Flange”. 
This means that the main part “Flange” does not have a closed contour and can therefore 
not be hatched with the part hatching. We therefore need to break up the two relief grooves. 
You can use the function Break up – Part” for this. Please note that in this case the relief 
groove needs to be active.   

 Use the Part hatching function to hatch the flange.  
 Alternative solution: Instead of selecting the “Break up – Part” function you could also have 

activated the main part “Flange” and copied the lines of the two relief grooves into the part 
with the “Take over GE to active part” function.  
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30 Beginning of 3-D Training: Solid Primitives  
The previous chapters were targeted at acquiring basic 2-D knowledge, which will also be 
needed for the operation of the 3-D module (e.g. a good understanding of the HiCAD part struc-
ture). In the following chapters we will concentrate on the functions of the 3-D module:      

Use the functions of the Solid primitive menu to create  
 cuboids, prisms, pyramids, tetrahedrons and 
 cylinders, cones, spheres and toruses.  

 
Fig. 49  Solid primitives 
 

In the “Anvil“ exercise you will practise the working with solid primitives by creating and proc-
essing one cylinder and several hollow cylinders. Let us therefore take a closer look at the solid 
primitive “Cylinder”:  
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30.1 Cylinder 
Use this function to create circular cylinders and cylinder segments. The generation of hollow 
cylinders and cylinder segments is also possible.  

To do this, activate/deactivate the checkboxes Hollow, resp. Segment in the Type area.  

The following table provides an overview of the value inputs that are required for various set-
tings.   
 

Circular cylinder 
as 

Type Entries 

Full body   Hollow 
 Segment 

Height 
Diameter 

Hollow body   Hollow 
 Segment 

Height 
Diameter 
Wall thickness (inter-
nal) 

Segment  Hollow 
 Segment 

 

Height 
Diameter 
Start angle 
End angle 

Hollow segment  Hollow 
 Segment 

 

Height 
Diameter 
Wall thickness (inter-
nal) 
End angle 

Enter the required data, and place the cylinder in your drawing area. The fitting point is the cen-
tre of the surface area.  
 

H
ei

gh
t

Cylinder segment 
from 180° to 270 °

x

y 90°

0°

180°

270°

Diameter

 
Fig. 50    Circular cylinder 
 

Tip: In the “P. direct” mode, you can also directly specify start point and end point. The height is 
calculated automatically. This fitting mode makes sense if, for example, you want to fit a cylin-
der between 2 predefined points.  
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31 The Information + Communication Navigator 
An integral part of HiCAD is the Information + Communication Navigator (ICN), which clearly 
outperforms common structure browsers.  

The ICN provides direct access to all opened models, drawings and views, part and assembly 
structures, attributes and the PDM properties of individual parts. The ICN marks referenced 
parts accordingly and shows you which parts have been modified or are currently being proc-
essed.    

The view structure is also visualised, including all dependencies between views and 2-D/3-D 
part structures, as well as between 3-D models and list views.  You can switch between views 
in the ICN, without having to activate any view function.  

You can create and process your drawing while the ICN is open. During the process, the repre-
sentation in the ICN is constantly adjusted to the actual construction in the drawing area. All 
structures and properties can be modified or processed via mouse-clicks in the ICN. In this way, 
you can also activate a wide range of part processing functions. Multiple selection options (as 
known from Windows applications) enable a modification of several parts in one single process-
ing step.  

The Information + Communication Navigator is displayed on the left hand side of the screen. If 
required, you can also hide the ICN:  

 Close the ICN by clicking the  symbol. 

If required, you can hide individual windows of the ICN:  
 Right-click on an ICN window caption and select Hide. 

     
     Fig. 51  Hiding of individual windows in the ICN via right-click on window caption 
 

or 
 use the Settings > Docking window function at the top right of the HiCAD window.  

 
Fig. 52  Hide individual ICN windows via Settings for Docking windows 
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Fig. 53  The Information + Communication Navigator (Example)  

 
The ICN consists of 3 windows:  

 The first window contains information about the view structure and the loaded drawings.  

 The second window contains the parts structure (subdivided into 2-D and 3-D).  

 The third window contains information on the individual parts, as well as the HCM and the 
Feature log (3-D).  

You can change the size of the individual windows by dragging the frame borders with the 
mouse (as known from Windows applications).  
 

Please note: 
New and processed 3-D parts of the current drawing are identified in the ICN by a   symbol. 
When saving the drawing, this identification is removed again. When exiting HiCAD, or close a 
drawing, please check whether there are parts marked with the   symbol in the drawing. If so, 
you still need to save the drawing, i.e. the current state of the drawing has not been saved yet.  

 

 
 

Upper ICN window 

Tabs: Views, Switch drawing 

Middle ICN window 

Tabs: 2-D Part structure, 3D-part structure 

Lower ICN window 

Tabs: Feature, HCM, Graphic, Properties 
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31.1 The “Switch drawing” Tab 
You can load up to 18 drawings into HiCAD and use the Switch drawing tab to switch between 
them.  The tab contains thumbnails and file names of all loaded drawings. If you work with HE-
LiOS, the document number is displayed as well.   

 
Fig. 54  The Information + Communication Navigator  (Example)  

Open several drawings 
If you want to load drawings without closing the current drawing, activate the Switch drawing 
tab and click on the empty thumbnail. Load the required drawing, or create a new drawing.  

Switch to another drawing 
To switch from the current drawing to another drawing, simply click another thumbnail displayed 
in the window of the tab.  

Remove drawing 

To remove a drawing from the tab, activate the drawing with a left-click. Then select the Close 
function in the QuickAccess toolbar.  

Update preview 

Update the preview thumbnails in the Switch drawing tab by double-clicking them.  
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31.2 The “Views” Tab 
31.2.1 Views in the “Sheet” and “Model” Area 
This tab displays the view structure of the current drawing.   

 
Fig. 55 Arbitrary switching between “Sheet” and “Model” views  

HiCAD distinguishes between “Model” views and “Sheet” views. In the sheet views, the produc-
tion drawings are displayed, which can automatically be derived from the 3-D model. In 
addition, you can use genuine 3-D views (so-called “model views” in HiCAD, e.g. arbitrary detail 
and sectional views, cut-outs with user-defined depth and direction, list views with particular 
parts and assemblies, and much more. This does however not affect the position of the views in 
the sheet area.  

Please note that you will receive genuine 3-D views which you can also use for processings 
when representing production drawings on the basis of 3-D models. As all views in HiCAD are 
fully associative, changes in the production drawing are automatically applied to the 3-D model 
and vice versa. This enables you to freely switch between model views and production views.  

Please note however that before printing you need to select the Sectional/Detail View > Up-
date, All function once. You will find this function if you right-click a view in the drawing area 
(pink dotted rectangle) and select Process > Others. The sectional views and detail views are 
then also updated.  

You can create several sheet areas if required. Right-click Sheet in the window and select 
Sheet area, New. You could now create 4 standard views from this view, and add further sec-
tional, detail and/or list views.  If you right-click “Sheet” again, you can create further sheet 
areas, with the method described above.  

Example: If you create 4 sheet areas, these may represent one production drawing, one pro-
posal drawing, one approval drawing, and one customer drawing.  
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31.2.2 Activate View 
To activate a view, click on the corresponding view in the Views tab of the ICN, or click the pink 
dotted rectangle in the drawing area.  

 

31.2.3 Properties 
If you activate a view in the Views tab, HiCAD displays further information about the active view 
on the Properties tab of the lower ICN window, as well as a graphic preview of the view on the 
Graphic tab of the lower ICN window. As soon as you move the cursor into the drawing area 
again, the properties of the active part are shown on the Properties tab again.  

 

 
Fig. 56 Properties of a View  

 

31.2.4 Process Views 
To process a view, right-click the required view in the ICN, or the pink dotted rectangle in the 
drawing area. The following images show that the functions selected via the ICN are mainly 
“management” functions, while the functions selected via the drawing area (pink dotted frame) 
rather focus on “processings”.  

                                                                                       
Fig. 57  Context menu for views, selected via ICN        Fig. 58  Context menu for views, selected via drawing area 
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Please note that in the ICN you can also select several views to be moved, deleted etc. For 
multiple selection, press and hold down the CTRL key while making your selection.  

Move views 
 

You can move views in the ICN from the model area to the sheet area and vice versa with Drag 
& Drop (press and hold down mouse button).   

In the ICN, click the desired view, hold down the mouse button and drag the view onto the entry 
3-D-Model, resp. Sheet. 

Multiple selection is also possible (CTRL, resp. SHIFT key, as known from the Windows appli-
cations).  

31.3 Part Structure 
The HiCAD part structure is displayed in the middle window of the ICN (separately for 2-D and 
3-D). It provides information about the assemblies, main parts and sub-parts existing in the 
drawing, the part types etc.  
 

 

Fig. 59 HiCAD Part structure in the ICN (3D-Part structure tab) 

You can use the following keys to browse in the part structure: 
 
↑, ↓ Switch active part, up and down 

Pg ↑, Pg ↓  To top /bottom  

Pos1 Jump to first item  

End Jump to last item 
 

For each part,   
 a graphical symbol for the respective part type,  
 the part name or article number (if an article number was assigned to the part via RMB > Part 

attributes), and,   
 (in curly brackets) the item number and Designation1 (from the Part attributes)  

are displayed. If required, you need to right-click the name of the drawing in the middle ICN 
window and select the HELiOS Attributes, Display (update) function to display Article num-
ber and Designation.  

 
 

The representation is based on the drawing and 
has a tree-like structure (as known from many 
Windows applications). You can expand the tree 
structure by clicking a “+” symbol, which also 
displays the sub-parts of the corresponding part, 
and collapse the structure again by clicking “ - “.  
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31.3.1 Colour Representation 
In the ICN, parts are represented in different colour:  

 Active part = red , 
 Selected part = dotted frame,  
 Parts belonging to a 3-D part list = highlighted in dark blue 

All three types of representation may occur individually, together or in arbitrary combinations.  

 Active part 

The active part in the current drawing is shown in the ICN in red colour. The Properties tab 
displays the attributes of this part, while the Graphic tab provides a graphical preview of the 
part.  

 Selected part  

The selected part is the part whose properties and graphic are shown in the corresponding 
tabs. This part is represented in the part structure with a dotted frame. Normally, this is the 
active part, it can however also be switched by a left-click while holding down the ALT key.   

 The current part list   

The ICN allows multiple selection of parts. Such multiple selection is also referred to as “part 
list”. All parts of a multiple selection are highlighted in dark blue, their sub-parts are high-
lighted  in light blue. The active part can (but does not necessarily need to) belong to the part 
list.  

The following paragraphs provide an overview of the selection options for 2-D and 3-D parts 
and the definition of part lists.  

 
31.3.2 Parts and Part Lists 
31.3.2.1 Select Parts  
You activate a part with a left-click, and open its context menu with a right-click. If you press and 
hold down the CTRL key you are enabled to select several parts. If you activate a part at the top 
of the structure and a part at the bottom while holding down the SHIFT key, all parts between 
these two parts are also activated. 

For 3-D Drawings you can also create part lists by picking the required parts not from ICN, but 
directly from the drawing.  

Further information on part selection filters can be found in the Online Help.  

 
31.3.2.2 Process Part Structure with Drag & Drop 
To move parts within the part structure, proceed as follows:   

 In the ICN, place the mouse pointer on the part you want to move. 

 Press and hold down the left mouse button and drag the part to the part or assembly to 
which you want to assign it (complete with sub-parts). Then release the mouse button.  

  
 
If you want to turn the selected part into a main part, the cursor needs to point at the name 
of the drawing when releasing the mouse button!  
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31.3.2.3 Auxiliary Parts On/Off 
HiCAD also manages parts without part character, e.g. 2-D auxiliary lines, drawing frames ac-
cording to DIN etc. You have the following options to represent these objects in the structure 
tree of the ICN:  

In the 2D-Part structure tab of the ICN, right-click the name of the drawing. In the context 
menu, select Auxiliary parts On/Off > Auxiliary parts On. This setting will apply temporarily, 
i.e. for the current HiCAD session. To switch the display of auxiliary parts off again, select Aux-
iliary parts Off.  

To change this setting permanently, open the ALGPAR.DAT file and set the value for the entry 

Display of auxiliary parts in the part display/Browser (0/1) - Anzeige von Konstruktions-
Hilfsbauteilen in Bauteilanzeige/Browser (0/1)  

to 1. 

 

31.3.2.4 Special 2-D Parts 

The 2-D parts Part 

When creating a new drawing, HiCAD always inserts a main part with the name View 1 into the 
2-D structure. This main part contains a sub-part with the name 2-D parts. Each time you select 
a new 3-D view, the name of the main part in the 2-D structure is adjusted to the selected view 
– e.g. ENG. AXONOMETRY 2 or TOP VIEW.  
 

By the time you have moved the cursor out of the ICN into the drawing area, the display 
has been updated.  
 

This part is for structuring purposes only and cannot be deleted!  

When you insert 2-D geometry elements into a 3-D view without having defined a new 2-D part 
beforehand, these will automatically be assigned to the sub-part 2-D part.   

Example 

Let us assume that you create a new drawing. The first 3-D view is created automatically.  By 
default, a “View 1” is created below “3-D model”. This means that a part with the name “View 1” 
and a sub-part with the name “2-D parts” are entered into the 2-D structure. At this point, the 3-
D structure is still empty.  

 
Fig. 60  2-D structure at the start of a drawing creation (middle ICN window, 2D-Part structure tab) 

If you now create a new 3-D main part, e.g. with the name CUBOID, a main part with the name 
CUBOID is inserted in the 3-D structure. The 2-D structure is only changed if you activate a new 
3-D drawing. In this case the name of the part “View 1” is replaced with the name of the new 
view.  
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The Parts 2-D model and 2-D sheet 

All 2-D parts which are located below the part 2-D sheet are visible if a sheet view is activated 
(e.g. Drawing frame).   

In contrast to the 2-D parts located below an individual view, these parts are also visible if you 
select the Only active view option.  
 

How can you use the part “2-D sheet” in practice? 

Let us assume that you want 2-D parts, such as a Bill of Materials, a tolerance table or a newly 
created 2-D part with processing notes are only visible in the views of the Sheet area, but not in 
the Model area. In the Views tab, activate a view of the SHEET area.  The display will be up-
dated as soon as you move the cursor into the drawing area again. In the “2D-Part structure” 
tab of the ICN, move the Bill of Materials, the Tolerance table and the created 2-D part “Proc-
essing notes” below the part “2D sheet”. The result looks as shown in the image below. In the 
view of the model area, the 2-D parts are now invisible.   
 

 
Fig. 61  Bill of Materials, Tolerance table, Processing notes below “2-D sheet“ 

 
 

31.3.2.5 Properties 

 
Fig. 62  Properties tab in the lower ICN window 

This tab shows the Properties of the active (resp. selected) part.  
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31.3.2.6 Graphic 
This tab shows a graphical preview of the active (resp. selected) part.  

 
31.3.3 The Drawing Name 

 
Fig. 63  Name of drawing in the middle ICN window (drawing name = article number when working with database)   
 

The uppermost entry in a part structure (middle ICN window) is always the name of the current 
drawing. When working with the database it is the article number.  

If you right-click on the name of the drawing, the context menus for drawings is displayed. One 
of many functions  is the HELiOS Attributes, Display (update)  function. Use this function to 
display the database attributes “Article number” and “Designation” in the ICN structure tree, or 
(if these are already displayed) update the display of the attributes. If the database attributes 
are already displayed, the HELiOS Attributes, Hide function is active, which enables you to 
switch the ICN display back to part name/part designation. 

 
 

31.3.4 The “Find” Function 
The Find function can be accessed   

 via the title bar of the middle ICN  window or 
 via the keyboard shortcut CTRL+F. 

This function provides a convenient search tool within the ICN.  

 
Fig. 64  The ICN search mask  
 

You operate the search mask in the same way as most Windows applications.  
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31.3.4.1 Search Criteria 
You specify the desired search criteria by activating/deactivating the appropriate checkboxes. 
Furthermore, you can enter the common wildcard characters * and ? into the input fields.  

Use the BOM-relevant checkbox to restrict the search to parts which are BOM-relevant or not 
BOM-relevant. You can assign this property to parts by right-clicking them and selecting the 
Part attributes function.   

 If the checkbox is not active, BOM-relevance is not taken into account for part search, i.e. it 
makes no difference whether the part is BOM-relevant or not.  

 If the checkbox is active, HiCAD will only search for BOM-relevant parts.  

 If the checkbox is active, but with less colour-intensity, non-BOM-relevant parts are also 
taken into account for part search.  You achieve this activation by clicking the activated 
checkbox once again.  

Examples: 
 Only the Part name field is activated. “2*” has been entered: HiCAD will only search for 

parts whose number begins with a 2. 
 Only the Item number field is activated.  „-“ (i.e. only a dash) has been entered: HiCAD will 

search for all parts with no item number.  
 Only the Material is activated. „-“ (i.e. only a dash) has been entered: HiCAD will only 

search for parts to which no material has been assigned yet.  

You start the search by selecting the Start/Cancel search function in the toolbar.  
 

31.3.4.2 Process Found Parts 
The parts shown in the result list can be processed directly via the result list.  

Right-click the item of the result list that you want to process. Multiple selection (hold down 
SHIFT or CTRL key) is also possible.   

All selected parts are highlighted in dark blue and can now be processed.   
 via the context menu (right-click),  
 with the functions of the Edit menu, or  
 with the functions of the toolbar.  

This enables you to assign a particular material to all parts or mark them as BOM-relevant.  

 

31.3.5 The HiCAD Clipboard 
You can (besides other possibilities) use the HiCAD Clipboard to copy parts from one drawing 
to another drawing.  

Select the part or specify the part list that you want 
to copy from the current drawing to another drawing. 
Then right-click the part or part list and select the 
Copy to clipboard function.  

You can then paste the current contents of the Hi-
CAD Clipboard to another drawing:   

In the ICN of the target drawing, right-click the part 
to which you want to assign the contents of clip-
board as sub-part. If you want to paste the contents 
of the clipboard as main part into the drawing, right-
click the drawing name in the middle ICN window.  
Then select the Paste from clipboard function.  

Fig. 65  Copy to / Paste from Clipboard functions (lower part of 3-D part context menu in ICN) 
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The copied parts are shown, and HiCAD prompts you to specify a fitting point in the drawing. 
This is the point via which you position the copy in the drawing.   

After specification of the fitting point, HICAD prompts you to specify the position of the fitting 
point in the drawing.  

The function group Insert Part on the Drawing tab provides further possibilities to copy parts 
into other drawings:  

Here you can load re-usable parts, e.g.    

 from the database, or the Explorer, 
 from a catalogue, 
 from the part library (optionally available), 
 from another drawing, or 
 via an interface 

 
Fig. 66  Function group Insert Part on the Drawing tab: Further part insertion functions 

 

31.4 The “HCM” Tab in the ICN 
The “HCM“ tab of the lower ICN window contains all HCM constraints that have been assigned 
to your drawing.  

The integrated “HiCAD Constraint Manager” enables you to effectively parameterise your draw-
ing. Available are edge constraints as well as part constraints. Geometric relations can be 
assigned in 2-D and 3-D - either while creating your drawing, or to already existing assemblies.  
This enables a dynamic manipulation even of complex models, i.e. spatial movements are con-
trollable and can be visualised in real-time. Three-dimensional kinematic analyses, too, can be 
realised in this way.   

The constraints you have assigned to an active part or an assembly via part constraints can be 
found in the HCM tab of the lower ICN window.  

More information on the HCM is provided in the Online Help.  
 

The ISD offers a 2-day training for the Parametrics module. This training also covers the topics 
Feature Variants, Design Variants, Motion Simulations and Assembling Simulation. 
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32 Representations of Views 
HiCAD offers a wide range of representations for views, running the gamut from glass model 
and Hidden Line representation to photo-realistically shaded and rendered models.  

The representation functions for views refer – apart from a few exceptions – always to the ac-
tive view. These functions are available in context menus which can either be activated by a 
right-click on the  view frame in the drawing area (pink dotted frame) or on the name of a draw-
ing in the ICN.  In addition, you can find many view functions in the Views tab.  

The following paragraphs deal with some exemplary types of representation. Further informa-
tion on view functions can be found in the Online Help.   

 

32.1 Glass Model 
If a part is represented as glass model, all edges, including the hidden ones, are visible. This 
representation is called “glass model” as this setting provides a realistic representation for 
transparent materials only.  

An advantage of this representation is that the image build-up speed is quite high, as no visuali-
sation calculations have to be carried out.  

  
      Glass model             Hidden Line          Hidden Line dashed 

                                             
Fig. 67  Edge model functions 

If you want to represent all views of your drawing as glass models, right-click the view frame 
(pink dotted frame) in your drawing and select Representation, Others > All views, Glass 
Model. 

 

32.2 Hidden Line/Hidden Line Dashed 
The Hidden Line function “hides hidden lines”. The Hidden Line dashed function, in contrast, 
shows hidden lines by representing them as dashed lines. The hidden edges of a body on layer 
40 (glass) are not considered for these functions.    

If you want to represent all views of your drawing as Hidden Line representations, right-click the 
view frame (pink dotted frame) in your drawing and select Representation, Others > All 
views, Hidden Line.  

The Hidden Line calculation does not take self-intersections into account. In such cases, unex-
pected overlaps may occur. Use the Collision check function in the Information tab to check a 
drawing for collisions.  

 

32.3 Shaded With Edges 
This function enables a faster calculation, with shading and representation of visible edges. The 
edges are represented according to the current edge model parameters – with the exception of 
free edges.   

We recommend that you also read the information on Drawing properties provided in the Online 
Help. You can access the relevant functions via Drawing > Properties > Others > Surface 
approximation and 3-D Standard > Properties > Others > Limiting angle for shading. 

See Online 
Help 
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These functions do also affect shaded representations. For example, a higher value for surface 
approximation results in many cases in a more accurate and consistent shading.  

 
Fig. 68  Glass model, Shaded without edges, Shaded with edges 

 

 

Fig. 69 Examples of shaded parts 
 

Shaded representations as well as all types of representation beginning with “Quick…” (Quick 
Hidden Line etc.) are based on approximation algorithms. This enables a very fast calculation of 
the shading or hidden lines, even for very large and complex assemblies. In very rare cases it 
may occur that particular elements (e.g. the shortening of a view or similar) are not represented 
correctly.  In such cases it is recommended to use the exact procedure, “Hidden Line”, instead 
of “Quick Hidden Line”.  
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32.4 Exercise 1 (3D-GL-01.0) Anvil 
 Learning target: Solid primitives; select functions via the context menu; ICN; different types 

of representation. 
 Load the “Main assembly Anvil + Tool” as a main part via the Explorer from the hicad / 

Szenen / Examples directory. Hide the sketches in the ICN (Information- and Communica-
tions-Navigator) if necessary. 

 Draw the mandrel as a cone with a diameter of 5 and a height of 7. Reference the part and 
add it to the feature log. Save the part, with document master data, to the HELiOS data-
base. 

 Draw the block of wood and the hoops as (hollow) cylinders. Reference the part and add it 
to the feature log. Save the part, with an arbitrary document master, to the HELiOS data-
base.  

 You can find the “Translate part, via 2 points” function in the “Transform” function group of 
the “3-D Standard” tab. If you want to translate a part, you need to activate it in the drawing 
or in the ICN first. The most convenient procedure, however, is the following one: If you 
want to translate a part, right-click the part in the drawing or the part name in the ICN, and 
select the “Translate part, via 2 points” from the context menu. The part on which the cursor 
is placed is automatically translated, as you automatically activate a part by right-clicking it.  

 Switch between different types of representation for the drawing object: Glass model, 
Shaded with edges, Shaded without edges etc.  

 Familiarise yourself with the ICN: 

 Switch between the “Views” and “Switch Drawing” tabs. 

 Look especially at the sub-parts of the anvil in the middle window of the ICN. 

 Switch to the “Properties” tab in the bottom window of the ICN and assign different col-
ours to the mandrel, block of wood and hoops. If you find the names are not meaningful, 
use this tab to change them. 

 Activate the part “Anvil” in particular and look at the feature of this part in the bottom win-
dow of the ICN. Activate some sketches in the feature with the “Process Sketch” 
functions. 

 Hint: Surface colour and name can also be changed in the middle window of the ICN (by 
right-clicking the corresponding part). 

 Space for notes:  
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33 Transform and Clone Parts 
Main parts and sub-parts can be transformed, i.e. translated, rotated, mirrored or scaled. You 
clone a part by additionally copying it while transforming it. The following paragraphs deal with 
transformations and clonings.  
 

33.1 Transform parts 
On the 3-D Standard you will find the Transform function group.  

 

 
Fig. 70  The Transform pull-down menu 
 

Select the Translate part, via 2 points function. Use this function to translate the active part via 
specification of 2 points which determine the translation vector.  

First specify a point on the part you want to transform, then specify its new position in the draw-
ing. If you choose the point option “Relative”, you are enabled to specify the exact length of the 
translation.  

 

1. Pkt.

2.Pkt

 
Fig. 71  Translation 
 

When rotating a part, we specify a rotation axis instead of a translation vector. We can select 
the rotation axis as a line or via 2 points. Mirroring is described in the following paragraph.   
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33.2 Clone Parts 
Parts which are needed several times in the drawing can be copied. Such copies are called 
“clones” in HiCAD. The corresponding functions can be found in the Clone function group of the 
3-D Standard tab. 

The following types of transformations are available:  
 Translate, 
 Rotate, 
 Mirror, 
 Move (incl. Similarity transformation). 

Let us now take a closer look at the Mirror function.  

Select Clone+Mirror part, via 2 edges. 

After selecting this type of transformation, the following input window is displayed:  

 

 
Fig. 72  The Clone input window 

 Number 

Here you can enter the number of part you want to create. Please note that the original 
part is already included. If, for example, you want to have 3 parts, you need to enter a 3 
(and not a 2). Please also note: When mirroring parts, the number is always 2.  

 Union 

If you want to union the original and its clonings by a Boolean operation, so that it forms one 
single part, activate the Union checkbox (this only makes sense if you start with one half of a 
(revolved) part that you want to make a whole part. Otherwise always deactivate the Union 
checkbox).  
 

 Create superordinate part (only available if the Union checkbox is deactivated) 
If this checkbox is activated, all parts created by mirroring, translation, rotation etc. are com-
bined as sub-parts under a dummy part with the name “Group”. We normally do not activate 
this option. Reason: The most convenient way to combine parts is the creation of Assem-
blies.   
 

 Create assembly (only available if the Union checkbox is deactivated) 
Use this option to combine cloned parts as subordinate parts to a common assembly.  

 

After entering the required data, exit the input window with OK. Then select two lines to de-
fine the mirroring plane.   
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33.3 Exercise 2 (3D-GL-02.0) Guide Carriage 
 Learning target: Solid primitives as hollow parts and part segments; add parts; various 

views; select functions for the design (e.g. change scale) via context menu. 
 Draw both upper parts of the guide carriage as hollow segment cylinders, respectively seg-

ment cones. 
 Merge both parts using the “Add part” function. Check the result in the ICN. 
 Mirror the new part in downward direction.  
 Display the part in front, side and top view as well as the standard axonometry. 
 Add a drawing frame (Sheet area). 
 Change the scale of the drawing if required. To do this, right-click the drawing and select 

the appropriate function.  
 Hint: Please note that Boolean operations (Add, Subtract, Intersections) have two disadvan-

tages: They increase the size of the drawing file and the calculation time in the Feature log, 
especially if the added/subtracted/intersecting part contains sub-parts, such as sketches 
etc. Besides, the added/subtracted/intersecting part will at first be invisible in the Feature 
log. (even if it can be retrieved and processed in the Feature log with the “Load processing 
part” function). Instead, you could also have used the “Revolved solid” function to draw the 
Guide Carriage “as one part”.  When adding very complex parts or subtracting very complex 
cavities, however, the attaching or excluding of simple geometries may not be sufficient, 
making additional Boolean operations necessary.  

 Space for notes:  
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34 Load Drawings With or Without Database  
Procedure with Database (additional module) 

Select the Switch drawing tab in the upper ICN window. Double-click the empty drawing 
thumbnail.  In the Drawing tab, select the Load drawing with DB function.  

Deactivate the two filters suggested by HiCAD for Links. As we have not linked our drawing to 
anything, this filter would not make any sense for us. Instead, define your own filters. This can, 
for instance, be *3 in the Document number field, or A* in the Designation field. If you set sev-
eral filters, all search conditions need to be fulfilled (“AND” link).  Therefore, you normally set 
only one filter.   

 
Fig. 73  Remove “Link” predefinions; set filter “*3”  in the “Document number” field. 
 

Click the Find icon. 

 
Fig. 74  Result list according to revision date (“Changed” column) 
 

A result list is displayed which can be sorted if required. To do this, click on a column header 
(Document No., Designation etc.). In the result list shown below, the “Changed” header was 
clicked twice. Therefore, the found drawings were sorted in descending order (i.e. the newest 
date is at the top of the list). 

Click an item in the list to get a Preview of the drawing. Use the arrow key to browse through 
the items.  

Load one of the drawings with a double-click. You can also select a drawing with a single click 
and then choosing Apply. 
 

Procedure WITHOUT database: 
 

If you work at your company without database, you probably will have switched off the database 
on your training computer. After selecting the Load drawing function, the Windows mask with 
the file names of all drawings is displayed. Further selection criteria are not available when 
working without database. You can however select the View menu icon. In the following menu, 
select Details. You can now, for example, sort lists of items according to their file size, by click-
ing the header of the Size column.  

 

 

 



                                                        Boolean Operations 

HiCAD  3-D Training  105 

35 Boolean Operations 
In the function group +/- of the 3-D Standard tab you will find the Boolean operations Add part, 
Subtract part and Intersection. The following example describes the subtraction of a part from 
the active part.  
 
 

35.1 Subtract part  
Use this function to subtract an arbitrary part from the active part.  

Select the Subtract part function. Identify the part you want to subtract. If you want to retain 
this part after the Boolean operation, answer “Yes” to the question “Retain second part”, other-
wise answer  “No”.  
 

Active Part = Cuboid
Identified Part = Cone

Active Part 
= Cuboid

= Cone
Identified Part 

Subtraction

Subtraction

 
Fig. 75  Subtract parts: (Top: Cuboid minus Cone; Bottom: Cone minus Cuboid) 

 

Please note that Boolean operations (Add, Subtract, Intersection) have two disadvantages: 
They increase the size of the drawing file and the calculation time (especially if the 
added/subtracted/intersected part has sub-parts, e.g. a sketch). Furthermore, the 
added/subtracted/intersected part is initially invisible in the Feature log (even if it can be re-
trieved and processed in the Feature log with the “Load processing part” function).   

In a later part of the training we will learn about functions which do not have such disadvan-
tages. These are functions such as “Subtract part, with translation/with rotation” or “Add sweep, 
with translation/rotation”. When adding very complex parts or subtracting very complex cavities, 
however, the attaching or excluding of simple geometries may not be sufficient, making addi-
tional Boolean operations necessary. 
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35.2 Exercise 3 (3D-GL-03.0) Female Die Part 
 Learning target: Subtract; intersection; Solid primitives; Select the functions via the right 

mouse button if possible; load from the database (additional module!). 
 Load the female die part as a main part via the Explorer from the hicad / Szenen / Exam-

ples directory.  
 Create a sphere with a diameter of 100 in the centre of the female die part so that it dips 

into the female die part by 10 mm. 
 Create a spherical indentation by subtracting the sphere of the female die part.  
 Create the male die part as a cylinder with a diameter of 70 and a height of 70 (the final 

height of 50 is created in a later step).  
 The ball-shaped rounded bottom of the male die part with a diameter of 100 and the total 

height of 50 are created as follows: Create a sphere with a diameter of 100 in the centre of 
the top surface of the cylinder. Create the intersection of sphere and cylinder. 

 Hint: Please note that Boolean operations (Add, Subtract, Intersections) have two disadvan-
tages: They increase the size of the drawing file and the calculation time in the Feature log, 
especially if the added/subtracted/intersecting part contains sub-parts, such as sketches 
etc. Besides, the added/subtracted/intersecting part will at first be invisible in the Feature 
log. (even if it can be retrieved and processed in the Feature log with the “Load processing 
part” function). Instead, you could also have used the “Subtract part, via rotation“ function to 
create the subtraction for the female die part. For the creation of the male die part you could 
have used the “Add sweep, via rotation” function.  When adding very complex parts or sub-
tracting very complex cavities, however, the attaching or excluding of simple geometries 
may not be sufficient, making Boolean operations necessary. 

 Save the drawing. 
 Load the drawing from the database (additional module!). 
 Familiarise yourself with the saving via interface and with the Print menu. 
 Space for notes:  
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36 Working with Sketches 
36.1 Sketches 
A sketch is a 3-D part with free edges which is located in a plane. You can, for example, use a 
sketch for derivation of extruded solids, bores, adding or of subtracting of material, as well as 
for c-edge sweeps or sectional views. The function can be found on the Sketch tab.  A sketch 
has the part type "Part with free edges".  

Please do not confuse the Sketch function with the 3-D Sketch function! The latter is some-
thing completely different, namely a 3-D dummy part (e.g. for guidelines).  

When you create a new sketch, HiCAD automatically assigns the part name Sketch, which can 
however be changed with the Rename function. As for 3-D parts, please note the following: If 
an article number exists in the Part attributes, it needs to be renamed or deleted, as in the ICN 
display, the article number has priority over the designation. You can access the part attributes 
by right-clicking the sketch (or a part).   

You draw the sketch in the current sketch plane, or in the current 2-D view (front/side/top view), 
respectively. Use the Plane functions in the New function group of the Sketch tab to define or 
activate a different sketch plane. This is however only possible if the Sketch does not contain 
any lines.   
 

Please note:  
 When you create a new sketch, HiCAD automatically starts the HiCAD 3-D HCM, which is a 

tool enabling you to position and move the elements of a composite edge or a sketch.  To 
this end, the elements of the c-edge/the sketch are linked with so-called constraints, i.e. di-
mensional and logical relations and/or restrictions.  The c-edge parametrics will transform 
the corresponding elements in such a way that the specified constraints are respected.   

 In case of 3-D objects derived from sketches, HCM constraints assigned to the sketch are 
taken over as parametric dimensions. This applies, for example, to extruded or revolved sol-
ids, as well as to bores, material subtractions etc. You can change the part via these 
parametric dimensions.  

A detailed description of c-edge parametrics is provided in the Online Help, or in our 2-day Pa-
rametrics training.  
 

36.1.1 New Plane 
You draw your sketch in the current sketch plane. If you are working in a 3-D view, HiCAD 
places this sketch plane into the current processing plane, or, if there is no processing plane, 
into the XY-plane of the active coordinate system. If you are working in a 2-D view, the sketch 
plane is automatically located in this view.    

As long as the sketch does not contain any lines, you can define a different sketch plane with 
the New plane… function.   

More information about processing planes can be found in the Online Help.  
 

36.1.2 Sketch Polyline 
A polyline is a structurally coherent succession of individual lines. The start point of a following 
line is the end point of the previous line.  
 

Sketch Polyline 

Sketch technology enables a fast creation of polylines.  It facilitates the drawing process by con-
stantly displaying auxiliary lines along a predefined grid – starting from each last point of the 
drawn polyline – while also showing the corresponding angles, distances and radii at the cursor. 

 

 

 
 

See 
Online 
Help 

See 
Online 
Help 
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This grid enables you, for example, to specify the direction and the length of a line with a mouse 
click.  

> 15°
80.

 
Fig. 76  Angle and Distance shown at the cursor 

You can change the grid fineness, as for all sketch functions, with the following keys on your 
keyboard:   

 Minus key: Refine grid (e.g. steps of “5” instead of steps of “10”) 

 Plus key. Coarsen grid 

 Space bar: The desired length or angle can directly be entered as a value via the key-
board.  

You can permanently preset the grid fineness in the SKIZZTEC.DAT file. When zooming the 
screen, the grid fineness also changes.  

If you have already drawn at least one line with the Sketch polyline function, and then click the 
right mouse button, the following context menu is displayed:  

 
Fig. 77 Right-click after drawing a line with Sketch polyline function  
  

The following paragraph provides an explanation of the Arc function. All other functions are de-
scribed in detail in the Online Help.  

 
Arc 
Use this function to insert arc into the polyline. After selecting the function, an auxiliary circle is 
displayed tangential to the last line. Its radius is displayed at the cursor.  

 
Fig. 78  Auxiliary circle; Radius shown at cursor 

See 
Online 
Help 
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Accept the suggested radius with RET, or enter the value, or press the space bar and enter the 
value via the keyboard. Important: If you click in the 1st or 2nd quadrant of the arc, the arc is con-
nected tangentially in the direction of the last created line element. If you click in the 3rd or 4th 
quadrant or the arc, the arc is connected tangentially in opposite direction of the last created 
line element. Therefore, please make sure that the cursor is already positioned at the cor-
rect side of the circle when you select he radius!   

Next, the aperture angle for the arc is displayed at the cursor:   

 
Fig. 79  Aperture angle shown at cursor 
 

Accept the angle with RET, or press the space bar and enter the value via the keyboard.  

 
Fig. 80  Arc created  with the Arc function 

 

New polyline 

In the Line function group of the Sketch tab you will find the New polyline function. This func-
tion is particularly useful if you prefer working with point options instead of using a grid.  
 

 
Fig. 81  The New polyline function 

 

Select the point options, using one of the following options that you already know:  
 RETURN key 
 Point options R, A, D, P, W, N via pressing the corresponding key on the keyboard 
 Right-click when HiCAD suggests any point option 
 Quick double left-click 
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36.2 Extruded Solid  
Besides creating revolved solids, adding or subtracting material, you can also create extruded 
solids from closed polylines in a sketch.   

Use the Extruded solid function in the New function group of the 3-D Standard tab to create 
general cylinders. These are derived from sketches, by translating a copy of the sketch along a 
normal.  
 

 
Fig. 82  Extruded solid from sketch 

Proceed as follows: 

Proceed as follows to create an extruded solid:  

 Enter the part name.  

 Activate the Reference checkbox if you want to reference the extruded solid.  

 Activate the Feature checkbox to record the creation of the extruded solid creation in the 
feature log.  

 Select the type of Height definition (e.g. Value input, if you want to enter the height as a 
value) 

 Enter a value for End height and, if required, for the Draught and the Start height.  

 Select the type of cross-section definition. In the “Sketch for cross-section” area you can 
either create a new sketch or select an existing sketch.  

 If you first want to see a preview of the created part, click the Preview button. If you are 
satisfied with the result, click the Create button. 

 

Please note: 
If a sketch is active when you call the Extruded solid function, this sketch is used by default 
until you select or create a different sketch.   
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36.2.1 Height Definition 
You can either select the height dynamically with the cursor, or enter a height via value input. 
Default setting is always the previous setting.   

 Dynamic 
If you activate this option, you can select the height dynamically with the cursor. Move the cur-
sor to the required position and left-click. HiCAD then shows the height for correction. The input 
fields Start height and End height are locked if you select this option.  

In the “Dynamic” mode, you first need to select the “Preview” or “Select” function, then 
left-click in the drawing area. Please also note the user guidance text in the info bar.   

 Value input 
If you select this option, you need to enter appropriate values for Start height and End height.   

These values specify the distance between bottom surface and top surface of the extruded 
solid, starting from the sketch plane, thus defining the height of the extruded solid. Negative 
values cause the corresponding surface to be set in negative Z-direction.  

 Both sides 
If you activate this checkbox, you can (for both the Dynamic and the Value input option) deter-
mine that one half of the height will be set in positive Z-direction, and the other half in negative 
Z-direction. Alternatively, you can achieve the same effect by entering -30 for Start height and 
30 for End height.  
 

If you right-click one of the value input fields (e.g. Start height), a context menu is displayed. 
Here you can pick distances and angles or copy and paste variables or values from the clip-
board into the input fields.  
 

36.2.2 Draught 
You can specify the inclination angle to create an extruded solid with draught. Positive and 
negative angles are permitted.  
 

36.2.3 Sketch for Cross-Section  
Here you can select either a new sketch or an existing sketch for the cross-section of the ex-
truded solid.   

 Create new sketch 
Activate this symbol if you want to create a new sketch for the cross-section of the extruded 
solid. To create the new sketch, proceed as described in the Sketches chapter. The New ex-
truded solid window will remain active during the sketch creation. After completion of the 
sketch you can insert the extruded solid into your drawing by selecting Preview/Apply or Cre-
ate. 

 Select sketch 
Activate this symbol to use an already existing sketch as cross-section. Identify the sketch, then 
select Preview/Apply or Create to insert the extruded solid into your drawing.  

 Delete after creation 
Activate this checkbox if you do not want to retain the sketch after its creation.  
Please note however that the sketch will no longer be available for subsequent changes if you 
are working without Feature Technology! When working with Feature Technology you can re-
trieve the sketch at any time, even after its deletion.  

 

Closed polylines (e.g. rectangles, circles etc.) which are located within a plane of the sketch, 
are interpreted as bores or material subtractions.   
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36.2.4 The “Reference” and “Feature” Checkboxes 

Reference 
You can reference extruded solids already during their creation, by activating the Reference 
checkbox.  

After creating the extruded solid, HiCAD prompts you to save the part. Further information on 
referencing is provided in the chapter “Re-Use“ and in the Online Help.  

Feature 
If you want to record the creation of the extruded solid in the feature log, activate the Feature 
checkbox.  

 
Fig. 83  Example of a feature log for extruded solid creation  

If you want to apply subsequent changes to the cross-section of the extruded solid, select the 
Sketch, Process function in the feature log, change the sketch as required and confirm your 
changes with Apply sketch.   

Or select the Sketch, Exchange function to replace the cross-section of the extruded solid with 
another sketch.   

Use the Sketch, Load function to obtain a sketch which is totally independent of the underlying 
3-D part. You can, for instance, use this sketch to create another extruded solid, a bore or simi-
lar.  

Further information can be found in the Online Help.  
 
36.2.5 The “Preview” and “Create” Buttons 
If you want to see a preview of the extruded solid, click the Preview button. You can then cor-
rect the entered values or insert the part as displayed by clicking the Apply button.  

If you click the Create button, the part is immediately inserted into your drawing. 

Please note: 

 If a preview is already displayed, this preview will, in case of any changes to the values in 
the input fields, only be updated if you confirm the changes with RETURN (ENTER).  

 If you have selected dynamic height specification, you need to activate the dynamic mode 
after clicking the Preview or Create button. Please also note the prompt in the info bar.   

 

see 
Online 
Help 
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36.2.6 Example 
Extruded solids based on different value inputs for start height, end height and draught (inclina-
tion) have been created from the sketch shown below. Differences are shown in Fig. 85.  

3-D sketch

x

y

z

 
Fig. 84  Sketch 

Draught 0
Start height 0
End height 80

Height 
of part: 80

Height 
of part: 100

Height 
of part: 60

Height 
of part: 80

Height 
of part: 60

Height of part: 80
(Part "upside down")

Draught 0
Start height 0
End height -80

Draught 5
Start height 20
End height 80

Draught 0
Start height -20
End height 80

20 20

80

80

Draught 0
Start height -20
End height -80

Draught 5
Start height 80
End height 0  

Fig. 85  Extruded solids with different start and end heights 

 

36.2.7 Notes on Extruded Solids 
 Circular arcs will produce cylindrical surfaces for analytical models.  

 Inner cycles, i.e. closed polylines, circles and ellipses located in a sketch plane, are inter-
preted as bores/material subtractions.  

 The height of the extruded solid, as well as the HCM constraints assigned to the sketch are 
taken over as parametric dimensions. These enable you to change the part at a later time.   

 If a sketch is active when you call the Extruded solid function, this sketch will be used by 
default until you select or create a different sketch.  
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Before creating an extruded solid (or revolved solid, material subtractions or addings), you 
should make sure that the contour of your sketch is actually closed. You can use the following 
options for this:   

 Sketch > Sort GE in active sketch  
 Information > Information 3-D Sketch and  
 Information > Information 3-D-Sketch 1  

 

37 Parametric Dimensions 
When Feature Technology is switched on, HiCAD automatically generates the parametric di-
mensions of a part and displays them if the part and the feature step with which the parametric 
dimensions have been generated is active (i.e. extruded solid).   

 

 
Fig. 86  Parametric dimensions 

 

37.1 Changing Parts via Parametric Dimensions 
If you right-click a parametric dimension, a context menu with various processing functions 
opens. The Change feature parameters function enables you to change the parametric di-
mension. Use the Convert to drawing dimension function to convert the parametric dimension 
to a “genuine” 3-D dimensioning.  
 

                                        

Fig. 87  Details of the Parametric dimensions context menu 

 

Changing part dimensions in the feature log or via parametric dimensions is the most recom-
mended way to model parts.  

To hide parametric dimensions before printing a drawing, activate the 3-D Dimensioning+Text 
tab and select Tools > Table > Parametric dimensionings > Hide, all. 
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37.2 Exercise 4 (3D-GL-04.0) Profiles 
 Learning target: Sketches; extruded solids; conversion of 2-D parts to 3-D parts; modify part 

via parametric dimensions. 
 Draw the first two profiles as extruded solids. Activate the referencing feature for this and all 

future parts.  
 Load the part “BATTEN.FIG” from the hicad / Szenen / Examples directory. Create a sketch 

and copy the 2-D part into the sketch. Convert the sketch to an extruded solid (right-click on 
sketch).                                                  

 Select the parametric dimensions with the right mouse button and change them. 
 Tip: Let us assume that you copied a 2-D part into a sketch. This sketch can now be con-

verted to an extruded solid or a revolved solid. This is one option to transform a 2-D drawing 
into a 3-D drawing. 

 Another option to transform 2-D parts into 3-D parts is the so called “2-D->3-D Conversion”. 
Ask your trainer for a demonstration of the conversion technique. Example drawings can be 
found in the directory local hard disc / hicad / Szenen / Beispiele (Examples).  

 Space for notes:  
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38 Convert 2-D Parts to 3-D Parts 
38.1 Convert via Sketch 
3-D CAD models offer many advantages over 2-D drawings. For example, you can automati-
cally derive standard views, sectional views and detail views from 3-D drawings. If you apply 
changes in one view, these changes are automatically applied to the other views (the so-called 
“associativity”). In 2-D, you would have to change all views one after another. Furthermore, you 
are enabled to perform motion simulations, collision checks, assembling simulations, weight 
calculations or statics calculations. Besides that, images derived from 3-D drawings look much 
more realistic than images from a 2-D drawing.  

Therefore it makes sense to convert frequently used 2-D drawings to 3-D drawings. Very often 
you use sketches for the conversion:  

 Go to the required view (front view, side view, top view) or define a processing plane.  
 Define a sketch (not 3-D Sketch!). 

In the Others function group of the Sketch tab you will find the Project GE, Individual function 
enabling you to copy 2-D Polylines and 2-D Parts into a sketch with the same named menu 
items: 
 

 
Fig. 88  Functions for the copying of 2-D lines into sketches (to convert 2-D to 3-D)  
 

You can use the sketch to create extruded solids or revolved solids, add or subtract material.  
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38.2 2-D->3-D Conversion 
If you have created several views in 2-D, the conversion of 2-D to 3-D can be performed even 
faster: In such cases, it is recommended to use 2-D->3-D- Conversion. To access this function, 
activate the Drawing tab and select Others > Modules > 2-D->3-D Conversion. The procedure 
will be explained in the following exercise by your trainer.  

Further information on this function can be found in the Online Help. 

 

 
Fig. 89  3-D part created with 2-D->3-D Conversion 
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38.3 Continuation Exercise 4 (3D-GL-04.0) Profile 
 Learning target: Conversion of 2-D parts to 3-D parts.  
 Load the part LEISTE.FIG from the directory hicad / Szenen / Examples. Create your own 

sketch and copy the 2-D part into the sketch. On the “Sketch” tab, select the “Others” func-
tion group. Here you will find the function “Project GE, Individual” > Without transformation, 
Part”.  

 The menu of the “Project GE, Individual” function provides a wide range of functions for 2-D 
lines or 2-D parts. You can use them to convert arbitrary 2-D parts to 3-D parts. These can, 
for instance, be parts from old 2-D drawings, but also contours from 2-D Standard Part CDs, 
which you require as 3-D parts in a 3-D drawing.  

 Convert the sketch to an extruded solid (right-click sketch).                                                
 Tip: Let us assume that you copied a 2-D part into a sketch. This sketch can now be con-

verted to an extruded solid or a revolved solid. This is one option to transform a 2-D drawing 
into a 3-D drawing.  

 Another option to transform 2-D parts into 3-D parts is the so called “2-D->3-D Conversion”. 
Ask your trainer for a demonstration of the conversion technique. Example drawings can be 
found in the directory local hard disc / hicad / Szenen / Examples.  

 Space for notes:  
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39 Automatic 10-Minutes Save 
In HiCAD you can open and process up to 18 drawings simultaneously. The currently proc-
essed drawing of the first 9 drawing files is automatically saved every 10 minutes. The 
automatic backups can be found on your local hard disk in the temp sub-folder of the hicad 
directory. In the lower area, select the extension .SZN (instead of .SZA) in the File type field.  
HiCAD_11 means the automatic saving of the drawing in the first of the 18 thumbnails. Hi-
CAD_91 is the automatic saving of the drawing in the 9th thumbnail. HiCAD_92 is the last but 
one saving of the drawing in the 9th thumbnail (i.e. 20 minutes old). If you are working with two 
screens, this will be the automatic saving of the drawing on the second screen.  

Example: You have loaded 10 drawings into HiCAD and are now working on the sixth drawing. 
After 10 minutes, the drawing will be saved under the name HiCAD_61. The previous automatic 
saving of the drawing is copied and renamed to HiCAD_62 (Special case: When using two 
screens, it will be the drawing on the second screen). Later, you switch to the third drawing. 
From now on, it will be this drawing that will be saved under the name HiCAD_31 every 10 min-
utes. The already existing previous copy “HiCAD_31” will be copied and renamed to HiCAD_32. 
The tenth drawing will not be saved – even if you open and process it, as the automatic 10 min-
utes save exclusively applies to the first 9 drawings.   

If you are working without database you need to copy the loaded 10-minutes save to another 
directory with the Save as function. (Reason: If the drawing remained in the temp directory it 
would be overwritten every 10 minutes.) If you are working with database, this will not be nec-
essary. When loading the 10 minutes save, HiCAD will ask you:  Link to HELiOS document found. 
Take over file name (Y) or Delete link (N)? Answer this question with YES. HiCAD will automatically 
copy the drawing back to the default path C: of the system file FILEGRUP.DAT. 

 

40 Change Parts via Sketches 
In the previous exercise, we have changed the dimensions of parts via their automatically cre-
ated parametric dimensions.  If we have created an extruded solid or revolved solid, material 
subtractions or addings via a sketch, we can also change these parts or material subtractions 
via the sketch. When we change the sketch, the extruded/revolved solid or material subtrac-
tion/adding derived from the sketch changes as well.   

If you have switched Feature technology off, you must not delete the sketch after creation of the 
extruded solid, material subtraction etc. If Feature Technology is switched on, you can delete 
the sketch if desired, as you can retrieve it at any time with the Sketch, Process function in the 
feature log.  

 

40.1 Change Line in Sketch 
Activate a part (extruded solid, revolved solid, subtraction etc.)  you have created with a sketch. 
In the Feature tab of the lower ICN window you can see the feature steps for the creation of this 
part. If the corresponding sketch has been deleted after creating the part, select the feature step 
for this part in the feature log and retrieve the sketch with the Sketch, Process function. The 
following graphic shows the sketch contour of a screw plug after selection of the Sketch, Proc-
ess function. 
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Fig. 90  Process sketch  
 

Use the functions Show only active part and Front view to obtain a clearer representation of 
the sketch.  

Apply some changes to the sketch, e.g. delete a chamfer change the width of the nut. Make 
sure during the process that you do not interrupt the closed contour of the part. Then select 
Apply sketch. The change is also applied to the revolved solid belonging to the sketch.  

 

40.2 Apply Changes via 3-D C-Edge HCM (Edge Constraints) 
In the last paragraph we have changed a sketch without parametrics. This paragraph explains 
how to change a sketch with parametrics. The 3-D C-Edge HCM (HiCAD Constraints Manager) 
enables the setting of constraints for edges (edge constraints). The 3-D C-Edge HCM is part of 
the 3-D HCM and is a tool allowing the positioning and moving of composite edge elements. In 
most cases, these are polylines in sketches, but can also be 3-D lines within a 3-D part.  The 
corresponding elements are linked to each other by constraints, e.g. by   

 Dimensional constraints 

 Positional constraints and  

 Dependencies between variables (Example: The width is defined via the variable “Width” 
and the height with the formula “Width/2+10”).   

The 3-D C-Edge HCM transforms the corresponding elements in such a way that the specified 
constraints are fulfilled.  

The image below shows the three function groups on the HCM tab used for sketches:   

 
Fig. 91  Edge constraints (if sketch is active)  
 

The image below shows the three function groups on the HCM tab used for constraints between 
parts: 
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Fig. 92  Edge constraints, for lines between various parts 

Constraints are assigned to individual elements of composite edges. These elements can be 
points, straight lines, circles or arcs.  

Besides assigning constraints in order to position elements, you can use the Dragger to move 
individual elements while keeping to assigned constraints. You can also use the Dragger to 
detect remaining degrees of freedom in the drawing (i.e. “elements that still can be moved”).   

Proceed as follows:  

The definition of a parametric c-edge model consists of the following steps:  
 Sketching of the required composite edges – either in a sketch or in a 3-D part 
 Assigning of dimensional and positional constraints (edge constraints)  
 You can enter values as well as variables for dimensional constraints 
 If you assign variables (e.g. for the height of a plate or sheet in a sketch), you can also refer 

to already existing variables instead of entering a new variable (e.g. define the height with 
the formula “Width/2+10”). Please note that no spaces and arithmetic operators are allowed 
in names of variables! For example, “X-distance” would mean that you would subtract the 
“distance” variable from the “X” variable. Use the name “X_distance” instead.  

 Testing of the model with the dragger or via the variables table (if variables have been de-
fined); if required, correction of constraints or adding of missing constraints  

 

Please note: 
 Elements of a composite edge part (e.g. a sketch or a 3-D part with 3-D lines) can also be 

positioned relative to elements of another composite edge part.  The defined HCM con-
straint is however always assigned to the active c-edge part.  

 Only “properly drawn” composite edges can be processed properly: Please make sure that 
identical points, for example, are actually identical, or that lines do not consist of many seg-
ments etc.  

 Do not confuse “normal” HiCAD dimensionings and dimensional edge constraints! 
 A parametric c-edge model can only be changed via the constraints assigned with the 3-D 

C-Edge HCM.  
 The elements of a HCM model are highlighted in colour, according to the corresponding 

degrees of freedom: 

 Fixed elements orange 

 underdefined blue 

 overdefined red 

 fully defined green 
 

40.2.1 Start 3-D Edge HCM 
Start the 3-D C-Edge Constraints as follows:  

 Create a sketch or a 3-D dummy part.  
 Activate the HCM tab.  
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40.2.2 The HCM Model  

40.2.2.1 Create a HCM Model 
A HCM model is automatically created if you 

 assign the first HCM constraint manually, or 

 selected the AutoConstraints in the Settings and then call the Update HCM system func-
tion, or  

 Assign dimensional constraints automatically with the same-named function, or 

 during sketching, if you selected Specify constraints  via 3-D C-Edge > Tools/Settings. 

 

40.2.2.2 Display of the HCM Model in the ICN 
In the HCM tab of the lower ICN window, all HCM-constraints assigned to a composite edge 
part are shown. The constraints are linked to the part and are saved together with the part. In 
this way, you are enabled to change assigned constraints at a later time if required.  
The HCM tab of the lower ICN window provides information about the constraints of the individ-
ual elements of the active composite edge. It is also shown whether any elements are 
underdefined.  
 

 
Fig. 93  HCM constraints in the ICN 

 
You can select individual constraints in the HCM tab with a right-click. Here you will find the 
functions Sort according to geometry and Sort according to constraints. You are also enabled to 
Change, Delete etc. individual constraints.  
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40.2.2.3 Highlight Elements 
If you select a HCM constraint in the ICN with the left mouse button, the corresponding ele-
ments in the drawing are highlighted. This highlighting is retained even after part rotations.  
Surfaces to which the constraint has been assigned are marked green. This default setting 
(mark_faces=1) is saved in the KZUGPAR.DAT file in the SYS directory. 

40.2.2.4 Change HCM Model 
To change the HCM model of a composite edge, you need to activate the corresponding c-edge 
part (e.g. the sketch). The assigned HCM constraints are displayed in the HCM tab of the ICN.   

Proceed as follows:  

 Right-click the required constraint in the ICN and activate in the desired function in the con-
text menu.  If you left-click a constraint in the ICN, the corresponding geometry is 
highlighted in the drawing.  

 Right-click the required constraint in the drawing and activate the desired function in the 
context menu.   

 Select the desired function in the HCM tab (e.g. Change dimensional constraint) 
 

40.2.2.5 Use AutoConstraints 
Besides entering dimensional and positional constraints manually, you can also automatically 
search for relations and constraints between the elements of a composite edge by selecting the 
Use AutoConstraint option in the Settings dialogue. To access this option, activate the 
Tools/Settings function in the 3-D C-Edge function group.  When starting HiCAD for the first 
time, the AutoConstraint option is activated.  

To detect the constraints automatically, activate the Update HCM system or Assign dimen-
sional constraints automatically option.  All automatically detected relations/constraints are 
displayed in the HCM tab of the lower ICN window and also represented in the drawing. For 
further information on AutoConstraints please also see the Tools/Settings paragraph.  

If you want to assign AutoConstraints already during drawing of lines, circles etc., select 
Tools/Settings > Specify constraints. 
 

40.2.3 Dimensional Constraints  
Use the functions of the 3-D C-Edge (Dim.) function group to assign distance, angle and radius 
constraints.  

You can also use formulas or variables for all constraints requiring a value input. Formulas are 
a common arithmetic expression, within which variables may occur. If the start value of the vari-
able has not been defined in the sketch/part or in one of the superordinate parts yet, HiCAD 
prompts you to specify the start value.    

Dimensional constraints are, depending on the selected function, represented as distance, ra-
dius or angle dimension.  

Please note: 

 The dimension points depend on the dimensioning options specified in Tools/Settings. 

 The dimensions created by the HCM are no “normal” HiCAD dimensions. Conversely, Hi-
CAD dimensions are no dimensional constraints of the 3-D C-Edge HCM. 

 Dimensional constraints assigned to a sketch are taken over as parametric dimensions.  

 
The following paragraph explains the Distance parallel to X-axis, Distance parallel to Y-axis 
and Distance parallel to Z-axis functions of the 3-D C-Edge (Dim.) function group. All other 
functions are described in detail in the Online Help. We also offer a 2-day training on Paramet-
rics. 

 

 

 

 
 
 

 
 

see 
Online 
Help 
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40.2.3.1 Distance Parallel to X-, Y- Z-Axis 
Use these functions to assign a distance constraint between:  

 2 points, 
 1 edge and 1 point, 
 2 edges. 

In contrast to the Direct distance function, the distances are defined in X-, Y- or Z-direction.  

 
Fig. 94  Distance constraint, parallel to X-axis 

 

40.2.4 Define Positional Constraints 
Use the functions of the 3-D C-Edge (Pos.) function group to assign positional constraints, 
such as:  

 Fix/Unfix 
 Parallel X-axis 
 Coincidence, 
 Symmetry, 
 Tangential, 
 … and many others 

Positional constraints are represented in the drawing by the following characters:  

T tangential  - coincidence 
L perpendicular  = parallel 
K concentric  M mid point 
S symmetric  E equal distance 
F     Fix 

 
The following paragraph explains the functions Fix/Unfix, Concentric, and Parallel X-,Y-,Z-
axis of the 3-D C-Edge (Pos.) function group. All other functions are described in detail in the 
Online Help.  
 
40.2.4.1 Fix/Unfix 
A special type of constraint is the fixing of individual elements. If an element is fixed, it will not 
be moved in case of any necessary transformations.  

You can fix 
 Edges 
 Circles/arcs and 

 

 

 
 

See 
Online 
Help 
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 All points found with point option I. 

Identify the element or the point. If you have already fixed an identified element, the fixing is 
undone (removed).  

 
40.2.4.2 Parallel X-, Y-, Z-Axis 
If HiCAD recalculates the HCM model, it may happen that the sketch is rotated. Although Hi-
CAD keeps to all HCM constraints, a rotation of the sketch is often unwanted. Use the Parallel 
X-axis and Parallel Y-axis functions (if a 3-D instead of a sketch is used, also Parallel to Z-
axis) to prevent the rotation of the sketch (or the 3-D polyline), as these functions allow an 
alignment of lines parallel to X-, Y- or Z-direction of the active  coordinate system. The other 
lines, e.g. those of a rectangle, are automatically protected against unwanted rotations via con-
straints such as Parallel and Perpendicular. 

Select the desired type of alignment and identify one of the elements of the HCM model.  

The other elements are aligned to the identified element, i.e. the HCM model is adjusted.  
 

Very frequently, the first constraints assigned in a sketch are Fix/Unfix and Parallel X-axis. For 
example, by fixing the corner of a rectangular sheet in a sketch, you will also fix the direction of 
a possible lengthening of the sheet. Without fixing of the corner, the lengthening direction would 
be completely arbitrary.  

 
40.2.4.3 Concentric 
You can assign this constraint between  

 a circle/arc and a point 
 a circle/arc an a straight line 
 two circles/arcs 
 a circle/arc and a cylinder 
 a circle and a sphere 

 
Fig. 95  Specify concentricity constraints 
 
 
40.2.5 Drag Dynamically 
Use this function to change a parametric model by dynamic dragging of lines and points while 
taking already specified constraints into account. In this way, parameter changes of the ele-
ments are visualised.   

Use the crosshairs to select a point of an element of the composite edge. If the position of the 
selected element has not yet been specified, it can be dragged dynamically with the crosshairs. 
Apply the modified model with a left-click. Use the middle mouse button to restore the original 
situation.  

 

The Dragger function is often used to detect remaining degrees of freedom in the HCM model. 
You can then assign dimensional or positional constraints to elements that can still be moved.   
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Active Model

Angle Constraint: 15°

Fixed Point

2nd Identification

1st Identification

 
Fig. 96  Drag 
 

You rotate the c-edge about the fixed point by moving the identified line. The length of the iden-
tified line and its angle to the second c-edge remain unchanged. Position and length of the third 
edge will be changed.  

Please note that during dragging the dragger mode settings specified in Tools/Settings are 
taken into account.  
 

40.2.6 Change Dimensional Constraint 
Use this function to change a constraint that has already been assigned to a composite edge.  

Identify the dimensional constraint, and enter the new value.  

 
Fig. 97  Change dimensional constraint 
 

Alternatively, you can also change dimensional constraints via the ICN.  
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40.2.7 Move Dimension Line 
Use this function to move the dimension line of a dimensional constraint. Identify the constraint, 
and drag the dimension line to the required position.  

Please note: You can also directly move the dimension line with Drag & Drop.   

 

40.2.8 Update HCM System 
Use this function to update the active HCM system.   

This function can be helpful if, for example, not all constraints are displayed after clicking Re-
draw. In addition, you can use this function to search for AutoConstraints.  
 
40.2.9 Change Variables 
Instead of value inputs for distances, angles, etc. you can also use variables to assign dimen-
sional constraints. This function enables you to display a list of the variables used in a model.   

To change the values assigned to the variables in the dialogue window, double-click the re-
quired value and overwrite it.   
 
40.2.10 Tools/Settings 
Use this function to specify various settings for the C-Edge HCM. In addition, the context menu 
of the function allows a selection of further constraints, in addition to already assigned con-
straints.   

 
40.2.10.1 Settings (3-D Part HCM) 
You can find this function in the 3-D Part function group of the HCM tab. Use this function to set 
the parameters for the auto search of constraints/relations between the elements of a compos-
ite edge. Furthermore, you can select the dragger and calculation mode.  

 
40.2.11 Delete constraints, individually 
Use this function to delete individual constraints of the active system. Identify one of the geome-
tries to which you have assigned a constraint. HiCAD displays the found constraint and asks you 
whether you want to delete it.  

Alternatively, you can also delete constraints directly in the ICN, or by right-clicking a constraint 
in the drawing.  

 

40.3 Link Dimensions with 3-D C-Edge HCM  
You can use the functions in the 3-D C-Edge (Dim.) function group to define distances, angles, 
diameters, radiuses etc. and assign values to them. We can however also assign names of 
variables to them. The first character of the name needs to be a letter. Besides that, we can 
select already existing constraints via the Change dimensional constraints and enter a vari-
able name instead of a value. The following function enables you to edit a list of all assigned 
names of variables and conveniently change them by simply double-clicking a value.  

  
40.3.1 Change Variables 
Instead of entering values for distances, angles, etc. you can also use variables to assign con-
straints. Use this function to display a list of the variables used in a model.  
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Fig. 98 Change variables 

The values assigned to the variables can be changed by double-clicking and overwriting them.  

40.3.2 Cross-Referential Variables Names  
The assignment of variables names is particularly interesting if you refer variables to each 
other. In the following exercise, the Depth shall receive the variables name H1, and the Inner 
thread diameter the variables name D0.  

Use the Change variables function to display the result:  

 
Fig. 99  Depth and Inner thread diameter as variable 

You can use the Distance parallel to Y-axis function and enter the formula D0*1.25 for the 
inner diameter. This means that the inner diameter will always be 1.25 times greater than the 
inner thread diameter. As you did not assign a new variables name (D0 existed already), the 
variables table contains only the variables D0 and H1.  

 
Fig. 100  Inner diameter 1,25 times larger than inner thread diameter  
 

If you have used variables names in a sketch and have already created a 3-D part with the 
sketch (e.g. an extruded solid or a revolved solid), you can also access the variables table via 
the part: Right-click the part and select the Properties / Part variables function.  This is even 
possible for solid primitives to which material subtractions have been applied via a sketch with 
variables names.   
 

 

Due to reasons of time we could show you only a few Parametrics functions in our 3-D training. 
Extensive information on the Parametrics module is provided in our 2-day Parametrics training, 
such as the creation of local and global variables, constraints between different parts, motion 
and function simulations, dynamic collision checks, creation of Feature and Design Variants etc.  
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40.4 Exercise 5 (3D-GL-05.0) Screw Plug 
 Learning target: Sketches; revolved solids; modifications of the revolved solid by deleting 

and redrawing lines in the corresponding sketch; modifications of the revolved solid via the 
3-D Constraint Manager; modifications of the revolved solid via the 3-D Constraint Manager 
using variables. 

 Draw the revolved solid with the given dimensions.  
 Save the drawing! 
 Select the “Process Sketch” function in the feature log. Delete the 2x45 chamfer and the R2 

fillet. Sort lines if necessary. Take over sketch. 
 Select the “Process Sketch” function in the feature log. Change some dimensions with the 

help of the 3-D c-edge Constraint Manager. Fix – if necessary – some points or lines. Use 
the dynamic drag function to control if dimensions change into the direction required and if 
the characteristics of the other lines (e.g. parallelism etc.) are maintained. Take over sketch. 

 Select the “Process Sketch” function in the feature log again. The dimensions you defined 
in the previous section with the help of the 3-D c-edge Constraint Managers are still there. 
Change some of the data. Take over sketch. 

 Again, select the “Process Sketch” function in the feature log. Delete all constraints of the 
active part. If you have made too many modifications already, load the drawing you saved in 
the 3rd step. Allocate the variables H1 and D0 with the help of the 3-D c-edge Constraint 
Managers. The inner diameter is always 1.25-times the internal thread diameter D0. Do not 
use any new names for variables for the inner diameter, but D0*1.25. 

 Load the automatic data back-up of your drawing. The file is named hicad_N1 and can be 
found on the local hard disc in the hicad / temp directory. N represents the number of the 
drawing in which you are working. If you work in the third drawing, its data back-up is 
named hicad_31. Important: In the current version you need to switch the file extension to 
„.SZN“ in the “File type“ field type at the bottom.   

 Tip 1: We learned how to change parts via parameter dimensions in the previous exercise. 
We modified the workpiece via the corresponding sketch in this exercise. We changed the 
lines directly in the sketch for the first modification. In the second step, we changed the 
sketch with the help of the 3-D C-edge Constraint Manager. In the third step, we allocated 
variable names in the 3-D C-edge Constraint Manager, to create dependencies between dif-
ferent dimensions. 

 Tip 2: The function “Load sketch” in the “Feature” tab of the ICN allows the loading of the 
sketch belonging to the active part. You will get a copy of the sketch that has nothing to do 
with the original processing any more. Thus you can apply this sketch to other parts as well 
to create extruded solids, revolved solids, recesses or butt-joints. Example: You need the 
same recess for two different parts, and a butt-joint with identical contour for a third part.  

 Space for notes:  
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41 Processing Planes and Subtractions 
41.1 3-D Processing Plane 
When deriving 3-D parts from sketches (e.g. creating extruded solids or subtractions), you often 
create your sketch in the screen plane: You choose front, side or top view and then select, e.g. 
the Extruded solid function. The processing plane will then automatically be located in the 
front, side or top view etc. You can however also create and process sketches directly in the 
axonometric view by defining processing planes. The drawing plane will be placed into the se-
lected processing plane.  

You can define several processing planes, only one of which can however be active. The active 
processing plane is highlighted by a green frame, all other processing planes have a dark red 
frame. 

 

Add cuboid in processing plane

Subtract cylinder (bore) in processing plane

 
 

Fig. 101  Working with processing planes: Examples  

 
The function for processing planes can be found on the transparent toolbar. Left-click to activate 
the Surface-Edge-Point function, right-click to activate the context menu for processing planes. 
The context menu is also activated if you right-click an already existing processing plane.  
 

In most cases you define a processing plane via 2 edges. Please note that the first selected line 
is the future X-axis, the second line the future Y-axis. You normally want the X-axis in the proc-
essing plane to be horizontal and running from left to right. Therefore look vertically at the 
surface and select from this viewing direction a horizontal line in the left half. The future X-axis 
will then run horizontally from left to right. Again, look vertically at the surface and select a verti-
cal line in the lower half.  The future Y-axis will then run from bottom to top.  

Almost all 3-D functions refer to the currently active coordinate system (e.g. direction of a mate-
rial subtraction, direction of a text etc.). For all of the approximately 30 functions prompting you 
to specify surfaces, please therefore note the following: First select for the X-direction a horizon-
tal line on the left, then select for the Y-direction a vertical line in the lower half.  
 

41.1.1 Plane Functions 
The previous paragraph explained how to define a processing plane prior to calling a function 
such as Extruded solid, or Add/Subtract part. But even if you have already called one of these 
functions and HiCAD has already created a sketch, you can still change the plane in which the 
sketch is located (please note however that the sketch must not contain any line elements). To 
do this, activate the Sketch tab and select New > New plane….  

 

Sketches; 
also see 

Online help 

Processing 
planes; also 
see Online 

Help 

 

 

 



                                                        Processing Planes and Subtractions 

HiCAD  3-D Training  135 

41.2 Subtraction 
In the Subtraction function group of the 3-D Standard tab, you will find the functions Subtract 
part, via translation, Subtract part, with translation+ depth and Subtract part, via rotation.  

 

 
Fig. 102  3-D Standard tab, Subtraction function group 
 

The Subtract part, via translation function (black rectangle) creates a material subtraction 
running through the entire part.  

The Subtract part, with translation+ depth (dashed rectangle) creates a material subtraction 
with a limited depth (e.g. blind holes).  

Subtractions are based on existing or newly created sketches, the polyline of which runs com-
pletely through the part or penetrates it with a specified depth. 

The part created by the subtraction is the difference between the active 3-D part and the ex-
truded solid derived from the sketch. The name of the 3-D part is retained as part name.  
 

 
Fig. 103  Input window for the Subtract part, with translation function 



Processing Planes and Subtractions 

136                                                                                                                                        HiCAD  3-D Training 

To create a subtraction with translation and limited depth, proceed as follows: 
 Select the Subtract part, with translation+ depth function (dashed line in the upper image 

on page 135). 
 If you want to create the subtraction with draught (inclination), enter the inclination angle in 

the Draught field. The position of the draught is influenced by the mathematical sign (posi-
tive or negative value).   

 Select the type of height definition, e.g. in the –Z-direction field. Example: If you select 
Value, you can enter a value for the depth of the translation.  If you select To surface, you 
can specify a surface until which the subtraction will extend. If you select the Dynamic 
depth specification, left-click on the drawing area, drag the cursor to the required position, 
and left-click again (RET). HiCAD shows you the depth specified by the cursor position. If 
required, you can correct this value.   

 If you selected Value, enter the subtraction depth.  
 If you want to use an already existing sketch, click the Select sketch button and identify the 

sketch. 
 To create a new sketch, click the Create new sketch button.  HiCAD then activates the 

Sketch tab. Create the required sketch.  
 Click Preview, then click Apply to execute the subtraction.   

 

The position of the subtraction is determined by the position of the sketch – see the graphics 
below.  

 
Fig. 104  Insert subtraction 

 

 
Fig. 105  Position of subtraction 
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42 Dimensionings 
42.1 Sheet Views 
The view structure of the current drawing is shown in the Views tab of the upper ICN window. 
HiCAD distinguishes between 

 Model views and 
 Sheet view. 

In the views of the Sheet area you can create and name your production drawings and dimen-
sion the parts.   

To activate an area or a view, simply move the mouse pointer onto the corresponding item in 
the ICN and left-click. The name of the view is displayed red.  

To process a view, move the mouse pointer on the corresponding item in the ICN and right-
click. Now you can select the required processing function in the context menu.  

If the Views tab is open and a view is still active, information on this view is displayed on the 
Properties tab of the lower ICN window.   

When dimensioning a part, you always activate (besides the part) the sheet view. Further de-
tails on model views and sheet views are provided in Chapter 43 of this training book.  

 

42.2 3-D Dimensionings 
Functions for 3-D dimensioning and texts can be found in the 3-D Dimensioning tab.   

You can also activate the tab by double-clicking already existing 3-D dimensions or texts.  

 

42.2.1 General Notes on Dimensionings 
To insert 3-D dimensionings, activate (besides the sheet view) the part you want to dimension 
and use the appropriate dimensioning, symbol or text functions. Dimensions, texts, symbols 
etc. are always assigned to the active part.  
 

To process a dimensioning, move the cursor on the required dimensioning and press the right 
mouse button. 

The 3-D dimensioning is applied to the XY-plane of the currently active coordinate system.   

If you want to choose a different plane than the XY-plane, right-click after specifying the 2nd di-
mensioning point. You can then select a different dimensioning plane.   

It is also possible to define a processing plane (= new XY-plane) before setting dimensionings 
or texts.  
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The next paragraph provides a description of the functions for axially parallel and angular di-
mensions:  

 

42.2.2 Linear Dimensions, Axially Parallel 
Use the functions of the Parallel function group to create axially parallel dimensionings. These 
will retain their position in case of transformations of the part (i.e. a rotation).  This means that 
they will still be axially parallel even if a 30° rotation is performed on the part (which will not be 
the case if you use the Linear dimensions, free function instead).  

Further functions are contained in the Others pull-down menu (small blue arrow): 
 

 
Fig. 106  The Parallel function group 

 

All types of dimensioning require the identification of two edges or points. These can be arbi-
trary edges or points in the drawing.  For instance, these points need not necessarily be end 
points of an edge and can also belong to different parts.  

Dimension figure position 

A third point must be specified for the position of the dimension figure. In this mode you have 
the following input options:  

 Switch dimensioning plane  

Before specifying the position of the dimension figure, you can switch the dimensioning plane if 
required. If you do not want to use the dimensioning plane suggested by HiCAD, press the right 
mouse button (if the suggested dimensioning plane is correct, you can directly move on to the 
next paragraph Position the dimension line or dimension figure). You can then, for example, 
select the following option:  

        Switch to ZX-plane  
 

After selecting the ZX-plane, the dialogue for dimension line positioning is continued.  
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 Position the dimension line or (RMB) dimension figure  

Left-click the point where you want to place the dimension line. If you also want to position the 
dimension figure, right-click to open a context menu offering various options for this: 

  
Fig. 107  Move dimension FIGURE 

 Selection of a reference line  

Instead of using the point selection option described above, you can also select the dimen-
sion line of another dimensioning with a left-click. This reference dimension is then 
highlighted in pink.  Your new dimensioning will then appear at the same height as the refer-
ence dimension.  

The following image shows dimensionings in three different planes:  
 

XY-plane of drawing CS

XZ-plane of drawing CS

YZ-plane of drawing CS  
Fig. 108  Dimensioning in different planes 
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Now let us take a look at the Create new chain dimension and Create new parallel dimen-
sion from the Parallel  function group.  

Detailed descriptions of all further functions can be found in the Online Help.  

 

42.2.2.1 Create New Chain Dimension 
Use this function to create a chain dimension, i.e. a group of dimensions in which two consecu-
tive sub-dimensions have one common dimension point.  

Identify the object you want to dimension, and the position of the dimension line. Then specify 
the following points.  

You can refine chain dimension by inserting intermediate points, or you can delete individual 
sub-dimensions. The length of the individual dimension lines is automatically corrected.  

 

 
Fig. 109  Chain dimensions   

 
42.2.2.2 Create New Parallel Dimension 
Use this function to create a parallel dimension, i.e. a group of dimensions have the same start 
point and the dimension lines of the sub-dimensions a fixed distance from each other.  

Identify the object you want to dimension, and the position of the dimension line. Then specify 
the following points.  

You can refine chain dimension by inserting intermediate points, or you can delete individual 
sub-dimensions. The length of the individual dimension lines is automatically corrected.  

 

 
Fig. 110  Parallel dimensions 

See 
Online 
Help 
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42.2.3 Angular Dimensions 
Use the functions of the Angle function group to create angular dimensions.   

Further functions ate contained in the Others pull-down menu of the function group (small blue 
arrow).  

 

 
Fig. 111  The Angle function group 

 

The legs of the angle you want to dimension can be specified by identifying two edges, specify-
ing start and end point of the two lines, or selecting 2 surfaces.   
 

For dimension line positioning, HiCAD prompts you to specify another point. As for the previ-
ously described linear dimensions, you have the option to right-click and open a context menu. 
Here you will find various options to move dimension lines and dimension figures, or allow an-
gles greater than 180 degrees.  
 
42.2.3.1 Create New Angular Dimension 
Use this function to dimension angle between 2 edges.  

Identify the two legs and define the position of the dimension line. If you also want to change the 
position of the dimension figure or allow angles greater than 180°, right-click to open a context 
menu after selecting the two legs. 

 

 
Fig. 112  2 edges/individual dimension 
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42.2.3.2 X-Axis, Y-Axis, Z-Axis 
Use these functions to dimension angles between an edge and the X-, Y- or Z-axis.  

Identify the leg. The second leg is automatically the X-, Y- or Z-axis. Then specify the position of 
the dimension figure.  

 

x

Z
Y

 
Fig. 113  3-D Angular dimension, line to Y-axis 

 

42.2.4 Permanent Saving of Dimensioning Settings 
The functions shown in the closed black rectangles enable you to change the settings for 3-D 
dimensions, parametric dimensions, HCM dimensions and Steel Engineering dimensions.  
These settings will then apply until you shut down HiCAD.  If you want to save these settings 
permanently, additionally select the Save parameters function in the dashed rectangle. This 
function enables you to save your changes to the DIMENSIONING_SETTINGS.XML file. The 
settings will then be automatically preset when starting HiCAD.  

 
Fig. 114  3-D Dimensioning parameters 

 

If you need to create commissioned drawings for different customers requiring different dimen-
sioning settings, you can use the Save parameters to save the changes to files with different 
names (e.g. DIMENSIONING_SETTINGS1.XML, DIMENSIONING_SETTINGS2.XML etc.). 
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Before creating a drawing, you can then use the Load parameters function to select the di-
mensioning settings that you need.  

Another option to permanently change dimensioning settings is provided by the Settings func-
tion (icon at the top right corner). Click the icon and select Settings > Basic Settings > 
Dimensioning.  

Further detailed information on all dimensioning functions can be found in the Online Help.  
 

Before dimensioning, please activate the part you want to dimension and a view of the sheet 
area.  
 

42.3 Further Permanent Changes 
The previous paragraph explained how to permanently save changes to dimensions. Now let us 
see how to change other settings permanently.   

42.3.1 Permanent Changes from HiCAD 
Many settings can be changed permanently via the Settings > Settings (function at the top 
right corner of the screen). 

 

Fig. 115  Permanent changes 
 

42.3.2 Permanent Settings in System Files 
 

Most system files (with the exception of HICAD/EXE/FILEGRUP.DAT) can be found in the 
HICAD/SYS directory.  Although the majority of the system files are only of interest for software 
developers, there are also some files which can also be changed by CAD users, e.g. the follow-
ing files:   

 

System file Some exemplary applica-
tions 

ALGPAR.DAT Which point options do you 
want to be displayed when 
working on a 2-D or 3-D part? 

At what intervals (minutes) do 
you want HiCAD to automati-
cally save your drawing? 

FILEGRUP.DAT Definition of the logical paths 
, e.g. of the default path “C:“, 
to which all drawings, parts, 
part libraries etc. are saved.  

 

 

 

Changes applied in system files or via Settings > Settings are always permanent changes. 
This means that they cannot be revoked with any default function or a re-start of HiCAD.  
Therefore, please make sure that the changes you want to apply are actually useful and keep a 
record of these changes in case you want to revoke them.                                                              



Dimensionings 

144                                                                                                                                        HiCAD  3-D Training 

42.4 Exercise 6 (3D-GL-06.0) Bore Block 
 Learning target: Subtractions; 3-D dimensioning. 
 Switch to the front view. Draw a sketch. As you are in front view, the processing plane is the 

XZ-plane. You can change into any other view while drawing the contour of the bore block. 
Draw the fillets and chamfers as well as the bore, but not the subtraction with a depth of 
20mm. If you want to parameterise the sketch, it makes sense to add fillets or chamfers af-
ter creating the extruded solid. This procedure has the advantage that you can fully 
parameterise the drawing with a fairly moderate number of constraints.  If the sketch already 
contains fillets, chamfers etc., very many constraints may be required until the sketch is fully 
parameterised.  Create the bore block as an extruded solid from the sketch.   

 Create the subtractions. A processing plane is defined by two lines. Please remember that 
the first line is the future X-axis and the second line the future Y-axis. You should therefore 
choose a horizontal line in the left half and then a vertical line in the lower half. 

 Dimension the part. Activate the Sheet area (for more information see next exercise). De-
fault dimensioning is in the active XY-plane. Use the right mouse button if you want to 
dimension in the XZ-plane. 

 Space for notes:  
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43 Sheet Views and Model Views 
The view structure of the current drawing is displayed on the Views tab of the Information  + 
Communication Navigator (ICN), with HiCAD distinguishing between  

 Model views and 
 Sheet views. 

 
Fig. 116  Arbitrary switching between model views and sheet views 

In the Sheet area you can create and name your production drawings. You can then switch to 
the Model area to process your 3-D model. The position of the views in the Sheet area will not 
be altered by adding views in the Model area. Changes of the geometry are automatically ad-
justed in the sheet area, thus enabling you to arbitrarily switch between model and production 
view.   

To activate a view, move the mouse pointer on an item in the ICN or on the pink dotted rectan-
gle around a drawing and press the left mouse button.  

If you activate a view in the Views tab, the Properties tab of the lower ICN window provides 
information on the selected view. If you have selected the view with a single mouse-click, the 
information is displayed only temporarily, if you have double-clicked the view, the information is 
displayed permanently.  

It is possible to create several sheet areas (right-click Sheet, then select Sheet area, New). 
This enables you to distinguish between proposal drawings, production drawings, approval 
drawings, customer drawings etc. by creating each of them in a separate sheet area. When 
processing a part in the model area (or in any of the sheet areas) the part is automatically ad-
justed in all sheet areas.  

 When dimensioning a part, always activate the Sheet area (and, of course, also the part). 
 Please note that before printing you need to select the Sectional/Detail View > Update, All 

function once. You will find this function if you right-click a view in the drawing area (pink 
dotted rectangle) and select Process > Others. The sectional views and detail views are 
then also updated. 
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44 Copy Dimensions to Other Views 
In HiCAD you can create dimension-comprehensive dimensionings. Especially for complex 
drawings it makes sense to initially set the dimensionings in a particularly clearly structured and 
easy-to-understand view (e.g. a list view), and the copy these dimensioning to another view.   
Or you can create your dimensionings in the (also very clearly structured) axonometric view and 
copy them automatically to top, side or front view. 
 

44.1 Show/Hide Dimensions 
Activate the 3-D Dimensioning and select Tools > Table. Click the arrow symbol below table 
and select the Visualisation, Show dimensions/Hide dimensions function.  
 

Visualisation – Show Dimensions 
First select which dimensions you want to be displayed:  

 Individually, i.e. you identify individual dimensions. 

   Structure, i.e. you select a structured dimension (chain/parallel/running dimension etc.) 

   Rectangle, i.e. you select the dimensions with a drawn rectangle 

 All in part, i.e. all parts of the active part are considered 

 All, i.e. all parts of the active drawing are considered.  
 
Show in ... 
After specifying the dimensions to be shown you are prompted to specify the view in which the 
selected dimensions are to be shown:  
 

 Active view 
The selected dimensionings are only displayed in the active view. 

 Identified view 
Identify the view in which you want to display the dimensions. 

 All views 
The dimensionings are displayed in all views. 

 All but active view 
The dimensionings are displayed in all views, except the active view.   

 All but identified view  
Identify the view in which the dimensioning are not to be displayed. 

  
 

Visualisation – Hide Dimensions  
Use this function to hide dimensions. The procedure is the same as for the Visualisation, 
Show dimensions function.  
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44.2 Exercise 7 (3D-GL-07.0) Connecting Piece 
 Learning target: Extruded solid; standard processings; select views and not only parts and 

drawings with the right mouse button; transfer dimensions automatically to other views; 
model and sheet views. 

 Switch to the front view. Draw the connecting piece as an extruded solid. As you are in front 
view, the processing plane is the XZ plane. You can change into any other view while draw-
ing the contour of the connecting piece. 

 Use the Standard Processings functions for the through hole and the slot.  
 Call the “Views” tab in the ICN. Activate the Sheet area first! Create 4 views and insert the 

drawing frame. 
 Select different visualisations for the four views. Activate the view with the right mouse but-

ton (context menu). In this case you do not need to activate the view first. 
 Dimension the standard axonometry only. Transfer the dimensionings to the other three 

views automatically using the “Show dimensioning” function. Remove the dimensioning from 
the Sheet area and the standard axonometry with the “Hide dimensioning” function. When 
you select Hide you remove the dimensioning from the active view only.  

 Activate a view in the Model area. Change the views there and execute an optional process 
(e.g. a chamfer). Then activate the Sheet area. You will see that the process has been 
taken over into all four views, but that the type and position of the views has been main-
tained. 

 Hint: You are enabled to create and name production views in the Sheet area. Switch to the 
Model area to process and model the 3-D model. The advantage of the Model area is that 
all views, cuttings and drawing frames are hidden. Processing is thus faster and more effi-
cient. You are also enabled to rotate the views of the part in the model without any 
repercussions on the production views in the Sheet area. In addition, the creation of several 
Sheet areas, e.g. for quotation drawings or production drawings, would be possible as well. 

 Space for notes:  
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45 Sectional Views 
45.1 Sectional View 

 
The New sectional view function can be found in the New function group 
of the Views tab. You use this function to create sectional views, either 
with or without identification of the section path, while the parts themselves 
remain unchanged. You define the section path by a sketch that either 
already exists in the drawing or is newly created when defining the sec-
tional view.   

Besides creating “normal” sectional views you can also create “unfolded” 
sectional views, i.e. all sectional views are unfolded into a common plane. 
This makes sense if, for example, you want to represent the internal sides 
of revolved solids, pipes etc. Non-unfolded sectional views can also be 
laterally limited, so that the intersection body will not entirely penetrate the 
drawing.  
The following combinations are possible:  
 

  With parts in background 
  Only section plane 
  Unfolded 

The view is displayed as a 
solid. 

  With parts in background 
 Only section plane 
  Unfolded 

 

A sectional view is created 
in which only the section 
surface is displayed. 

  With parts in background 
  Only section plane 
  Unfolded 

All section planes are ex-
panded into a common 
plane. The view is dis-
played as a solid. 

  With parts in background 
  Only section plane 
  Unfolded 

All section planes are ex-
panded into a common 
plane, but only the section 
surface is displayed. 

In addition, you can restrict non-expanded sectional views laterally.  

 To do this, activate the Limited  option.  

 

 

Please note: 

 In contrast to virtually all other HiCAD functions, we draw the section path as an open poly-
line, and not as a closed polyline.  

 Before creating a section you should activate the sheet views. In this way the clear structure 
of the model area is retained.  

 Sectional views are not suitable as processing and modelling views.  
 For sectional views, only parts are considered whose sectional view ID is set to "Cut, In 

sectional view". To access this function, right-click a part and select Properties > Cut…. 
 If you want to assign a material with a corresponding hatching to a part before creating the 

sectional view, HiCAD will use this hatching for sectional and detail views. If you change the 
hatching at a later time, you need to update the sectional/detail view.  

 
 
 

 

Fig. 117  Sectional view  
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45.2 Examples 
The left image shows the original view with the sketch for the section path. The right image 
shows different variants of the sectional view (here: not unfolded). 

 

 

 

 

 
 

 

 

 

 

Fig. 118  Original situation 

 
        

           

                                                              

                                                                              Fig. 119  Sectional views  (not unfolded) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 120  Limited sectional views                                               Fig. 121 Unfolded sectional view 

 
 Further information on sectional views is provided in the Online Help. Besides sectional 

views, there are also detail views and cut-outs. The detail views are explained in the 
“Create Detail View” chapter of this training book.   

 Before printing you need to select the “Sectional/Detail view > Update, All” function. In con-
trast to standard views, sectional and detail views are not updated automatically.   

 

Top view with 
section path

Top view with fold designation Sectional view

Line of vision

Axonomteric view of
3-D model

Original with sketch Sectional view without limitation

Limited sectional views

Sketch for limitation

 

active view active view

active viewactive view

sectional viewsectional view

sectional view sectional view

section path and caption A-Awithout section path and caption

setcion path and fold designation with section path, without caption

active view
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46 Assign 2-D Parts to 3-D Views 
3-D drawings can also contain 2-D parts.  These can, for example, be a bill of materials, a toler-
ance table or a part containing processing notes as 2-D text etc.  

If you do not want to see this part in the model area, you can assign the part in the middle ICN 
window (2D-Part structure) to the sheet area. Please note that in middle window you can only 
see the views of the area which is active in the upper ICN window. This means that if a view of 
the sheet area is active in the upper ICN window (see next image), you will see the part “2-D 
sheet” (and not the part “3-D model”) in the middle ICN window (2D-Part structure tab) as well.  

Example: You have created a 2-D part “Processing notes” that you want to see in the sheet 
area only. Proceed as follows:  

 In the top window of the ICN, activate a view of the Sheet area.  

 
Fig. 122 Active view in SHEET area 

 

 Move the cursor into the drawing area to enable the display in the ICN to be updated! 
 In the 2D-Part structure tab, the part “2-D sheet” is displayed. Move the part “Processing 

notes” below this sub-part. The result is shown below:  

 
Fig. 123  2-D part “Processing notes” below the part “2-D sheet” 
 

In the same way, you can assign other 2-D parts to the views of the Sheet area.  

For many parts such as fits tables, dimensioning tables, coordinate tables etc. HiCAD automati-
cally ensures that these parts are only visible in the Sheet area (and not in the Model area). 

Please note: If you do not want a 2-D part to be visible in all views, but only in one particular 
view, e.g. in Eng. Axonometry 2, you can also move the 2-D part under “2-D part” below “Eng. 
Axonometry 2”. The result looks as follows:  

 
Fig. 124  The 2-D part “Processing notes” is moved below “Eng. Axonometry 2”. 
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47  Referencing  
Referencing parts is the most efficient method for re-using parts. Referenced parts can be used 
and processed company-wide and project-comprehensive. The 3-D body that represents this 
part is not closely integrated into the model, but only added when the model is created in the 
current state.   

Referencing of parts has the following advantages: 
 Frequently required company-specific parts can be managed and changed much more ef-

fectively from a constructive perspective if they are referenced. The major advantage of this 
technique is that parts or assemblies can be processed and updated by a team. 

 If a drawing contains referenced parts, the system checks automatically to see whether they 
exist in changed form. Changed parts are automatically updated, if required. Even when a 
drawing is saved, only the parts that have been changed are saved again. This ensures 
high speed even for complex drawings.  

 If the HELiOS database is being used, referenced parts are blocked for other users while 
they are being processed. Only when the part has been released again are automatic up-
date and other changes possible. 

 Application possibilities for referenced parts include changing and managing company-
specific standard parts as well as construction unit systems. 

 

47.1 Reference 3-D Part 
Use the Reference part, Save, Detail drawing function to reference 3-D parts. Select the set-
tings shown below:  

 
Fig. 125  Reference 3-D part 

After confirming with Continue you complete the document master data mask for the part. Hi-
CAD saves the part to the database and converts it to a referenced part. Of course, you can 
also reference a part when creating it.  

 

47.2 Break Up Referencing 
On the Drawing tab, select Drawing/Reference > Others > Break up ref., individual to break 
up the referencing of the part (i.e. if the part is meant to be a custom part).  

Extensive information on referencing is provided in the Online Help.  
See 
Online 
Help 
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47.3 Exercise 8 (3D-GL-08.0) Ball-Shaped Head 
 Learning target: Referencing, sectional views, allocate 2-D parts to a 3-D view. 
 Draw a cylinder and reference the part.  
 Specify 3 points to define a processing plane in the MIDDLE of the cylinder. Make sure that 

the first 2 points define the future X-direction and the third point the future y-direction of the 
coordinate system.   

 Create the ball-shaped head with the “Add sweep, via Rotation“ function.  
 Create the 10mm gap as well as the two flattenings at the sides with “Subtract part, via 

Translation” in the front view. 
 Create the width across flat in the side view with “Subtract part, via Translation”. 
 Use the standard subtraction function and not the Standard Processings for the 10mm bore. 

In this case we do not need to delete the centre cross of the bore when adding the centre 
cross of the ball-shaped head. 

 Add all necessary crosshairs and centre crosses at the ball-shaped head. 
 Assign a Material to the part and create the sectional view (activate Sheet area first) and 

translate it if necessary.   
 Hint: If you assign a material to the part before creating the sectional view, HiCAD will use 

this material hatching for the sectional view (as well as for the detail views).  If you assign 
the material to the part afterwards, you are enabled to update the sectional and detail 
views.  

 If you want to omit the “Gland follower” exercise to save time: Create (also in the Sheet 
area) a detail view and a cut-out view (not shown in the exercise on the right page).  

 Add the drawing frame to the Sheet area as well.  
 Copy the ball-shaped head into another drawing. Change the part in one of the two draw-

ings. Then switch to the other drawing to see how the ball-shaped head has, due to the 
referencing, changed in the other drawing as well. 

 Create a 2-D part and enter into this part some notes for processing of the ball-shaped 
head. Then translate the 2-D part in such a way that the text will only be visible if a Sheet 
area and not a Model area will be active. Please note: The part “2-D Sheet” is only dis-
played in the middle window of the ICN if (in the upper window of the ICN) a view of the 
Sheet area and not the Model area is active. Please check by activating the individual views 
that the processing notes are only shown in the views of the Sheet area. 

 Hint: In the same way you can make sure that a fits table, a Bill of Materials or any other 2-
D part is only visible in the Sheet area, but not in the Model area.  

 Space for notes:  
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48 Add Sweeps / Standard Processings 
48.1 Add Sweep, via Translation 
 

Use this function to attach an extruded solid (sweep) to the active 
part, i.e. no second part is created that we would have to merge 
with Boolean operations.  

The extruded solid is created with the help of a sketch. This sketch 
can either already exist in the drawing or needs to be created.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

Fig. 126  The input window for the Add sweep, with translation function 
 

Proceed as follows: 

 Select the Add sweep, via translation function.  

 If you want to create the part with a Draught (inclination), enter the inclination angle. The 
position of the draught is influenced by the mathematical sign (positive or negative value). 

 Specify the settings for the extrusion, which is done in the same way as for the previously 
described Subtract part, via translation function. 

 If you want to use an existing sketch, click the Select sketch button and identify the sketch.  

To create a new sketch, select the Create new sketch button. HiCAD switches to the 
Sketch tab, enabling you to create the required sketch.  

 Click the Preview button to display the result. If you activated the Value option instead of 
the Dynamic option, select Preview or Add, left-click into the drawing area, drag the cursor 
to the required position and left-click again (RET). The height specified by the cursor posi-
tion is displayed for your information. You can correct this value if desired.   

 Click Apply to add the part.   
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Ausgangsteil mit Skizze  
Fig. 127  Add sweep, via translation 
 

Proceed likewise for the Add sweep, via rotation function.  
 

48.2 Standard Processings 
The Standard Processings function group of the 3-D Standard tab offers many different types 
of standard processings, e.g. Through holes, Slots and Blind holes.  
 

48.2.1 Variable Blind Hole 
Use this function to insert blind holes into parts.  

The current standard settings are considered. If required, the Settings window is displayed.  

Identify the surface to which you want to apply the bore, by selecting 2 edges. Please note the 
hints given at the bottom of this page.  

Enter diameter, bore depth and point angle. 

 
Enter the point where you want the blind hole to begin. The point option R(RET) is frequently 
used for this.  

 
Fig. 128  Blind hole 

This function, too, requires the selection of a surface. Please note that when selecting the first 
line, you also set the direction of the future X-axis, and when selecting the second line, you set 
the direction of the future Y-axis. Therefore first select (view direction: vertical at surface) a 
horizontal line in the left half, then a vertical line in the lower half. Alternative: Select the bottom 
left corner to select a surface. Please note that the cursor needs to be placed in the vicinity of 
the future X-axis.  
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48.3 Exercise 9 (3D-GL-09.0) Clamp 
 Omit this exercise if there is not enough time. 
 Learning target: Add; subtract. 
 Change to the front view and draw the 15 mm thick part of the clamp as an extruded solid. 
 Use the “Add sweep, via translation” function for the feet with a depth of 3 mm and the head 

with a depth of 30 mm,  
 Use the Standard Processings for both bores.  
 Create the R27 fillet with “Subtract part, via Translation” in the side view (draw closed con-

tour with R27 circular arc). 
 Create the sectional view. Activate the Sheet area first! 
 When dimensioning, do not only activate the part, but also the view you want to dimension. 

Activate a view in the Sheet area, in order that the view of the Model area will remain free 
from dimensionings!  

Hint: If you activate the drawing in the view in which you want to dimension the part, you 
automatically also activate the view as well.  

 Space for notes: 
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49 Views 
49.1 Create Detail View 
 

The New detail view function can be found in the New function group of 
the Views tab. Use this function to display enlarged details of your draw-
ing. The detail is created with the help of a sketch. This sketch can either 
already exist in the drawing or needs to be created.   

Proceed as follows:  
 Activate a view of the sheet area.  
 Select the New detail view function. 
 Select Create new sketch if you want to draw a new contour for the 

detail.  
 Draw a closed contour.  
 An enlarging scale, an ID letter, the marking of the detail location and 

the hatching type are already suggested by HiCAD. You can change 
these values if required.   

 After selecting the Create function you can position the detail view in 
your drawing.  

 

If you right-click the marking of the detail location (e.g. ellipse), you are 
enabled to change all parameters of the detail view, and also the path of 
the detail view contour at any time.   

 

 

 
Fig. 129  Detail view 

 

Detail views are not suitable as processing and modelling views. A detailed description of the 
New detail view function is provided in the Online Help.  
 

Original view with sketch

Original view after definition of 
detail view, with identification of 
the detail (here: elliptical)

Detail view with caption

 
Fig. 130 Example of a detail view 

 

 
 



                                                        Views 

HiCAD  3-D Training  161 

49.2 Shorten View 
The Shortened view function can be found in the Process function group (left of Transform) of 
the Views tab. You can also access this function by right-clicking the view (pink dotted frame) in 
the drawing area and selecting the appropriate function from the context menu. The latter way 
is the better one, as it automatically also activates the view. In the Shortened view dialogue, 
click the Add button and specify the start and end point of the axis, and set the division points of 
the shortening(s).  Click Create to end the function.  

Start Point

End Point

Division point

Division point

Shortened view

 
Fig. 131  Definition of a shortened view 
 

Please note that all view representations beginning with “Quick“, as well as all shaded repre-
sentations are time-saving approximation procedures, which are, for instance, unsuitable for the 
representation shortened views. Use “Hidden Line” instead of “Quick Hidden Line” if you want to 
create a shortened view.  
 

49.2.1 Delete Shortened View 
The Delete shortened view can also be found in the Process function group. It enables you to 
revoke the shortening.  
 

49.3 Surface in Screen Plane 
In the context menu of the view you will find the Surface in screen plane function. Use this 
function to rotate arbitrarily located planar surfaces into the screen plane. You will then look at 
this surface in vertical direction. You have now the following options to identify the surface:  
 

  Identification of 2 edges                     Specification of 3 points 
 

In the figure shown below, a blind hole is inserted into the surface F1:  
View 1
Axonometric 2

View 2
Surface on picture plane

Specifiy surface by identifying two edges:
(1) identify edge 1 near P1
(2) identify edge 2 near P2

P1

S1

P1

(1)

(2)P2

P2

x

x

y

y

z

z  
Fig. 132  Surface in screen plane 
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49.4 Exercise 10 (3D-GL-10.0) Gland Follower 
 Learning target: Chamfer; fillet; axis representation; detail view; clip plane (shaded); shorten 

view; accuracy of representation of filleted surfaces. 
 Create the 18mm thick plate of the gland follower as an extruded solid.  
 Draw the Ø70 cylinder with “Add sweep, via translation” or (simpler) as a hollow cylinder. 

Merge the hollow cylinder with the extruded solid. 
 The groove can be created with the “Subtract part, via Translation” or “Subtract part, via 

Rotation” function.  
 Add the standard processings, chamfers, fillets etc. 
 Axis representations can be found in the “Tools” function group of the “3-D Standard” tab. 
 Create the sectional view in the Sheet area! 
 Translate the views by right-clicking them and selecting the appropriate function (automati-

cally activates the view you want to translate).  
 Activate one of the views in the Sheet area. Create detail views (not given in the drawing).  
 Familiarise yourself with the functions “Clip plane (shaded)“, “Shorten View” and “Surface 

on screen plane”. 
 Tip: The accuracy of the display of the filleted surface can be set via “Drawing” / “Proper-

ties” / “Others” / “Surface approximation”.  
 Space for notes:  
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50 Shafts, Shaft Processings and Cut-Outs 
50.1 Shaft Processing 
Activate the 3-D Standard tab and select Standard Processings > Others > Feather key-
ways. The feather keyway is one of the many shaft processings offered by HiCAD. 

Set a processing plane on the shaft shoulder:  
 

 

Fig. 133 Processing plane on barrel surface of shaft shoulder 
 

Select the Feather keyways function. 

 
Fig. 134  Feather keyway DIN 6885-1 N1 
 

Use the Relative-Return option to insert the feather keyway, then move a distance equivalent to 
half of the feather keyway width to the right (the fitting point is located in the centre of the 
feather keyway).  
 

 
Fig. 135 Shaft with feather keyway 
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50.2 Cut-outs 
Select the Create new cut-out function in the Process function group (left of View functions) 
on the Views tab.  

Proceed as follows:  

 Identify or draw (as for the sectional views) the sketch for 
the cut-out contour. Please make sure that the sketch is 
closed.  

 Specify the point for the cut-out bottom. Click Select point 
and determine the point in the drawing.  

 If you want to hatch the section planes, activate the With 
hatching checkbox and select the hatching data.   

 Check the cut-out with the Preview button. If required, you 
can switch the direction of the cut-out by activat-
ing/deactivating the Reverse direction checkbox.  

 Click Create to generate the cut-out with the current set-
tings.  

 
 

 

 

 

 

 

 

 
 

 
Fig. 136  Cut-out 
 
 

 
Fig. 137  Create cut-out                                                                          Fig. 138  Reverse cut-out direction 

Aktive Ansicht 

Erzeugter Ausbruch

Skizze

Ausbruchboden

Ausbruch

Ausbruch in
umgekehrter Richtung
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50.3 Exercise 11 (3D-GL-11.0) Shaft 
 Learning target: Revolved solid; shaft standard parts; subsequent processing options in a 

sketch. 
 Change to the front view and draw the shaft as a revolved solid. 
 Use the centre bores and feather keyways.   
 Activate, in the Sheet area, the view you want to dimension. 
 Insert (in the Sheet area) a tolerance table and a drawing frame. 
 Create a cut-out that makes the centre bore visible (not shown in the drawing). 
 Get familiar with the options to alter a sketch subsequently: Call the “Process Sketch” func-

tion in the feature of the revolved solid. Change the revolved contour arbitrarily in the 
sketch. Execute another modification using the 3-D HiCAD Constraint Manager. 

 Tip: We drew the shaft as a revolved solid and not as an addition of two cylinders. This pro-
vides us with more modification options via “Process Sketch” in the Feature, as well as 
more parameterisation options. Furthermore, we are enabled to see all creation and proc-
essing feature steps at one glance.  

 Space for notes:  
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51 Re-Use 
Re-use speeds up the design process considerably. In almost every company there are parts 
which are largely similar, which would be drawn only once. When you want to use the part 
again, you will simply load it from the first drawing or a different location, such as a catalogue or 
a part library, or a database.  

The loading of parts from another drawing (e.g. via the clipboard) is always possible. The load-
ing from the database, a catalogue or a part library requires a previous saving of the part (or 
assembly)  to these locations.   

 

51.1 HiCAD Clipboard 
You can use, for instance, the HiCAD clipboard to copy parts from one drawing to another:  

In the ICN, activate the part, the assembly or the part list (multiple selection with CTRL and 
SHIFT, as known from Windows applications) that you want to copy from the current drawing to 
another drawing.  

Right-click the part(s) and select the Copy to clipboard function.   

You can then paste the current content of the Clipboard to other drawings. In the ICN of the 
target drawing, right-click the assembly to which you want to assign the content of the clipboard 
as sub-parts, and select the Paste from clipboard function. Select a fitting point on the part 
and specify the position of the fitting point in the drawing.  

If you want to paste the content of the clipboard as main part into the drawing, select in the mid-
dle ICN window the name of the drawing. Please make sure that you selected a 3-D part in the 
3D-Part structure tab (in case of a 2-D part: 2D-Part structure tab). Then choose the Paste 
from clipboard. function.  

 

51.2 Load Part from Drawing 
The functions described in the previous paragraph Clipboard require that you have loaded the 
drawing from you want to re-use any part(s). Now let us take a look at a function for which this 
will not be necessary:  

Activate the Drawing tab and select Insert Part > Others > From drawing, Via document 
master (if you do not have a database, select From drawing, Via Explorer). This function en-
ables you to copy a part from a drawing of your choice to the active drawing.  

First select, via the document master data, the drawing containing the part that you want to 
copy. Then identify the required part in the drawing. Place the part in the active drawing by se-
lecting a fitting point on the part and specifying its position in the drawing.  

 
You can also access the above function by right-clicking the drawing area. 
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51.3 Save Part to Database (or Explorer) 
Re-used parts can be saved to the database.   

Activate the Drawing tab and select Drawing/Reference > Reference part, Save, Detail 
drawing.   

We start from the assumption that we require neither referencing not part masters. Select the 
settings shown below:  

 
Fig. 139  Save parts for re-use to database 
 

Enter the document master data of the part and confirm with OK. 

If you do not have a database, you can also save re-used parts to the Explorer. In the above 
dialogue you would need to select “Without database” instead of “Database, without part mas-
ter”.  

 

51.4 Load Part from Database 
In the Insert part function group of the Drawing tab, select the Insert part, via DB document 
master function. This function enables you to load a part from the part database into the active 
drawing. Select, via the document master data, the part that you want to load (if required, re-
move suggested links). As for drawings, you can set your own filters, sort according to column 
headers etc. Then place the part in your drawing by specifying a fitting point on the part and 
specifying its position in the drawing.  

If you do not have a database, you probably have saved your parts for re-use to the Explorer. 
You can then re-load these parts with the Insert part, via Explorer function.  

 

Parts can only be directly loaded as parts from the database, if they were previously saved to 
the database. The saving of parts to the database is explained in Chapter 51.3 “Save Part to 
Database (or Explorer)” . 
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51.5 Insert From Catalogue 
Use the Insert main part, via Standard Part catalogue in the Insert Part function group of the 
Drawing tab to load parts from a catalogue. Select the required catalogue, then select the re-
quired table. Click the table and select a part. Confirm with OK and position the part in the 
current drawing, by selecting a fitting point on the part and specifying its position in the drawing.   

 

If you want to load a part for re-use from a catalogue, this requires that you have previously 
saved this part to the catalogue. For this purpose you can use the program CATTEDITOR.EXE 
to create your own tables (and also catalogues if required). Please note that user-defined tables 
and catalogues can only be created in the catalogue “Factory standards > Parts and Process-
ings”. As HiCAD provides a vector graphic as preview, parts selected for a preview graphic 
must not be displayed as a surface-representing approximation (i.e. no shaded or Quick* repre-
sentation). For further information on how to save parts to a catalogue please see the relevant 
chapter in the Online Help.  

 

 

51.6 User-Defined Part Library (User Library) 
HiCAD allows the combination of frequently used parts into part libraries. The parts contained in 
that library can then be quickly and conveniently fitted via a pop-up menu.  

 
Fig. 140  The User Library pop-up menu 

 

 

Fig. 141  Example of a part library  
 

 
This function for the creation of user libraries is optionally available as an extension module. 
Existing user libraries can however also be loaded without a licence for this module.  

 

 

See 
Online 
Help 
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51.7 All Re-Use Options at a Glance 
 

Function Application 

1) HiCAD Clipboard Copies one or several parts into the current drawing 
or into a different drawing.  

2) Insert Part > Others > From drawing, Via docu-
ment master 

Loads parts from any drawing. In contrast to the 
clipboard function, this option requires that the 
source drawing (i.e. the drawing from which you 
want to copy the part) must be loaded in HiCAD.  

3) Insert Part > Insert part, via DB document master Enables direct access to the part you want to load. 
In contrast to the “From drawing, Via document 
master” function, this option does not require that 
you know the name of the drawing in which the de-
sired part is located.  The “Insert part, via DB 
document master” function allows only the loading of 
parts which have been previously saved as parts 
with the “Reference, Save, Detail drawing” function.  

4) Insert Part > Insert main part, via Standard Part 
catalogue 

Loads a part from a catalogue. This part needs to 
have been saved with the function “Reference part, 
Save, Detail drawing > Save as part, with catalogue 
entry”.  

Please note that catalogues provide numerous ser-
vice functions (arrange parts into main series, sub-
series, lock parts, and much more).  

5) Insert Part > User Library In addition to the simple insertion option, you are 
provided with preview images, help texts and the-
matical subdivisions into various part libraries.  
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51.8 Exercise 12 (3D-GL-12.0) Bearing Cap 
 Tip: Omit this exercise if there is not enough time. (you can practise the re-use functions in 

one of the following exercises). 
 Learning target: Re-use of parts; Revolved solid; extruded solid; merge parts. 
 Change to the side view and draw the bearing cap as a revolved solid.  
 Create the flange as an extruded solid and create the other two flanges by cloning the part. 

Merge bearing cap and flanges. 
 You can also access the crosshairs for hole patterns via the “Tools” function group of the 

“3-D Standard” tab.  
 For re-use of the part please proceed as follows: 

 Load the bearing cap with the HiCAD clipboard into a new drawing. 

 Load the bearing cap into a new drawing using the function “Insert Part” / “Others” / 
“From drawing, with document master”. 

 Ask your trainer to show you how to create catalogues and tables. Save the bearing cap 
in a catalogue you created, then reload the part from the catalogue. 

 Save the bearing cap as a part in the database, then reload it as a part. 

 Create a parts library file “bearing cap” and enter the bearing cap you have just created 
into this file. 

 Space for notes: 
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52 Align Part to X-, Y- and Z-Axis (Or to Another Part) 
The Move, via fitting points function enables you to move (i.e. translate and rotate) the active 
part. You can access this function by activating the 3-D Standard tab and selecting Transform 
> Others. You can also right-click the part and select this function from the context menu. You 
can use this function to align an obliquely positioned 3-D part parallel to the X-, Y, or Z-axis. 
You can also align a 3-D part parallel to another, arbitrarily positioned 3-D part.   

 Enter 3 fitting point pairs in succession. 
 The fitting points on the part are transformed in the direction of the corresponding fitting 

points of the drawing. The part retains its original dimensions.  

Example: You want to align an obliquely positioned cuboid to a second cuboid, which has in 
turn already been aligned parallel to the X-, Y, and Z-axis (reference cuboid). The two cuboids 
can have different sizes. Select the Move, via fitting points function:  

1st fitting point pair: Specify an arbitrary point on the obliquely positioned cuboid, e.g. the front, 
top, left point. Then select the corresponding comparable point on the reference cuboid, i.e. 
also the front, top, left point.  

2nd fitting point pair: Specify another point on the obliquely positioned cuboid, e.g. the front, top, 
right point. Then select the corresponding comparable point on the reference cuboid, i.e. also 
the front, top, right point. 

3rd fitting point pair: Specify a third point on the obliquely positioned cuboid. This point must be 
located in the same plane as the first two points and must not be located on the same axis as 
these points. Apart from these coordinates, it can be freely selected. You can, for example, se-
lect the back, top, or left point as third point on the obliquely positioned cuboid.  Then select the 
corresponding comparable point on the reference cuboid, i.e. also the back, top, or left point. 

On the next page you will find an example showing you how to align an obliquely positioned 
cylinder to a cuboid which has already been aligned to the X-, Y- and Z-axis. Point 2.1. means: 
2nd  fitting point pair, 1st point. Point options “Centre” and (twice) “Quad point” were used for 
selection of the points on the cylinder. 

Tip: Let us assume that you have an obliquely positioned 3-D part, and that you want to align a 
second part parallel to this first part. This means that the first part would be our reference part. 
In this case, too, proceed as described above. 

 

52.1 Exercise 12.1  (3D-GL-12.1) Align Parts to Coordinate Axes or to 
Other Part 

 Tip: If there is not much time, you trainer should only show you this exercise.  
 Learning target: Align parts parallel to X, Y-, or Z-axis (or to another part). 
 Draw a cuboid or a cylinder and rotate these parts about one or several angles, so that the 

parts are obliquely positioned in space.  
 Draw a reference cuboid which is positioned parallel to the X-, Y-, and Z-axis. This cuboid 

does not need to have the same size as the cuboid from the previous point.   
 Align the obliquely positioned cuboid and cylinder to the reference cuboid. Use the Move, 

via fitting points function for this.  
 Tip: In the same way, we could have aligned a 3-D part  to another, arbitrarily positioned 3-

D workpiece, with this workpiece being the reference part.  
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53 3-D Guidelines 
3-D guidelines are used to create pipes with the 3-D Sketch function, to describe motion paths, 
or – in the Motion simulation extension module – to perform translations along composite 
edges.   

 

53.1 Create 3-D Sketch 
In the New function group of the 3-D Standard tab, you will find the New dummy part function. 
Use this function to create a new 3-D dummy part. You can also activate the Funktion 3-D 
Sketch function in the New function group of the Sketch tab. In the Line fnction group of the 
Sketch tab, you will find the New polyline function, which enables you to draw 3-D polylines. 
To end the creation of the polyline, press the middle mouse button.   

 

53.2 Process C-Edges 
The Process c-edges function can be found in the Others function group of the Sketch tab. It 
You can use this function to trim lines (i.e. shorten them to the next intersection point). If you 
click the arrow on the icon, a pop-up menu with many processing functions, including the Re-
group function: 

 

53.2.1 Regroup 
Use this function to break up and regroup composite edges. This enables you to automatically 
connect composite edges with identical end points.  

You normally change the orientation of c-edges with this function. Furthermore, composite 
edges will be interrupted at “Y” points, i.e. at points where more than two edges intersect.  

Very frequently you use this function to combine optically closed (but in fact still open) compos-
ite edges into polylines which are then actually closed in the internal data structure. 

Example: You have drawn a polyline with 5 lines. You have however selected the New poly-
line function several times. This means that you have in fact created several (poly)lines, but not 
one closed polyline. If you apply the Regroup function, you obtain, also in the internal data 
structure, a closed polyline. If you now use the polyline for the creation of a pipe, you will obtain 
one continuous, uninterrupted pipe.  

 

You can specifically connect two composite edges with the Connect function.  

 

53.3 Fillet/Chamfer Composite Edge 
The Fillet and Chamfer functions on the Sketch tab enable you to fillet or chamfer individual 
corners or entire polylines. 
 

 
Fig. 142  Fillet/chamfer corners 

 

 

 
 

 

 

 



                                                        Pipe Creation 

HiCAD  3-D Training  177 

54 Pipe Creation 
54.1 C-Edge Sweep 

Use the C-edge sweep function to set cross-sections on 3-D 
guidelines. You will find this function in the New functiongroup of 
the 3-D Standard tab.  

The guideline can be a sketch, a 3-D composite edge (“3-D 
sketch”) or a hyperedge. Curved guidelines are also possible.  

The cross-sections need to be sketches. If you activate the Cir-
cular cross-section option, you will require no cross-section.  

Procees as follows:  

 Activate the Hollow checkbox if you want to create a hollow 
body. In this case you can additionally activate the To out-
side checkbox to determine that the wall thickness is applied 
to the outside (instead of the inside, as is usually the case) of 
the body.  

 In the Type area, select whether you want to set a circular or 
an arbitrary cross-section: Activate the corresponding option. 
For circular cross-sections, enter the diameter and identify 
the required guideline with the Select guideline function. If 
you have activated the Arbitrary cross-section option, iden-
tify the guideline and select the sketch for the cross-section. 
Use the Select sketch function for this.  You are enabled to 
specify the direction in the process. Before you finally set the 
cross-section, you can position (i.e. translate, rotate, mirror) it 
as required. 

 Activate/deactivate the Reference and Feature checkboxes.  

 Enter the part name.  

 If you first want to see a preview of the created part, click the 
Preview button, then click Apply. If you want to create the 
part without preview, click the Create button. 

 

Fig. 143  C-edge sweep 
 
 
The following paragraph provides explanations of two other setting options: 
 

 Position sketch automatically 

If you selected this option, the cross-section is placed into the plane vertical to the first identi-
fied guideline edge, so that the fitting point of the cross-section is located in the start point of 
this edge. If required, click the Position sketch button to translate, rotate or mirror the 
sketch.   

 
 

 With direction specification 

Use this function to specify the direction for free cross-sections. If this option is active, the 
otherwise greyed out Specify direction vector icon is activated for selection. Identify the 
guideline and specify the direction by identifying an edge or selecting two points. The further 
procedure is identical to the procedure without direction specification.   
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This function can, for example, be useful if you want to create a stair stringer along a spiral. 
Normally, HiCAD would drag the cross-section along the guideline in such a way that the 
cross-section would always be positioned perpendicular to the guideline. For the stair 
stringer, in contrast, you would want the stringer cross-section to be vertical at any point of 
the guideline. To achieve this, activate the With direction specification option and use the 
Specify direction vector option to select an arbitrary vertical line, as shown in the figure be-
low:  

 

3D-Sketch

Guide Line

Edge for direction

Without direction specification,
automatic positioning

With direction specification, 
automatic positioning

 
Fig. 144  Spiral with c-edge sweep 

 

 

 

 

You can use up to 3 guidelines. Further information is provided in the Online Help.  
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This page is left blank to enable the next exercise to appear on a double page.  
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54.2 Exercise 13 (3D-GL-13.0) Air Duct 
 Learning target: 3-D graphic elements; c-edge sweep .  
 Create a 3-D dummy part or 3-D Sketch and draw the given 3-D guideline including the 

radius 100 fillet. Note: The “Regroup” function has the same effect as the “Sort GE” function 
in the 2-D module and in Sketches: Graphic elements with distance < tolerance are com-
bined into a polyline 

 Create the first pipe as a c-edge sweep with a circular cross section.  
 Draw the cross-section of the hexagonal pipe in a sketch (not 3-D sketch). Create the sec-

ond pipe as c-edge sweep with arbitrary cross section. 
 Hint: The “Sketch” function creates a planar, i.e. 2-dimensiononal sketch. Such sketches 

are needed for functions such as “Extruded solid”, Revolved solid”, “Add”, “Subtract” etc. 
The 3-D Sketch (or 3-D dummy part) enables you to draw in 3-D.  It can be used for guide-
lines which do not simply lie in a plane, but run in all 3 directions of the coordinate system. 
Typically, you would use the “C-edge sweep” function to create a solid from the guideline 
(e.g. a pipe, a staircase stringer or similar). 

 Space for notes:  
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55  Assemblies and Main Assembly 
A 3-D drawing can already be defined as assembly drawing and entered into the database dur-
ing its creation. For assembly drawings, HiCAD automatically creates a 3-D Main assembly. All 
subsequently created 3-D parts are subordinated to this main assembly!  This structuring pro-
vides maximum efficiency, in particular for referencing, itemisation, BOM creation, or a 
combined working with the PDM system HELiOS.  

Main assemblies play an important role for many HiCAD automatisms. In case of itemisation or 
identical part search in Steel Engineering, for instance, the entire product structure of the main 
assembly is automatically transferred to the HELiOS product structure (if you use the PDM sys-
tem HELiOS).   

In the ICN, main assemblies are identified with the  symbol. Each drawing can only have one 
main assembly! A drawing can however contain a large number of “normal” assemblies, as 
shown in the figure below:  

 

 
Fig. 145  Example of a part structure of an assembly drawing 

 

55.1 Create Main Assembly 
In the New function group of the 3-D-Standard tab you will find the Main assembly function.  
This function enables to create the top part of all drawings which are no detail drawings. You 
can create only one main assembly for each drawing. In most cases, a main assembly consists 
of several (sub-)assemblies. The next chapter describes how to create such assemblies.  

 

55.2 Create Assembly 
In the New function group of the 3-D-Standard tab you will find the Assembly function.  Select 
this function and enter the name of the assembly. In contrast to the main assembly, you can 
create for your drawing as many assemblies as you want. Of course, you can also use this 
function to create sub-assemblies, e.g. by entering a name such as Sub-assembly “Suspen-
sion” in the “Article number” (or “Part name”) field. The figure shown above provides an 
example of the subdivision into assemblies and sub-assemblies.    

 

Please note that the part name is only displayed in the ICN if the part has no article number. As 
soon as you enter an article number when creating a main assembly, it will have priority over 
the part name and will be displayed (instead of the part name) in the ICN.  

 

 

 

 



                                                        Model Set 

HiCAD  3-D Training  183 

56 Model Set 
At the top right of the screen, you will find the Settings icon. Click the icon and select the Tool-
bars function. In the dialogue, activate the Toolbars tab, then activate the 3-D Model set 
checkbox.  

 
Fig. 146  Activate 3-D Model set 

 

The 3-D Model set toolbar is displayed at the bottom of the screen.  
 

 
Fig. 147  The Model set toolbar 
 

You can use the functions of the 3-D Model set  toolbar to drag parts from large assembly 
drawings and process them in your own drawing. This method provides a very fast and well- 
structured working, even when dealing with very large drawings. A requirement for this is a free 
window (thumbnail) in the Switch drawing tab.  

You can define and process up to 18 model sets, which may also have a hierarchical structure, 
while the modelling browser provides a clear overview of the model sets.  

The working with model sets is meant to facilitate the processing of parts in complex drawings. 
For this purpose,   

 the parts of the drawing that you want to process are collected, i.e. combined into a model 
set,   

 copied to a new drawing,  
 processed in the new drawing, and 
 retransferred to the original drawing. 
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56.1 Procedure 
Remove all parts from all sets 

Use this function to remove the parts from all selected sets, i.e. all old model sets that might 
exist are deleted.  

Add part 
Use this function to select the parts that you want to take over to the active model set, i.e. you 
collect a new set of parts to be taken over into a new, empty drawing.   
 

Separate model set  
If you have defined the model set, you can transfer it temporarily to a new, initially empty draw-
ing and process it there. This method is much faster and more convenient than applying the 
changes in the original main drawing. The new drawing contains only the parts in the model set 
which can now be modified with all 3-D functions. In this context, please note however the ex-
ception at the bottom of the page (highlighted in grey).  
 
Retransfer active set 
After completion of the processing, you can retransfer the modified parts to the original drawing 
by selecting the Retransfer active set function. Before the parts are inserted, HiCAD will ask 
you whether you really want to apply the changes to the original drawing.  
 
 
 
 

Please do not rename the parts in the model set and do not change the part structure. Other-
wise loss of data may occur. You are however allowed to add parts.   
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57 List View 
HiCAD allows you to define part lists and then to display only those parts contained in these 
lists in the view. Such “list views” are views that contain only a few parts instead of all parts. You 
can, for instance, create a view consisting of only one long beam, which is to be displayed in 
shortened representation in the list view.  In a list view, you can also to display only a few se-
lected parts with a larger scale (e.g.. 5:1 instead of 1:1). 

To access the functions for the creation of list views, activate the Views tab and select New > 
Others > List view. You can also right-click a view in the drawing area (pink dotted frame) and 
select the function from the context menu.  

 
Fig. 148  List view functions 

 

You have the following options for the creation of view lists:  

Select parts  
Individual parts are selected either by identification with the cursor or via the ICN. You end the 
selection with a right-click.  Specify the position of the new view on the screen and select the 
desired type of projection.   
  
List from reference view 
The parts displayed in another view are taken over into the view list.  
  

 

 In the Information + Communication Navigator all parts hidden in the active view are dis-
played with reduced colour intensity. The shown parts of a view list constitute the “view list”.  

 Normal views become list views when you right-click parts in the ICN and select the Hide 
and Show functions.  

 List views can be extended or narrowed at any time with the functions described above.  
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58 Create Detail Drawing 
Right-click the part of which you want to create a detail drawing. Select the Reference part, 
Save, Detail drawing function.  

 
Fig. 149  Create detail drawing (here: without referencing)  
 

The settings selected above are based on the assumption that you only want to create a detail 
drawing, without referencing the part (or maybe the part is already referenced). If you want to 
simultaneously create a detail drawing of the active part and reference the part, select the Ex-
ternal referencing option instead of the Without referencing option.  When you click 
Continue, the following prompt appears:  

 

 
Fig. 150  further question 
 

HiCAD suggests linking the document master of the new detail drawing to the document master 
of the part. This however requires that the part has a document master, i.e. that it is saved as a 
part to the database. Therefore you need to answer with Yes. After entering part number, des-
ignation etc. confirm with OK.  

The following dialogue is displayed:  
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Fig. 151  Parameters for detail drawings 

Select the required setting, in particular decide whether you want to preset the scale of the 
drawing or the size of the drawing frame. Confirm with OK. If you have preset the size of the 
drawing frame, you can confirm the scale calculated by HiCAD. If you have preset the scale, 
HiCAD will prompt you to select a drawing frame. After that, the document mask for the new 
detail drawing is displayed. Now enter the document number, designation etc. of the new detail 
drawing and confirm with OK.  

Advance information: Part master data is a database-specific term. The relevant terminology 
is explained (if you are working with a database) in a separate database training, which also 
deals extensively with the “links” topic. 

 

The following prompt does only appear if the part of which you want to create a detail drawing is 
a main part, and if this part is the only part of the drawing. In this case HiCAD offers to interpret 
this part as a detail drawing and create 4 views in the Sheet area of the same drawing:   

 
Fig. 152  Prompt appearing if part selected for detail drawing creation is a main part 

Answer this question with “Yes” if you want to create the detail drawing in the Sheet area of the 
same drawing, answer with “No” if you want to create a new, separate detail drawing instead.   
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59 Assembling, Transport and Motion Simulations 
You can use the functions of the Assembling Simulation (additional module) to perform and 
evaluate assembling, transport and motion simulations on a 3-D model. This enables you detect 
and eliminate possible errors at early design stages.  

The simulation functions are also very useful for product presentations.  
 

To access these functions, click the Settings icon at the top right of the screen, and select 
Toolbars. 

In the dialogue, activate the Toolbars tab and select the required function.  

A detailed description of these functions can be found in the Online Help.  

The following figures demonstrate a simulation on the basis of a simple example:  

 

59.1 Assembling Simulation 
  

x

y

z

 
Fig. 153  The original model (assembled) 

 

 

Teil 1

Teil 2

Teil 4

Teil 3

 
Fig. 154  Disassembling of the model 
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Fig. 155  Complete assembling simulation 

 

The following figures show an assembling simulation with assembling track: 

 
Fig. 156  Original model (assembled) 

 

 

 
Fig. 157  Disassembled model with assembling tack 
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59.2 Transport Simulation 
The example below simulates the rolling of a ball though a groove. The groove was created with 
the C-Edge sweep function. The spiral line is still present in the drawing.  

 
Fig. 158  Rolling ball  

 

59.3 Motion Simulation 
The below example simulates the lifting of an arm: 

A conceivable sequence of motions would be the following one:  

 Translate coordinate system into the centre of the shoulder joint 

 X-rotation of the upper arm  

 Translate coordinate system into the centre of the arm joint 

 Z-rotation of the lower arm 

 Translate coordinate system into the centre of the hand joint 

 Y-rotation of the hand  

 

 
Fig. 159  Sequences of a motion simulation 

The figure above shows (from left to right): The original model, the upper arm movement, the 
lower arm movement and the movement of the hand.  
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This page is left blank to enable the next exercise to appear on a double page.  
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59.4 Exercise 14 (3D-GL-14.0) Pipe Connection + Assembling Simula-
tion 

 Learning target: Create assemblies, derive detail drawings from the assembly (or vice 
versa); automatic alignment of assembly and detail drawings via referencing, list view; 3D 
Model set; assembling simulation; exploded view. 

 Create a drawing with database, create one main assembly called “Main assembly Pipe 
connection” and two (subordinate) assemblies called “Assembly Pipe parts” and “Assembly 
Flanges” 

 Draw in a 3-D Sketch the 3-D guideline of the pipe (tangent with a 45 degree angle at a 
circular arc with a radius of 50, etc.). Draw ALL following parts as referenced parts! 

 Create the pipe as a (hollow) c-edge sweep. 
 Divide the pipe into the three pieces shown in the drawing and create the 5 mm gap with 

“Subtract part, via Translation”. 
 Draw the lowest flange as a hollow cylinder and subtract the pipe. Position a processing 

plane on the upper end of the pipe. If you draw the two upper flanges as hollow cylinders, 
they are both angled by 45 degrees when inserting them. Please remember that the wall 
thicknesses of the two flanges are different! 

 Subtract the three pipe parts from the middle flange and execute the standard part process-
ings.  

 Check whether all pipe parts are below the “Assembly Pipe parts“ and all flanges below the 
“Assembly Flanges“.  

 Save the drawing! 
 Derive two detail drawings: One from the bottom flange and one from the upper section of 

the pipe (with referencing and via the database) 
 Load both detail drawings. Apply some minor modifications to the detail drawings (e.g. fillet, 

respectively chamfer) and save them.  Change to the assembly drawing and take over the 
modifications of the referenced parts. 

 Now apply a minor modification to the lower flange in the assembly drawing (e.g. a further 
fillet). Save the assembly drawing. 

 Switch to the detail drawing and take over the modifications here as well. 
 Assign a Material to the parts and create, in the Sheet area, the sectional view. Change the 

hatching of individual surfaces. Add dimensionings and insert a drawing frame in the Sheet 
view.  

 In the Sheet area, create a list view of the 3 sections of the pipe, and a second list view of 
the 3 flanges.  

 Use the Model set option to separate the upper section of the pipe and the upper flange into 
another drawing. Apply a minor change (e.g. fillet) and retransfer the change to the main 
drawing.  

 Make an Assembling Simulation (Settings > Toolbars > Toolbars > 3-D Assembling simula-
tion). If the parts will also move in the sectional view and the 2 list views, freeze the 
sectional view and the 2 list views (“View Functions” function group in the “Views“ tab). 

 Create a new drawing. Copy the main assembly “Pipe connection” into this new drawing. 
De-reference the parts to prevent possible repercussions of the planned exploded view on 
the original drawing. Activate the pipe and create the exploded view.  

 Hint: If you have several views and want to create an exploded view it makes sense to 
freeze all views, except for the one in which you want to display the exploded view. 
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60 Part Offset 
Use this function to create an offset of the active part. You can find the Part offset function in 
the +/- function group of the 3-D Standard tab.  

 
Fig. 160  The Offset dialogue 

Enter the wall thickness and select whether you want to create an internal or external offset.  

HiCAD prompts you to select surfaces. You have the following two options: 
 Select an arbitrary number of surfaces that you want to delete. Click the Preview button. 

Select Preview again to change wall thickness and the direction of the offset, if required. 
Then select Create. 

 Select no surface, but click the Preview button, then the Create button. HiCAD immediately 
creates an offset, without deleting any surface.  

 

Offset mit wegfallenden
Flächen

K1

K3 K2

K6

K5

K4

 

Fig. 161  Internal offset 

Tip: You can also use the Part offset function to assign wall thicknesses to surface parts.  
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61 Create Graphics 
2-D and 3-D drawings can also be used for presentations and brochures, or can be inserted as 
graphics into a letter. Before converting the drawing to a graphic, you can assign RAL-colours 
or custom colours to entire parts or individual surfaces, or use “layer 40” to make them trans-
parent.  Use the Reality Studio (additional module) to insert light sources (lamps) and spots into 
your drawing. Further options are shades, light reflections, textures, and much more. The Real-
ity Studio also enables the simulation of camera panning as well as animated motion 
simulations. 

The following paragraphs provide explanations of various commands for the conversion of 
drawings to graphics.  Detailed information on the Colour Editor can be found in the Online 
Help.  For further information on the Reality Studio, please contact your sales agent.   
 

61.1 CTRL+C 
On your keyboard, select the CTRL+C shortcut. Select the EMF or Bitmap format and enter the 
desired size of the image in pixels. Confirm with OK. Specify the required drawing detail in a 
rectangle and select a background colour.  The created graphic is then copied to the Windows 
clipboard and can be loaded into any picture processing program such as Paint, Corel-Draw 
etc. The program “Paint“ can be accessed, (depending on the operating system used), e.g. via 
Start > Programs > Accessories … 

61.2 CTRL+W 
On your keyboard, select the CTRL+W shortcut. Draw a rectangle around the drawing detail 
that you want to convert to a graphic. Select Process with Paint Brush. After confirming with 
OK, the selected detail of the drawing is displayed as a bitmap. You can now either save the 
bitmap or process it further. 

61.3 PrtSc Key 
You find the PrtSc key to the right of the F12 key on you keyboard. If you select PrtSc, the en-
tire screen (including toolbars) is converted to a bitmap. You can then load this bitmap to an 
image processing program from the clipboard.  

              

Fig. 162  Awning and kitchen, drawn in HiCAD and processed with Reality Studio 

 

61.4 Create EMF File 
To access the Create Enhanced Metafile (EMF) function, activate the Drawing tab and select 
Others > Extras > Tools.  
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61.5 Exercise 15 (3D-GL-15.0) Beaker 
 Learning target: Offset; options of the Feature log, derive graphics from HiCAD drawings. 
 Create the beaker as an extruded solid (Referencing and Feature: Yes). Create the sub-

tractions and fillets. 
 Delete all generated surfaces and the floor space, but not the top surface. 
 Allocate a wall thickness of 1 mm with the “Offset” function. 
 The trainer will explain the options of the Feature log. You can, e.g., move the red arrow to 

the start of the Feature log and go through the log step by step. You can also move or deac-
tivate Feature steps etc.  

 Shade and colour the beaker. Position it on layer 40, to make it transparent. 
 Create a graphics form this drawing in three different ways: 

 CTRL+C 

 CTRL+W 

 PRINT key 

 Create Enhanced-Metafile (EMF) 
 Space for notes:  
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62 Designing in Assemblies 
The first exercises in this 3-D training book dealt with the creation of detail drawings. In the ex-
ercise “Pipe Connection + Assembling Simulation” we have created an assembly and derived 
detail drawings from it. The following exercise shows how to design within an assembly:   

 

62.1 Exercise 16 (3D-GL-16.0) Axial Piston Pump 
 Learning target: Changing and modelling of parts in an assembly drawing. 
 Load the drawing “Axial Piston Pump” from the hicad / Szenen / Examples directory. 
 Save the drawing to the database (to prevent an accidental overwriting of the original draw-

ing)! 
 Activate the part “Casing hub”. You find it below “Hub complete”. Translate it 500 mm to the 

right. We are now going to draw this flange in an approximated form. 
 Change to the front view and draw the rough contour of your flange. 
 Correct the sketch with the “Process Sketch” function.  

 Freeze the bottom and the left line of the contour of the sketch with the help of the 3-D c-
edge HCM.  

 Change the diameter of the top left and top centre horizontal lines by dynamic dragging.  

 Define an exact distance for those two horizontal lines. Use the function “Offset - Parallel 
to Y-Axis“.  

 Allocate an appropriate width and height to the revolved solid. For example, at the left 
side, the outer edge of the flange needs to be flush with the part “Case bearing part” (you 
will find it below “Casing”). A further help is the dimensioned 2-D contour in the drawing. 

 Take over the sketch. 
 Create at least one of the subtractions. 
 Add hole pattern, countersink and bolting. Use the flange as an orientation; you translated it 

500 mm to the right. 
 Change the assembly via the context menu functions. 
 Add at least one more hole pattern.  
 If your flange has not been referenced, save subsequently as a referenced part. 
 Create a new (individual part) drawing with the flange you drew. 
 Chamfer an optional point of the flange you drew in the assembly drawing. Check if the 

individual part drawing has been up-dated automatically. 
 The angular hollow area to the left can be created with the part “hicad / Szenen / Exam-

ples / AX-GEH-SUBTRAKT.KRA (position to ABS 0 0 0). 
 You will find two additional exercises on the following pages. 

 
Tip: The additional exercise 3D-GL-Z32 is highly recommended if you want to practise the 
working with processing planes.   

 
 

 



                                                        Designing in Assemblies 

HiCAD  3-D Training  199 

 



Designing with Other HiCAD Modules 

200                                                                                                                                        HiCAD  3-D Training 

63 Designing with Other HiCAD Modules 
This training book mainly dealt with functions of the 3-D module, which is one of very many Hi-
CAD modules. Below please find short descriptions of these modules. If you require further 
information on any HiCAD modules, please contact your sales agent.  

2-D: Besides the 3-D module, HiCAD also offers the traditional 2-D module. This module, too, 
facilitates your daily work by many automatisms and a 2-D part structure.  

HELiOS Document Management: Enables you to create and efficiently manage drawings as 
new, modified, derived, or follow-on sheets drawings. More than 20 attributes are available al-
lowing you to search for particular drawings. For an efficient project management, assignment 
of rights, workflows, approval and release processes, etc.  

HELiOS Part and BOM Management: Enables you to assign master data to (2-D or 3-D) 
parts. BOM creation at the push of a button. Allows the creation of dynamic BOMs, parts where-
used lists, user-defined BOM formats. The combination of HELiOS Document Management and 
HELiOS Part and BOM Management is also called “Product Data Management” (PDM).  

Sheet Metal: Enables an efficient creation and development of sheet metal constructions. Parts 
from the 3-D module can also be developed. Allows a selection of material and development 
procedures (outer/inner leg, neutral chamfer etc.), as well as user-defined development proce-
dures. Provides many sheet metal-specific functions, from mitre cuts and overbend tables to 
punching and forming tools.  Automatic covering of 3-D parts with sheet plates. Reconstruction 
of sheet metal parts from 2-D developments (even if not created with HiCAD), and much more.  

Steel Engineering: Provides steel engineering-specific standard parts from rolled profiles to 
gratings, and steel engineering processing functions such as mitre cuts, notch and DAST con-
nections. Automatic itemisation of all parts, automatic detail drawing and workshop drawing 
creation, creation of user-defined steel beam series. Optional extension modules: Stairs mod-
ule, Metal & Facade Engineering, including logiKal interface.  

Stairs:  Enables the creation of straight and winding stairs. Straight stairs are already included 
in the steel engineering module.  

Metal and Facade Engineering: Enables the creation of glass facades, conservatories etc. 
Loading of parts from logiKal is optionally available. All HiCAD 3-D and Steel Engineering func-
tionalities can also be used for Metal Engineering constructions.  

Plant Engineering: Provides plant engineering-specific standard parts from pipes and vessels 
to small chemical plants. Enables an individual expansion of the plant engineering part cata-
logues by user-defined parts and the creation of plant engineering BOMs. Offers many 
automatisms enabling a significant reduction of calculation times.  

P+ID: Enables the creation of Piping and Instrumentation Diagrams (P+IDs), which can be 
linked to 3-D plant engineering layout plans.   

Freeform Surfaces: Module for all parts which are not analytically describable. This module is 
particularly interesting for the Automotive Industry and casting manufacturers. 

Macro Programming: Allows the creation of user-defined successions of commands and call 
them from the GUI / the keyboard. This is possible for almost all HiCAD modules. The macro 
module enables you to add further commands to the “normal” user interfaces of the individual 
modules.  

Variant Technology: If a company uses part which only differ in their dimensions, these parts 
need to be drawn only once, as so-called “variants”. For a second creation, only the entering of 
dimensions, number of bores etc. will be required. The variant is then drawn automatically.   

 

For information on further modules please contact your sales agent.  
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64 Additional Exercises 
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65 Glossary 
3-D C-Edge Constraint Manager 

The C-Edge Constraint Manager is based on the 3-D HCM and is a tool enabling you to posi-
tion and move composite edge elements. For this purpose, the c-edge elements are linked to 
each other through so-called “constraints”, i.e. dimensional and logical relations and restric-
tions. The C-Edge Constraint Manager then transforms the appropriate elements in such a 
way that the defined constraints are fulfilled. 

3-D Part HCM 
Use the 3-D Part HCM to define constraints between 2 objects (e.g. parts) The corresponding 
elements are linked to each other by dimensional/positional constraints and logical relations. 
The 3-D Part HCM transforms the corresponding elements in such a way that the specified 
constraints are fulfilled. See also 3-D C-Edge HCM. 

3-D Part 
3-D parts are normally solid bodies. They consists of 3-D graphical elements (short: “GE”), 
which constitute the lowest organisational units of a 3-D drawing. These can, for instance, be 
3-D points, 3-D (poly)lines, 3-D circles/arcs or surfaces.  

3-D Polyline 
A 3-D polyline is a structurally coherent (i.e. continuous and uninterrupted) succession of in-
dividual 3-D lines. The end point of the previous line coincides with the start point of the next 
line.  

Absolute coordinates 
Coordinates referring to the point of origin of the current coordinate system (short: “CS”).  

Active attributes 
HiCAD enables you to define particular attributes as active attributes. For all manipulations 
applied at a later point, only those elements possessing these attributes are taken into ac-
count.  

Arithmetic expressions 
Valid algebraic combinations of constants, numeric variables, arithmetic operators and paren-
thesis.  

Assembly 
Several combined (“assembled”) parts under one superordinate part. This superordinate part 
serves only the purpose of structuring (enabling, for instance, a simultaneous moving of the 
sub-parts below it, or the allocation of part master data to the superordinate part) and can 
therefore be an empty dummy part, i.e. it needs not necessarily contain lines, dimensionings 
or similar.  

Associativity 
“2-D/3-D Associativity” basically describes the possibility of a combined and simultaneous 
working in 2-D and 3-D. A HiCAD drawing files can both contain 2-D and 3-D objects. 3-D 
views can be added to technical drawings in 2-D, 2-D objects can be used as a basis for 3-D 
drawings etc.  

Attributes 
Characteristics such as colour, line type and line thickness, influencing the appearance and 
shape of elements.  

Autopilot 
A tool for the identification of points and parts. If the Autopilot is switched on, the cursor pro-
vides information on snappable points (e.g. start points, end points or mid points of edges, 
perpendicular base points, intersection points or centre points of circles) when it is moved 
over the drawing objects. These points can be taken over directly, i.e. without activating a 
point option.  
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Basic elements 
The lowest organisational units of a HiCAD drawing. In 2-D, these are line elements, in 3-D, 
these are edges, surfaces and 3-D points.  

Bill of Materials (BOM) 
List of all parts of which a product or an assembly is made up, indicating quantities and des-
ignations of the parts.  

C-Edge Constraint Manager 
see 3-D C-Edge Constraint Manager 

Clone 
Parts which are required several times in a drawing can be copied. These copies are called 
“clones” in HiCAD. You can choose whether you want to combine all parts into one part or if 
you want to create one superordinate part above the copied parts instead.  

Closed contour 
Continuous contour with coinciding start and end point.  

Colour table 
Enables you to pre-set the allocation of available colours. 

Contour 
Contours link graphic elements that are optically but not structurally coherent – they need not 
belong to the same part.  

Contour edges 
“Apparent” edges of the analytical 3-D model. 

Contour hatching 
Hatches a surface defined by a contour. Lines which are integrated in the boundary line can 
belong to different parts.  

Copy 
see Clone 

Crosshairs 
Cursor symbol which is moved by the mouse, indicating the current position on the screen. 

Cursor 
See Crosshairs 

Data structure 
The HiCAD drawing structure. The highest organisational unit in HiCAD is the Drawing. The 
Drawing contains Main parts which may in turn consist of Sub-parts. The individual parts 
consist of the lowest organisational units: In 2-D, these are the graphic elements (GE) and in 
3-D, these are edges, surfaces and 3-D points. See also 2-D part, 3-D part, Drawing. 

Default value 
The value of a parameter which is set when the program is started.  

Detail  
An arbitrary drawing detail can be defined and inserted separately on the screen in any scale.  

Display lists 
Graphic card drivers for an accelerated output of graphic elements on the screen.  

Drawing 
Drawing file in HiCAD with the file extension .SZA. A Drawing is the highest organisational 
unit in HiCAD. It is composed of 2-D and/or 3-D parts. These can be assemblies, parts or 
bores. Each drawing is assigned an unambiguous name, enabling the user to retrieve it.  



                                                        Glossary 

HiCAD  3D-Schulung  229 

Drawing detail 
The detail of a drawing that is displayed on the screen (alterable by the “Rectangular zoom 
window” and “View all” functions).  

Drawing layout 
Several HiCAD drawings on one drawing sheet for print output.  

Engineering  axonometry  
A parallel projection, in which the y and z axes are full length and the x axis shortened. The x 
axis is at an angle of approx. 41°, and the y axis at an angle of approx. 7° to the horizontal of 
the screen plane. The z axis is perpendicular to the screen plane.    

Error tolerance 
Rounding errors in numerical values. Point coordinates, e.g., can be checked for a specific 
tolerance. Errors are calculated as the difference between the exact and the rounded value. 
The error tolerance, i.e. the allowed maximum deviation, can be preset within a specific 
range of values. Two points are recognised as one if the distance between them is less than 
the given value.  

ESM (European Solid Modeler) 
ISD’s self-developed 3-D kernel. 

Feature 
When designing in 3-D, Feature Technology is active by default. Feature Technology records 
all processing steps (“Features”) in a Feature log. Activate the Feature tab in the ICN to view 
the processing steps applied to the active part. With the help of Feature Technology you are 
enabled to conveniently change parts via the Feature log, and even correct processing steps 
that were applied long ago, without having to repeat these steps once again. You can also 
derive Feature variants from the Feature log. If Feature Technology is switched on, HiCAD 
automatically generates the parametric dimensions of the part. These are visible if the part 
and the Feature step are active. Such parametric dimensions provide, besides the Feature 
log, an additional option to change parts. See also Parametric dimensions. 

File group 
Short term for a HiCAD directory path, defined in the FILEGRUP.DAT file. 

File name  
The name under which the operating system (e.g. Windows or UNIX) manages the HiCAD 
data, such as CAD-drawings, parts, macros etc.  

File path 
A short designation for a HiCAD directory path. Paths are defined in the FILEGRUP.DAT file. 

Fitting points 
Points used for reference, e.g. when transforming parts.  

Folder 
Folders can be used in HELiOS to simulate and manage order processes. You can save  all 
documents and parts of an order to a folder. One distinguishes between mandatory and op-
tional objects. Mandatory objects are requested by Folder Workflows, optional objects can be 
created or dragged into the element list (with Drag & Drop or similar functions), if desired. 
You can create a Folder Workflow for a Folder: In such a workflow you can, for instance, de-
fine the steps required for the processing of an order. For example, if you have determined 
for the Workflow step “Request check-up” that a document named “Test Report” would be 
required, this configuration would automatically lead to the opening of a document mask in 
this Workflow step. Alternatively, you can also search for existing documents or parts. Docu-
ments/Parts in the Folder or in related links are listed in further tabs.  

Freehand symbol technique 
Special input method based on the definition of a symbol and assigning it to a specific com-
mand.  
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Graphic elements (GE) 
Lowest organisational 2-D unit. Graphic elements can be points, symbols, lines, circles/arcs 
or conic sections.  

HCM HiCAD Constraint Manager 
Parametric designing on the basis of Constraints, linking individual objects to each other by 
means of geometrical relations.  

Identical part search 
Automatic detection of parts with an identical geometry in the drawing.  

Identification 
Selection of an object with the cursor.  

Intelligent Cursor 
Context-sensitive cursor providing you with functions appropriate to current processing re-
quirements. If you process objects, for instance, you are prompted to select the object you 
want to process. When you now move the cursor on an object, this object is highlighted and 
can be selected for processing by a mouse-click. Only those functions which are useful for 
the processing of this object are then displayed.   

Interfaces 
Software modules enabling data interchange with other programs.  

Isolated points 
Independent points that can be inserted freely into the drawing. They need not be located on 
a drawing object. Isolated points can be used as auxiliary point during drawing creation, or as 
fitting points during transformations.  

Kinematics 
Functions for modelling, simulating and analysing complex freely definable linkages.  

Kinetostatics 
Analysis function for bearing and element stress.  

Layer 
The Working with layers can be compared to the working with transparent foils on a conven-
tional drawing board.  

Level 
see Overlap and Visualisation level. 

Library 
A “pool” of parts (part library), macros or variants (macro library). A library can be added to 
the screen menu. In this case, the calling of the parts, macros or variants takes place via se-
lection of the appropriate library entry.   

Local 3-D coordinate system  
Temporary 3-D coordinate system, which can also be rotated.  

Logical relational expression 
Simple arithmetic comparison, e.g. a > b (a is greater than b). The value of the expression is 
TRUE or FALSE.  

Logical variables 
Variables which always return either TRUE or FALSE as a result. They are frequently used in 
macro technology, especially in loop and IF conditions.  

Macro 
Sub-program accessing HiCAD functions and creating variants in cooperation with the user. 
Macros serve the purpose of reproduction, i.e. the repetition of permanently returning HiCAD 
processes.  
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Main part 
The second-highest organisational unit after the Drawing. A Main part can be an Assembly or 
an individual part. An unlimited number of Sub-parts can be assigned to a Main part to pro-
vide the logical structure of a real construction. See also Part structure and Sub-part.  

Mask 
A form that is temporarily displayed for the input or selection of data. Masks usually contain 
input fields or selection fields for parameter specification, as well as explanatory texts.  

Model area 
A view in which all other views, sectional views, detail views, drawing frames etc. are hidden. 
This enables a fast and structured working. Besides, you can rotate the model view without 
any repercussions on the production views in the sheet area. See also Sheet area. 

Mouse 
A device that is manually moved over the table, thus moving and controlling the crosshairs on 
the screen.   

Moving of objects 
Simultaneous translation and rotation of objects.  

Named points 
Points to which a name has been assigned. This is possible for start points and end points of 
lines and arcs, as well as for isolated points.  

Natural coordinates 
All 2-D data contained in the drawing refer to the carthesic coordinate system. These coordi-
nates are also referred to as natural coordinates. 

Object selection 
A choosing of objects for processing, either via identification, name entry, or with the struc-
ture browser.  

Overlap contour 
The Overlap contour defines the overlap area in 2-D. This is the area in which the overlapped 
lines are to be shown or hidden. See also Overlaps and Overlap level. 

Overlap level 
You can also create overlaps in 2-D by assigning so-called “overlap levels” to parts. See also 
Overlap contour and Overlaps. 

Overlaps 
You can create overlaps in 2-D by assigning a so-called “overlap level” to a 2-D part. See 
also Overlap contour and Overlap level. 

Parametric dimension 
Dimensioning appearing on the active part if the Feature is switched on. If you right-click a 
dimensioning, you are enabled to change the part. See also Feature. 

Part 
A drawing consists of very many graphical objects, such as lines, texts, dimensionings, etc. 
All of these graphical objects are assigned to parts. One part can, for instance, be called 
“Flange”, another part can be called “Plate”.  All lines, dimensionings, texts and processing 
symbols of the flange are assigned to the part “Flange”, and all lines, dimensionings etc. of 
the plate are assigned to the part “Plate”.  If you translate, rotate, mirror or delete such a part, 
all dimensionings, texts and processing symbols are also translated, rotated, mirrored or de-
leted.  If you create a part as main part or sub-part depends on whether the part is an 
individual, independent part, or if it belongs to another part. For instance, an individual 
haunched plate in a detail drawing would, as an independent part, be created as a main part. 
If this haunched plate is welded to a steel beam in an assembly drawing, it would be a sub-
part of the beam. See also Main part, Sub-part.  
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Part hatching 
Hatching of a surface bordered by a closed polyline. All lines of the border need to belong to 
one part.  

Part list 
Multiple selection of parts. The aim is to process several parts in one step 

Part structure 
Subdivision of the drawing into main parts and sub-parts. The part structure describes the 
logical composition of the real construction. It constitutes, for instance, the basis for the auto-
matic Bill of Materials (BOM), the automatic creation of subtractions for part hatchings, and 
part overlaps.  

Patterning  
Special hatching of a surface, with arbitrary symbols instead of lines for the hatching.  

Pixel graphic 
An image the data structure of which consists of pixels. Pixel graphics are created, for exam-
ple, when scanning images. Common formats are BMP, JGP, GIF, PCX and TIF. 

Point options 
Functions for the specification of point coordinates. The functions are subordinated to all 
other functions, i.e. they can be activated within other functions.  

Point specification 
See Point options. 

Polyline 
A polyline is a structurally coherent (i.e. continuous and uninterrupted) succession of individ-
ual lines, circular, elliptical, hyperbolic or parabolic curves. The end point of the previous line 
coincides with the start point of the next line.   

Redo 
Reverses the previous UNDO.   

Reference point 
The point to which a later subsequent transformation or point specification refers. See also 
Fitting point. 

Relative coordinates 
The coordinates refer to a point in the drawing that is not necessarily the origin of the coordi-
nate system. For many functions, this reference point is automatically defined by the last set 
point. Reference points can however also be defined by the user.  

Representation 
HiCAD offers several options for the representation of the 3-D parts in a drawing, e.g. 
shaded, as glass model, with or without hidden edges.  

Roles 
In contrast to the already known User/Group Management via edbsetup.exe, you can, in con-
junction with Role Workflows, create so-called “Roles”. Such “Roles” are a combination of 
special rights within the Role Workflows. You can create different Roles and assign different 
(already existing) users or entire groups (from the normal User and Group Management) to 
them. The Role Management enables you to provide Users and/or Groups with differ-
ent/other rights than those which are already available via the normal User/Group 
Management. The already existing rights remain unaffected and continue to exist. Within the 
Role Workflows, the rights can now be customised and can be used in addition to the, still 
available, existing rights. 
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Role (as opposed to Group) 
In contrast to the User/Group concept, the utilisation of Roles enables a dynamic manage-
ment of rights. Access rights are defined in HELiOS for individual Roles, and the access 
rights are given to Users by assigning them to specific Roles. The allocation of Users to 
Roles needs not necessarily be unique, central and system-wide, but can take place at the 
moment of the creation of an object possessing a Workflow, or even stepwise, during the life-
cycle of the object. This means that access rights of users can be controlled individually on 
object level and via the User<->Role allocation. In addition, you are enabled to change the al-
location of Users to Roles during the execution of a Role Workflow.  

Screen coordinate system (Screen CS) 
Coordinate system the XY-plane of which is the screen.  

Screen menu 
The area(s) of the graphic screen containing the icons, symbols and texts for function calls.  

Screen plane 
The XY-plane of the screen coordinate system.  

Screenshot 
Saving of the current screen or screen details as pixel graphic.  

Sheet area 
The area in which you can create and name production views. These can be normal views, 
sectional views, detail views, drawing frames etc. You can also create several sheet areas, 
e.g. one for the quotation drawing, one for the production drawing etc. See also Model area. 

Similarity transformation 
Simultaneous translation, rotation and scaling of a part.  

Sketches 
3-D part with free edges that lies in a plane. Sketches can be used, e.g., for the derivation of 
extruded solids, revolved solids, bores, subtractions or C-edge sweeps. The name “3-D 
SKETCH” can be changed if desired. After creating a sketch the appropriate sketch functions 
are displayed. The sketch is drawn in the active processing plane or, if no processing plane is 
available, in the XY-plane of the active coordinate system. Before drawing a closed contour in 
the sketch, you can use the “New plane, …“ functions to define or activate a different proc-
essing plane.  

Snap circle  
If snap mode is active, points within the radius of the displayed circle are automatically de-
tected.   

Snap mode 
If this mode is active, points can be specified directly, without calling a point option. See also 
Autopilot. 

Snap radius 
Determines the size of the snap circle.  

Solid primitives 
Basic 3-D bodies such as cuboids, cylinders, spheres etc.   

Status bar 
Displays information about the current program status, i.e. the name of the active part, active 
view and active coordinate system, etc.  

String 
A sequence of alphanumeric and special characters.   

Structure browser 
Offers a graphic representation of parts as well as the opportunity of processing component 
structure.    
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Sub-part 
A part that is subordinated to another part (Main part or Sub-part). See also Part structure 
and Main part. 

System variable 
HiCAD variables with fixed allocations.  

Transformation 
Umbrella term for positional and size changes of drawing parts, such as translations, rota-
tions, mirrorings, enlargements, downsizings etc. 

Trim 
Limits or shortens lines with respect to given conditions.   

Undo 
Reverses the previous action.    

Unit of measurement 
Preset unit of measurement (mm, cm, etc.) for all value entries.  

User-specific variable 
Variables which have been defined by the user and to which, depending on the type, a nu-
merical value or a character string has been assigned.  

Value entry 
Input of numbers, arithmetic expressions and variables.  

Variables memory 
Function enabling a rapid definition and saving of variables. 

Variant 
You use Variant Technology to create “Variants”. The creation of 2-D or 3-D variants makes 
sense if you frequently draw similar parts, differing only in their dimensions, the number of 
bores, etc. After calling a variant you only need to specify the required parameters (width, 
height, number of bores etc.), and HiCAD then draws the part automatically. Parts created 
with Variants (or Macros) can be simple sheets or plates, but also complex assemblies.  

Vector graphic  
An image constructed with vectors. In this type of graphic you can delete, move, change or 
scale the individual graphic elements. Vector graphics usually require less memory than pixel 
graphics.  

Views 
Projections, i.e. two-dimensional representations of 3-D objects. One distinguished between 
standard views (top view, side view, front view), isometric and axonometric views. View gen-
eration is based on projection principles.  

View All 
Displays the entire drawing on the screen.  

Window 
The subdivision of the screen in several processing windows, enabling you to process vari-
ous details of a drawing.  

Zoom 
Functions enabling you to enlarge or downsize the objects on the screen. 

ZTL file  
A 2-D drawing file with the extension ZTL; used in older HiCAD versions. 
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